Thank you for purchasing this Panasonic product.

- Before using this software, please read the instructions carefully.
# Contents

## Introduction ............................................ 4
- Software Licensing Agreement .................. 4
- Request Regarding Security ....................... 6
- About this document .................................. 8
- Terms used in this document ..................... 8
- What You can do with this Software ............. 10

## Preparation ........................................... 15
- System Requirements ................................ 15
- Network Configuration ............................... 17
- Steps to Start Operation ............................. 19
- Installing the Software on the Monitoring and Control Terminal ............. 20
- About Licenses ....................................... 25
- Before Using this Software ....................... 27
- Setting early warning function .................... 28
- Uninstalling the software ......................... 38

## Registering a Device to Monitor and Control ........................................ 39
- About the <Device Monitoring> Window .......... 39
- Registering Devices and Peripheral Devices to Monitor and Control ............ 41
- Register a network camera ......................... 53
- Changing the Registration Information of a Device or Peripheral Device .... 57
- Setting up the Fail Soft Function .................. 58
- Changing the Device Name ......................... 60
- Creating a Group ..................................... 61
- Creating a Keyword .................................. 63
- Creating Brightness Control ....................... 66
- Deleting (A device, group, keyword, brightness control, or network camera) 69
- Updating Device Registration Information ........ 70
- Registering Device Location Information .......... 73

## Monitor .......
Contents

Setting the Monitoring and Control functions ............................................219
  Setting the Monitoring and Control's option function............................219
  Setting the Information Updating Interval ............................................220
  Setting the Number of System History Entries that can be Saved ..........221
  Setting the Port Number for Command Control .....................................223
  Setting the Status Notification Function ............................................224
  Changing the Information Displayed on the Information Display Windows 225

Setting up the Early Warning Function (paid) ...........................226
  Setting the Early Warning Function of Monitoring and Control .............226
  Setting SNMP Notifications ..............................................................227
  Configuring the Required Settings for Sending Mail .............................230
  Setting a Warning to Report that a Device is Not Connected .................234
  Updating Notification Data ...............................................................236
  Registering, Deleting and Changing User Account Control ....................238
  Making Video Stop Determination Settings for a Network Camera ..........242

Other Questions & Answers ............243
  Error Messages ..........................................................243
  Frequently Asked Questions .........................................................248
  Trademarks ..........................................................261
Software Licensing Agreement

Use of this software is governed by the terms defined in this “Software Licensing Agreement”. By using this software, you are agreeing to the “Software Licensing Agreement”.

1. License
This license grants Licensee the right to use the Software, but does not transfer to Licensee any patent rights, copyrights, or any other rights, which remain the property of Panasonic or third parties. Licensee may use the Software only for the purpose of managing Panasonic displays (projectors and flat panel displays). Note that the usage rights licensed to Licensee by downloading the Software include separate restrictions limiting the period of use and the number of displays (projectors and flat panel displays) that can be used. The usage rights may be extended or modified, for example by separate purchase of a key code, but in such cases the license remains subject to the terms of this Software License Agreement.

2. Use by a Third Party
Licensee may not transfer or allow any third party, to use or copy the Software, whether free of charge or not.

3. Restrictions on Copying the Software
Licensee may make one copy only of the Software in whole or in part solely for backup purposes.

4. Computer
The Software is for use on one computer owned or managed by Licensee and may not be used on other computers.

5. Reverse Engineering, Decompiling or Disassembly
Licensee may not reverse engineer, decompile or disassemble the Software. Panasonic shall not be bound by warranty for any defects in the Software caused by reverse engineering, decompiling or disassembly of the Software. Furthermore, Panasonic or its distributors or dealers will not be responsible for any damage to the Licensee caused by the reverse engineering, decompiling or disassembly of the Software.
6. After-sales Service
If a problem should occur with the Software while Licensee is using the Software, the Panasonic Projector Support Center should be contacted. Panasonic shall undertake to notify Licensee of whether the problem is a known error in the program (“bug”), or whether the way in which the Software is to be used should be modified. However, no after-sales service will be carried out for problems caused by use of the Software for purposes other than managing Panasonic displays (projectors or flat panel displays). Furthermore, the specifications Software is subject to revision without prior notice.

7. Indemnification
Panasonic's responsibility for the Software shall not exceed the terms set forth in Section 6 above, regardless of any extension or modification of usage rights, for example by the separate purchase of a key code. Panasonic and its distributors and dealers shall assume no responsibility for any direct or indirect damages or losses incurred by Licensee or third party claims against Licensee in connection with the use or failure of the Software. Note that the purpose of the Software is to support management of Panasonic displays (projectors and flat panel displays). Panasonic and its distributors and dealers do not guarantee the adequacy of the Software, the accuracy of its results, or its fitness for Licensee's specific purpose, nor do they guarantee that the Software does not infringe on the rights of third parties. Furthermore, please note that Panasonic and its distributors and dealers cannot assume responsibility for any problems that occur when downloading files.

8. Export Control
If the Licensee brings the software to another Country other than the Country of purchase, The Licensee will follow the regulations of that Country regarding export management.

9. Governing Law and Changes to this Notice
All aspects of the use of this software shall be governed by and interpreted under the laws of Japan. Panasonic may change this notice at its own discretion without notifying Licensee.

10. Agreed Jurisdiction
In the event of a need for litigation concerning the use of the Software, Licensee and Panasonic may file an action in Osaka District Court only.
# Request Regarding Security

Be aware of the following security risks when using this software.
- Leakage of your private information via this software
- Illegal operation of this software by a malicious third-party
- Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
- Make sure the password is as hard to guess as possible.
- Change the password periodically.
- Panasonic Corporation and its affiliated companies never directly ask customers for their password. Do not give out your password even if directly asked by a third-party representing themselves as Panasonic Corporation.
- Regularly run Windows Update to keep the operating system on the computer up-to-date.
- Always use on a network that has safety protection such as a firewall implemented.
- Set passwords, and limit the users that are permitted login access.
Security warnings regarding the usage of Wireless LAN products

The advantage of a wireless LAN is that information can be exchanged between a PC or other such equipment and an access point using radio waves as long as you are within range for radio transmissions.

On the other hand, because the radio waves can travel through obstacles (such as walls) and are available everywhere within a given range, problems of the type listed below may occur if security-related settings are not made.

- Interception of communication
  A malicious third party may intentionally intercept wireless communications and see their contents, including possibly:
  - Personal information such as IDs, passwords, and credit card numbers
  - The contents of email messages

- Unauthorized access
  A malicious third party may access the individual's or company's internal network without permission and carry out actions such as the following:
  - Retrieve personal and/or secret information (information leak)
  - Spread false information by impersonating a particular person (spoofing)
  - Overwrite intercepted communications and issue false data (tampering)
  - Spread harmful software such as a computer virus and crash your data and/or system (system crash)

Since most wireless LAN cards or access points are equipped with security features to take care of these problems, you can reduce the possibility of these problems occurring when using this product by making the appropriate security settings for the wireless LAN device.

Some wireless LAN devices may not be set for security immediately after purchase. To decrease the possibility of occurrence of security problems, before using any wireless LAN devices, be absolutely sure to make all security-related settings according to the instructions given in the operation manuals supplied with them.

Depending on the specifications of the wireless LAN, a malicious third-party may be able to break security settings by special means.

Please contact your dealer if you need help taking care of security settings or other such.

Panasonic asks customers to thoroughly understand the risk of using this product without making security settings, and recommends that the customer make security settings at their own discretion and responsibility.
About this document

• These operating instructions assume use of the Windows 10 operating system and the Internet Explorer 11 web browser. Although a tablet can be used instead of a computer for the client function, the descriptions in the operating instructions assume the use of a desktop computer.
• Depending on your environment and settings, your screen may not match the screens shown in the operating instructions.
• For information about the operation of your computer, Windows operating system and the various routers, please see their respective instruction manuals.
• In this document, "(page X)" indicates a page to be referenced.
• The contents of this document are subject to change without prior notice.
• Unauthorized reproduction of the contents of this document in whole or in part is prohibited.
• Names of menus, tabs, buttons and strings in screens are given in square brackets ([ ]).
• Arrows (→) are used to indicate selection of a submenu from a higher-level menu.

Terms used in this document

Device
“Device” refers to a Panasonic display device (projector or flat panel display).

Peripheral device
“Peripheral device” refers to a network camera or DIGITAL LINK Switcher connected to the same network as a device.
• You can register a network camera on its own or by linking it to a device. When you link it to a device you can check the video displayed by the device or perform stop determination of videos. Furthermore, you can register a DIGITAL LINK Switcher by linking it to a device to check the input/output condition and fan condition of the DIGITAL LINK Switcher connected to the device.

Early warning function
A function to monitor the status of displays and their peripheral devices on the intranet in order to detect early warning signs and issue error notifications. In order to continue using the function, you need to purchase a license.

Server function
The monitoring and control functions that run on the computer (monitoring and control terminal) on which this software is installed. You can also add the early warning function (paid) by purchasing a license and activating the software. You can try a 90-day trial version (free of charge) of the early warning function.
Terms used in this document

Client function
The early warning function (paid), which can be operated by using a web browser.

Activation
The act of enabling the early warning function (paid) by purchasing a license and activating the software.
For details about licenses, see page 25.

DHCP (Dynamic Host Configuration Protocol) server
A server that automatically issues an IP address and other required information to a computer that is temporarily connected to the network.

PASS
The Panasonic Professional Display and Projector Technical Support Website. PASS manages licenses for the early warning function (paid), which means you must log in to PASS to activate it. For details, please visit the following websites.
https://panasonic.net/cns/projector/pass/
https://panasonic.net/cns/prodisplays/pass/

SNMP (Simple Network Management Protocol)
A protocol for monitoring and controlling communication equipment connected to the TCP/IP network over the network. SNMP consists of an SNMP manager on the management side and SNMP agents on the managed side. A notification sent from an SNMP agent to an SNMP manager is called an "SNMP trap".

Light ID
A visible light communication technology that uses flashes of light to convey information quickly and securely.
The LinkRay Light ID solution service provided by Panasonic works as follows.
Using the camera on your mobile device (smart phone or tablet) and dedicated application software, you can receive Light ID signals and then acquire and display the contents linked to the Light ID signal on the screen of your device.
• For details on the LinkRay Light ID solution service, visit the following website.
  https://panasonic.net/cns/LinkRay/
Introduction

What You can do with this Software

The purpose of this software is to centrally manage the equipment located in a particular network, for example in a school or company. The software makes it possible to monitor and display the status of multiple devices and their peripheral devices on the intranet and to issue error notifications.

In addition, by purchasing a license and adding the early warning function, it is possible to detect early warning signs and issue notifications, not just after, an error has occurred, and even issue notifications about scheduled maintenance such as cleaning and parts replacement. You can even use a Web browser on your tablet or laptop computer to check the status of Devices and their peripheral devices from a remote location inside the intranet.

Monitoring / Control Terminal*1

E-Mail transmissions

SNMP trap transmissions

WLAN

Peripheral devices

Monitoring / Control

Client terminal*2

Mail server

SNMP manager

Advance notice for maintenance cycles

Device

Notes

Please note that the software cannot predict the breakdown of devices and their peripheral devices in all instances. Also, the details displayed in an error notification will differ depending on the device or peripheral device.

For the devices and peripheral devices compatible with this software, please visit the following web pages:

https://panasonic.net/cns/projector/download/application/multiprojector/

https://panasonic.net/cns/prodisplays/download/software/multi/

*1 The computer on which this software (Multi Monitoring & Control Software) is installed.

*2 On a tablet or laptop computer, a Web browser can be used to access the monitoring and control terminal and check the status of the devices and their peripheral devices.
What You can do with this Software

Monitoring and control functions

This section describes the main functions that are carried out from the monitoring and control terminal.
The early warning function (paid) can be added by activating it. (page 13)

Registering and updating devices

Register device (page 41)
You can register devices that have been connected to the intranet. (Maximum of 2,048)
- Add a new device (page 41)
- Update registered information (page 57)
- Register peripheral device
  - Network camera (page 53)
  - DIGITAL LINK Switcher (page 41)
- Create group (page 61)
- Create keyword (page 63)
- Create brightness control for a group (page 66)

Update device information (page 70)
If the IP address of a connected device is being used by another registered device, an icon appears indicating that the device was not recognized due to a mismatch with the registered information. In this case, you may continue to use the device by updating its registration information.

Manage location information (Map UI) (page 73)
You can manage the placement of devices on a per-group basis.
- Control device (page 76)
- Register schedule (page 76)

Confirming the status of devices and peripheral devices

Monitoring (page 78)
You can display and monitor the status of devices and peripheral devices.
- Brief information display (page 78)
- Detailed information display (page 86)
- Network camera image display (page 88)
- Display an image input into a device (page 90)
- Error display (page 92)
What You can do with this Software

■ Controlling devices

Execute control command (page 110)
You can control multiple devices at once (power off/on, input switching, etc.).

Scheduling function (page 120)
The following functions can be executed at a specified date and time.
- [Operation Settings] (page 123)
- [Command Settings] (page 124)
- [Simultaneous image distribution] (page 125)
- [Distribution image deletion] (page 125)
- [Interrupting delivery] (page 134)
- [Distribute captions] (page 142)
- [Stop caption distribution] (page 144)
- [Brightness Control] (page 146)
- [Delivering contents list] (page 149)
- [Light ID Control] (page 162)

Calling the Content Manager (page 166)
The Content Manager of the projector can be called up from this software.

Acquiring and Delivering a Signage Schedule (page 167)
This function allows you to acquire the signage schedule configured for a projector and then deliver the signage schedule to multiple other projectors.

■ Managing and configuring information

Manage Light ID information (page 95)
You can manage multiple imported Light IDs simultaneously.

Display system history information (page 187)
The status information (errors, warnings and notifications) and history for all devices registered in the monitoring and control terminal are displayed.

Set up the early warning function (paid) (page 226)
The settings for the early warning function are configured on the monitoring and control terminal.

Notes
- The settings that can be selected for the devices and the functions that can be used may differ from one device model to another. For the supported functions for each device model, refer to the “List of Compatible Device Models” on one of the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/
What You can do with this Software

Early warning function (paid)

The function can be added by purchasing a license and activating the software. This function can be run on the monitoring and control terminal where this software is installed, or remotely by logging in from a web browser.

- You can try the early warning function for free of charge for 90 days after installing this software.

Performing activation (on the monitoring and control terminal)

Activating (page 30)

Activate the license to enable the early warning function. Once the early warning function is enabled, you can access the monitoring and control terminal from a web browser.

- To purchase a license, choose the maximum number of units to be registered and the expiration date (one year or three years). For details about licenses, see page 25.

Check the status of devices and peripheral devices (on the client terminal)

Early warning monitoring (page 171)

This function provides details on the cause and what measures to take when a device generates errors and warnings. It also gives advance warning when a part (specific parts) used in a device is likely to break down and when part maintenance should be performed based on customer usage.

History display (page 187)

Shows the history of past errors, warnings, and notification details.

Device temperature/voltage display (page 210)

Allows you to view the internal temperature and voltage status of devices.

DIGITAL LINK Switcher status check function (page 179)

Allows the input/output condition and fan condition of a DIGITAL LINK Switcher to be checked.

Network camera video display (page 193)

You can use a camera to remotely view the image being displayed by a device.

Simple control of devices (page 190)

Allows you to perform off/on controls for the power, shutter function, and AV muting function on registered devices.
What You can do with this Software

**Editing function (on the client terminal)**

<table>
<thead>
<tr>
<th>Maintenance cycle editing function (page 207)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to configure the length of time after which consumable parts replacement, parts cleaning, and regular parts replacement should be performed (maintenance cycles) for registered devices.</td>
</tr>
</tbody>
</table>

**Early warning function settings (on the monitoring and control terminal)**

<table>
<thead>
<tr>
<th>SNMP trap transmissions (page 227)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Informs the SNMP manager (network device management software) of errors, warnings and notifications by sending an SNMP trap (when they occur or are cleared).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mail send function (page 230)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sends information on errors, warnings and notifications to a preset mail address.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Detect presence of output image (page 193)</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can detect the presence of an output image from a device based on the image from the network camera assigned to that device, and issue a notification if image output has stopped.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modify notification settings (page 236)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the following steps to set the number of days remaining until a consumable parts replacement, regular periodic cleaning and non-consumable parts replacement are announced and to make settings to send notifications via mail or SNMP transmission.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set a warning to report that a device is not connected (page 234)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the conditions for issuing a warning to report that a device is not connected, or specify time periods during which disconnection warnings will not be output.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User account (page 238)</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can specify the use authority of users that access a monitoring and control terminal from a client terminal.</td>
</tr>
</tbody>
</table>
## System Requirements

### Software Operating Environment

The computer that will be used as a monitoring and control terminal and where the software will be installed must meet the following requirements.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The software works in 32-bit mode on 64-bit Windows.</td>
<td>• Compatible with English, Japanese or Chinese language versions of the above operating systems. (In the Chinese language version, the display is in English when the software is run from a web browser.)</td>
<td>• Microsoft Internet Information Services (IIS) is automatically enabled when the software is installed.</td>
</tr>
</tbody>
</table>

| Software library | Microsoft .NET Framework 4.7 | • Enable the installed .NET Framework 4.7 function. (page 21) |

| Web browser | Internet Explorer 11.0, Microsoft Edge | • Excluding Modern UI Internet Explorer 11 for Windows 8.1. | • The software should operate in most web browsers, excluding those above, but correct operation is not guaranteed. |

| CPU | Intel® Core™ i5 or better, or equivalent processor |

| Memory | 4,096 MB or higher |

| Hard disk free space | 100 GB or more | • Required capacity increases with increasing number of units. (Roughly 50 MB per unit.) |

| Other details | LAN connector (10Base-T/100Base-TX) | A display with a resolution of 1,366 × 768, High Color (16-bit) or better |

---

Note that this does not guarantee that any computer satisfying the above requirements will be able to run the software.
## System Requirements for Client Terminal

A web browser is used to log on to the monitoring and control terminal and view the monitoring screen. With a LAN function and any of the web browsers listed below, a tablet can also be used for access.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| **Windows** | Use any of the following web browsers. Web browser: Internet Explorer 11.0, Microsoft Edge  
- Excluding Modern UI Internet Explorer 11 for Windows 8.1.  
- The software should operate in most web browsers, excluding those above, but correct operation is not guaranteed.  
- When using Internet Explorer, you can use the web screen display function available on network cameras. However, installation of a display plug-in or DirectX may be required depending on the camera. The web screen display function cannot be used in Microsoft Edge. (As of October 2019) |
| **iOS** | iPad or iPhone running iOS 10, 11, 12  
Web browser: Safari  
- Operation is not supported when displaying the desktop version of the site.  
- Operation is not supported when using Split View of the Multitasking function.  
- Operation of the web screen display function available on network cameras is not guaranteed. (This is due to the browser being unsupported by the camera.)  
- When displaying the <Web Control> window of devices on an iPhone, it will be displayed in the same screen instead of in a new tab. |
| **Android** | Tablet running Android 6.0, 7.0, 8.0, 9.0, 10.0  
Web browser: Google Chrome |

**Note that this does not guarantee that any computer satisfying the above requirements will be able to run the software.**

**Notes**

- A separate wireless access point is required to access the monitoring and control terminal from a client terminal via a wireless LAN.
Network Configuration

The following sections describe how to connect a monitoring and control terminal, client terminals*, and devices and their peripheral devices via a network connection.

* The client terminal needs to be connected when using the early warning function (paid).

■ Necessary Environment for Computers to be Connected
Confirm that the following LAN configuration is in place before connecting the computer to the intranet.

Computer with a built-in LAN function
• Is your LAN switched on?

Computer without a built-in LAN function
• Is your LAN adapter properly recognized?
• Is your LAN adapter switched on?
• Install the required driver for the LAN adapter before making a connection. Install the driver according to the instructions in the operating instructions supplied with the LAN adapter.

Notes
• The monitoring and control terminal should be set to a unique, fixed address on the network, without obtaining an IP address automatically from a DHCP server.
• Installation of security features such as firewalls or LAN adapter utilities may prevent the software from establishing a connection to an intranet. Consult the administrative user if a connection cannot be established.
• There is no guarantee that the software will work with any LAN adapter or any computer with a built-in LAN adapter.

■ Setting the Computer
Please use a crossing cable to connect the computer and device when it is directly connected to the LAN outside the intranet.
Use a straight cable for the connection when a hub or other device is used to connect the computer and device.

Network Setup
• Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment. (Please consult your network administrator for details.)
• If “Use automatic configuration script” is checked in your web browser, uncheck it.
• If “Use a proxy server for your LAN” is checked in your web browser, uncheck it or specify the device IP address in “Exceptions” in the advanced proxy settings.

Notes
• Depending on the system configuration, whether it is straight, cross, or both to be used, will differ. Please consult your network administrator for details.
Setting the Device

Network Setup
Set the HOST NAME (DEVICE NAME), IP ADDRESS, SUBNET MASK, and DEFAULT GATEWAY according to the operating environment. (Please check with your network administrator for details.)

Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on the LAN.

If the entered IP address is used by another device, the device cannot be registered.

- For models that can be set, enable WEB control, PJLink Control, Network Control, and Network Standby.
- For devices that need to set an administrator account, perform the settings of the administrator account.
- For models in which the Web port number can be set, set the port number to “80”.
- For models in which command control can be set, set the port number to the same number. (Default setting value: 1024)

Flat-Panel Display Settings
When registering a flat-panel display that belongs to the Rich information model group to the software, various settings on the display itself must be configured.

When registering a flat-panel display that belongs to the Basic information model group to the software, settings configuration on the display itself is not required.

To see which group the device to be registered belongs to, see page 27.

- Change the [Options] menu of the flat panel display unit as follows.

<table>
<thead>
<tr>
<th>[LAN Control Protocol]</th>
<th>Set to [Protocol 2].</th>
</tr>
</thead>
<tbody>
<tr>
<td>[RS-232C/LAN Information Timing] or [Information timing]</td>
<td>Set the conditions for the detection of warnings and errors.</td>
</tr>
</tbody>
</table>

Notes

- For how to set a device or peripheral device, check the operation manual of the device or peripheral device you are using.
- This software identifies the device using the configured IP address. If DHCP is set to ON in the device network setting in a network environment that uses a DHCP server etc. the DHCP server may change the IP address allocated to the device, making it impossible to connect using this software. Please ensure that the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP address allocated to the device. (Consult your network administrator for details.)
- If a flat-panel display registered as a Rich information model automatically switches to the standby state during monitoring due to activation of the “No activity power off” function or other reasons, a warning is issued. To prevent warnings from being issued, it is necessary to change the configuration of the display so that it does not switch automatically to a standby state.
- If a flat-panel display registered as a Basic information model automatically switches to the standby state, a warning will not be issued.
- Configure the current time and on-screen menu language settings on a flat-panel display registered as a Rich information model if the settings are available.
- A warning may be issued if the display is used without configuring these items. If a flat-panel display is registered as a Basic information model, a warning will not occur even if you do not set the current time or select an on-screen menu language.
Steps to Start Operation

The steps from software installation to start of operation are listed below.

Installing the software

1. Downloading the installation file (page 20)

2. Installing the software (page 20)

Adding the licensed function

3. Setting the administrator password (page 28)

4. Purchasing a license and obtaining a key code (page 30)

5. Exporting the volume serial number (page 30)

6. Obtaining an activation code (page 32)

7. Activating the license (page 33)
## Installing the Software on the Monitoring and Control Terminal

If you are using a previous version of the “Multi Monitoring & Control Software” or “Early Warning Software”, you can continue using your existing data as-is by following the installation procedure below.

### Downloading the installation file

1. You can download the installation file from the following websites.
   - https://panasonic.net/cns/projector/download/application/multiprojector/
   - https://panasonic.net/cns/prodisplays/download/software/multi/

2. The terms for the application software download will appear. After reading them, click [Agree].
   - File name: MMCS_V3xxx_Setup.zip (where “3xxx” is the software version).

### Notes

- If the version of the software is not compatible with your devices, some device information may not be displayed. Please download the latest software.

### Installing the software

Install the software on the monitoring and control terminal.

**Preparation:**
- Make sure the Windows Update program is up to date.
- Verify that .NET Framework 4.7 is installed on your computer and that the .NET Framework 4.7 function is enabled.
- Close all programs that are running on Windows.

1. Extract the file “MMCS_V3xxx_Setup.zip” after it has finished downloading.

2. Double click “Setup.msi” in the folder created during extraction.
   - The installer will start.
   - Verify that the [Publisher] field displayed during installation is set to Panasonic Corporation before continuing the installation.

3. Follow the instructions on the screen to complete the installation.
   - When the installation completes, the completion screen appears.

4. Click [Close].
   - The shortcut icon will appear on the desktop.
Installing the Software on the Monitoring and Control Terminal

The following message will appear during installation

![Installer window](image)

**[Yes]**: Continue installation.
**[No]**: Abort the installation.

- For details about your computer settings and network environment, consult your network administrator.

**Notes**
- The installation may terminate un成功fully if you attempt to install the software while Windows Update is running or if the PC is in a state that requires it to be restarted.
- When using the software for the first time on a computer, always run Windows Update to install any required updates before using the software. The software may not operate if you attempt to use the software without running Windows Update.
- If .NET Framework 4.7 is not installed or the function is not enabled, an error will occur during installation of the software. In such cases, click [No] to cancel installation of the software, and enable the .NET Framework 4.7 function before performing installation again. See “Cannot install the software” in the “Frequently Asked Questions” section. (page 253)
- The update installer may take some time if there are many registered devices when performing the update installing. For example, if there are more than 513 devices registered, installation may take about ten minutes on a computer with 4 GB of memory.
Repairing or removing the software

If you run the installer again on the monitor and control terminal when this software has already been installed, a screen asking if you want to repair or remove the software appears.

1. **In step 3 of “Installing the software”** (page 20), select whether you want to “Repair” or “Remove” the software, and then click [Finish].
   - **Repair**: Repair defects in the software
   - **Remove**: Uninstall the software and reinstall it

(When “Repair” is selected)

2. **Follow the instructions on the screen to continue the installation.**
   - When the installation completes, the completion screen appears.

3. **Click [Close].**
Installing the Software on the Monitoring and Control Terminal

## Starting the software

### 1 Double-click on the desktop to start it.

You can also start the software by selecting [Start] → [Panasonic] → [Multi Monitoring & Control Software].

### Confirming the software version

1. Select [About] → [Version] from the menu.

2. After checking the version, click [Close] to close the screen.
Exiting the software

1 Click \( \times \) on the screen.
   • You can also exit by choosing [Device Management] → [Exit] from the menu.
# About Licenses

This software consists of a monitoring & control function and an early warning function. You can add the early warning function by purchasing a license and activating the software.

<table>
<thead>
<tr>
<th>Terminal where run</th>
<th>Monitoring &amp; control function</th>
<th>Early warning function (paid)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring and control terminal</td>
<td>Monitoring and control terminal</td>
<td>Network-accessible terminal after login from web browser</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Expiration date for use</th>
<th>No limit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>• Trial Version</strong>: Free of charge for 90 days from time of initial installation</td>
<td></td>
</tr>
<tr>
<td><strong>• 1-year license</strong>: Can be used for 1 year from time of activation</td>
<td></td>
</tr>
<tr>
<td><strong>• 3-year license</strong>: Can be used for 3 years from time of activation</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum number of devices</th>
<th>2,048</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>• Trial version</strong>: 2,048</td>
<td></td>
</tr>
<tr>
<td>You can choose one of the following license tiers, depending on the maximum number of devices to be registered.</td>
<td></td>
</tr>
<tr>
<td><strong>• Tier A (Diamond)</strong>: 2,048</td>
<td></td>
</tr>
<tr>
<td><strong>• Tier B (Emerald)</strong>: 512</td>
<td></td>
</tr>
<tr>
<td><strong>• Tier C (Sapphire)</strong>: 256</td>
<td></td>
</tr>
<tr>
<td><strong>• Tier D (Ruby)</strong>: 128</td>
<td></td>
</tr>
<tr>
<td><strong>• Tier E (Pearl)</strong>: 64</td>
<td></td>
</tr>
<tr>
<td><strong>• Tier F (Crystal)</strong>: 32</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>When the license expires</th>
<th>Can still be used</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>• The following early warning functions will no longer be usable.</strong></td>
<td></td>
</tr>
<tr>
<td>- SNMP trap transmissions</td>
<td></td>
</tr>
<tr>
<td>- E-Mail transmissions</td>
<td></td>
</tr>
<tr>
<td>- Notification settings</td>
<td></td>
</tr>
<tr>
<td>- Importing of device profile library</td>
<td></td>
</tr>
<tr>
<td>- Video stop determination function on a network camera</td>
<td></td>
</tr>
<tr>
<td>- Checking the status of a DIGITAL LINK Switcher</td>
<td></td>
</tr>
<tr>
<td><strong>• The icon to access the early warning function will continue to be displayed on the Brief information display area in the &lt;Device Monitoring&gt; window.</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>When number of registered devices exceeds limit of license</th>
<th>Up to 2,048 devices can be used without restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Devices above the limit can be used only the monitoring &amp; control function.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example</strong>: 300 devices are registered under license (tier D (Ruby, max 128))</td>
<td></td>
</tr>
<tr>
<td><strong>• Devices 1-128 can use both the monitoring &amp; control function and the early warning function.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>• Devices 129-300 can use only the monitoring &amp; control function.</strong></td>
<td></td>
</tr>
</tbody>
</table>

* For each registered device, you can check or uncheck [Use Early warning function] to change the number of devices that use the early warning function. (page 42)
Notes

- To raise the license tier (and increase the number of registered devices), purchase a 1-year license or 3-year license of a higher tier and activate the software license again.
- To continue using the same license tier (with the same number of registered devices) when the license period expires, purchase a license of the same tier and activate the software license again.
- To reduce the license tier during the license period (and decrease the number of registered devices), purchase a 1-year license or 3-year license of a lower tier and activate the software license again.
- When a new version of the early warning function is released, you can install it over the current software either during or after expiry of the 90-day trial period. In such an installation, the trial period of the new software will last 90 days from the date it was installed.
## Before Using this Software

### Checking whether devices are supported

For the devices and peripheral devices compatible with this software, please visit the following websites.
https://panasonic.net/cns/projector/download/application/multiprojector/
https://panasonic.net/cns/prodisplays/download/software/multi/

Devices are categorized into one of two groups depending on the type of information that can be accessed from them by the software. The difference in the type of information that can be accessed for “Rich information model” and “Basic information model” is as follows. For more information about each model, see page 175.

<table>
<thead>
<tr>
<th>Item name</th>
<th>Group designation based on accessible information</th>
<th>Rich information model</th>
<th>Basic information model</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Common items</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Name</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>IP Address</td>
<td>○</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>Shutter (AV Mute)</td>
<td>○</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Model Name</td>
<td>○</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Serial Number</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Selected input</td>
<td>○</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Power</td>
<td>○</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>Power on count</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Source Name</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Signal Freq.</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Main Version</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Network Version</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>AC Voltage</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Power on hours</td>
<td>○</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Temperature</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>Fan status</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td><strong>Projector only</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selected LIGHT</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>LIGHT Power / Operating Mode</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
<tr>
<td>LIGHT status</td>
<td>○</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td><strong>Flat-panel display only</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power consumption reduction setting</td>
<td>○</td>
<td></td>
<td>–</td>
</tr>
</tbody>
</table>

### Notes

- The Device Profile Library is updated from time to time. Before registering a new device, be sure to update the Device Profile Library. (page 35)
- May not be accessible depending on the device even if it is described as accessible in the table.
Setting early warning function

Setting the administrator password

• To use the early warning function for the 90-day trial period (free of charge), you only need to set the administrator password. (Up to 2,048 devices can be registered.)

1 Click [Early Warning Configurations] tab → [Administrator Password] tab.

2 Enter [New Password].
   A total of 64 single-byte alphanumeric characters and symbols can be registered as a password.
   • [Administrator] is the only valid administrator user name.

3 In the [Confirm Password] field, enter the same character string in step 2 and then click [Settings].
Setting early warning function

4 When the success message is displayed, click [OK].

The new password is now set, and the expiration date is displayed in the status bar at the bottom of the screen.
Setting early warning function

### Activating

Once the trial version expires (after 90 days), you will need to purchase a 1-year or 3-year license and activate it.

#### Prepare the key code of the purchased license

Make sure you have the label containing the key code for the purchased license available before activating the software using the following procedure.

#### Exporting the volume serial number

Enter the key code listed on the key code label to export the volume serial number.

Setting early warning function

2 Enter the key code on the key code label and click [Generation].
The key code is a 25-character, single-byte alphanumeric string. Enter 5 characters in each field.

3 Specify a location to save the file to and click [Save].
File name: SERIAL.LST
• The file name can be changed, but not the extension (.LST). (This document assumes the file is named SERIAL.LST.)

4 Once the file is saved, [Your Volume Serial Number.] is displayed for manual entry. Proceed to the next step.
• There are two ways to use the exported volume serial number. One is to use the saved SERIAL.LST file. The other is to directly enter the number displayed under [Your Volume Serial Number].

Notes
• If you export the volume serial number again without completing activation, the activation code acquired using the previous volume serial number is disabled and can no longer be used. When performing activation, always use the activation code acquired using the most recent volume serial number.
Setting early warning function

Obtaining an activation code

Use the exported volume serial number to log in to PASS and obtain an activation code.

1 Log in to [PASS] from one of the following websites.
   https://panasonic.net/cns/projector/pass/
   https://panasonic.net/cns/prodisplays/pass/
   • If you are not a registered member of PASS, you will need to register as a new member
     (free of charge).

2 Click [Activation] from the side menu.
   The website for issuing the activation code appears.

3 Select [Early Warning Software], and when the [Notes on Activation of Early Warning Software] appears, read it and then click [Confirm].

4 After reading the on-screen instructions, select the method for registering the volume serial number.
   [File upload →]: Upload the SERIAL.LST file
   [Manual entry →]: Manually enter the volume serial number

5 (When [File upload →] is selected)
   Follow the on-screen instructions to upload the volume serial number file (SERIAL.LST).
   (When [Manual entry →] is selected)
   ① Follow the on-screen instructions and select [License Model Number].
   ② Enter the character string displayed in [Your Volume Serial Number.] into the [Volume Serial Number], and click [Register].

6 When the key code input screen is displayed, enter the key code displayed on your key code label, and click [Next].
   The key code is a 25-character alphanumeric string. Enter 5 characters in each box.

7 When the “Your code is ready to be issued” screen is displayed, click [Save].
   When issuing is completed, the activation code for manual entry will be displayed.
   • Make a note of the activation code (30-character alphanumeric string) that is displayed to use when carrying out activation by manual input.
Setting early warning function

Activating the software

Use the activation code to carry out the activation in the software.


2. Click on an activation method to select it.
   [By import “Activation Code” file]: Import the ACTIVE.LST file (Go to step 3 in page 34)
   [By entering “Activation Code”]: Manually enter activation code (Go to step 5 in page 34)
Setting early warning function

(When [By import “Activation Code” file] is selected)

3 Select the “ACTIVE.LST” file that you saved in step 7 of “Obtaining an activation code” (page 32).

4 Click [Open] to start activation.
When activation is completed, a confirmation message will appear, displaying the [Software Model Number], [Tier], [Maximum Device (units)], and [Valid thru].

(When [By entering “Activation Code”] is selected)
5 Enter the activation code from step 7 of “Obtaining an activation code” (page 32).
The activation code is a 30-character alphanumeric string.

6 Click [Done] to start activation.
When activation is completed, a confirmation message will appear, displaying the [Software Model Number], [Tier], [Maximum Device (units)], and [Valid thru].

Notes
- When activation is completed, the valid thru date in the status bar at the bottom of the screen changes to the expiration date of the purchased license.
- Activation cannot be performed in the following cases.
  - The key code has already been used for a previous activation.
  - The key code entered when exporting the volume serial number is different from the key code entered when registering the volume serial number on PASS.
- The license expiration date of this software is calculated starting from the date of completion of activation. To continue using the software beyond the license period, you will need to purchase a new license. For details about licenses, see page 25.
Peperation

**Updating the device profile library**

If there is additional information for each device during this software is being used, you can display the additional information by updating the Device profile library even with this software.

**Downloading the device profile library**

1. Log in to [PASS] from one of the following websites.
   
   https://panasonic.net/cns/projector/pass/
   https://panasonic.net/cns/prodisplays/pass/
   
   - If you are not a registered member of PASS, you will need to register as a new member (free of charge).

2. Click [Download] from the side menu.
   
   The download page will appear.

3. Select [Utility Software] → [Multi Monitoring and Control Software] → [Device Profile Library] → [Setting file].

4. Select [Early Warning Function | Device Profile Library] → [Latest Version] → [Download].
   
   Name of compressed file: DeviceProfileLibrary_VerX.X.XX.zip (where “XX” is the version)

5. Extract the compressed file that was downloaded in step 4.
   
   Name of file: DeviceProfileLibrary_VerX.X.XX.UPD (where “XX” is the version)

**Notes**

- Since this operation is only performed when additional information is released for each device that is supported by this software, this operation is normally not necessary. When additional information is released, operations after step 3 become possible.

- To update the Device Profile Library, the software must be updated to a version that supports the Device Profile Library update file.

- When registering a new device that belongs to the “Basic information model” group, Device Profile Library update is not required.
Setting early warning function

**Updating the device profile library**

1. **Start the software. (page 23)**

2. **Open the [Early Warning Configurations] tab and click [Import of the device setting file].**

3. **Click [Yes] in the user account control screen that appears.**

4. **Select the Device Profile Library that was saved in “Downloading the device profile library” (page 35).**
   The update will begin.

5. **When the success message is displayed, click [OK].**
   - Verify the version of the Device Profile Library on the [Version] screen. (page 23)

**Notes**

- It is not possible to return a Device Profile Library to an earlier version.
- When registering devices, the software categorizes models into groups based on the Device Profile Library. For devices categorized as “Rich information model”, if no Device Profile Library corresponding to the device is imported, it is registered as a “Basic information model” device. The device will be recognized as a “Rich information model” device once you update the Device Profile Library for that device.
- The Device Profile Library is updated from time to time. Before registering a new device, be sure to update the Device Profile Library. (page 36)
- If devices that are categorized as “Basic information model” during registration are changed to “Rich information model” due to updating the device setting file, the settings related to the maintenance of that device will return to the state when it was bought. Redo the setting related to the maintenance of the device.
- For details about model groups, see page 27.
Log in from a web browser

By logging in to the early warning function (paid) using a web browser, you can monitor the status of devices from a remote location inside the intranet.

1. **Start the web browser and enter the following URL.**
   
   http://xxx.xxx.xxx.xxx/ews
   
   Where “xxx.xxx.xxx.xxx” is the IP address of your monitoring and control terminal.

2. **When the login screen appears, enter the [User Name] and [Password].**
   - For details on registering or changing user information, see page 238.

   ![Login Screen](image)

### Changing the password

You can change the password of the user registered at [User account] (page 238).

1. **In the screen of step 2 above, input the [User Name] and [Password] of the user whose password you want to change, and click [Change Password] (①).**
   - Change the Administrator password from the software. (page 28)

2. **Enter user name and password then click [Change Password].**
   - If there is a mistake in the entry, an error message will be displayed.

   ![Password Change Screen](image)

### Exiting

1. **Close the web browser.**
Uninstalling the software

1. **Follow these steps to open the [Programs and Features] window.**
   - **Windows 10:**
     ① Type “Control Panel” in the search bar to launch the control panel.
     ② From [Uninstall a program], select [Multi Monitoring and Control Software] → [Uninstall].

   - **Windows 8.1:**
     ① Press [X] while holding down the [Windows logo] key on the keyboard and select [Control Panel].
     ② From [Uninstall a program], select [Multi Monitoring and Control Software] → [Uninstall].

2. **When the confirmation message appears, select [Yes] or [No].**
   - **[Yes]:** Delete the registered device data and uninstall the software.
   - **[No]:** Uninstall the software but preserve the registered device data.
     • If you select [No], you can continue to use the preserved data after installing this software again or after upgrading the software.
   
   ![Installer dialog box](image)
Registering a Device to Monitor and Control

About the <Device Monitoring> Window

**Menu**
- Functions are arranged as individual menu items.
  - [Create New Device] (page 41)
  - [Device Management]: Device management menu excluding the registration of devices and peripheral devices.
  - [Control] (page 110)
  - [Options] (page 122, 219)
  - [View] (page 40)
  - [About] (page 23)

**Screen switching tabs**
- [Device Monitoring] (page 78)
- [Monitor on Map] (page 73)
- [Camera View] (page 89)
- [Remote Preview] (page 91)
- [Simple System history] (page 92)
- [Light ID Information] (page 95)
- [Early Warning Configurations] (page 226)
Registering a Device to Monitor and Control

About the <Device Monitoring> Window

3 Tree pane

- **[Group]**: A parent group ([Group] folder)
  This is the folder that the tree is composed from.
  - : Group folder (page 61)
  - : Network camera (page 53)
  - : Projector (Rich information model)
  - : Flat panel display (Rich information model)
  - : Illumination-type projector (Rich information model)
  - : Basic information model device

- **[Keyword]**: The keyword created will be displayed. (page 63)
- **[BrightnessControl]**: The brightness control created will be displayed. (page 66)

  - Register devices directly under the parent group ([Group] folder) or under a group folder or network camera. (page 41)
  - When you set video stop determination with a device linked to a network camera, [ ] will be displayed on the right side of the device name. (page 193)

4 Brief information display pane

Lists the status of the devices selected in the tree pane (3). (When a folder is selected, multiple lines of information are displayed.)

5 Command execution log pane

Displays the execution results of the control command (page 110) or scheduling function (page 120) and the connection status of the device.

6 Early warning function message display area

Displays the early warning function’s activation status and messages.
  - You can select whether or not to display from the menu’s [View] → [Early warning function message].

7 Status bar

Displays the status of this software.
  - You can select whether or not to display from the menu’s [View] → [Status Bar].

Notes

- Refer to the following about warnings or errors (Example: , ) displayed on the icon.
  - Tree pane (page 79)
  - Brief information display pane (page 80)
- For details about “Rich information model” and “Basic information model”, see page 27.
Registering Devices and Peripheral Devices to Monitor and Control

Up to 2,048 devices can be registered. There are several registration methods to choose from depending on your environment.

<table>
<thead>
<tr>
<th>Registration Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Individual Registration of Device]</td>
<td>Register devices or DIGITAL LINK Switchers manually (page 41)</td>
</tr>
<tr>
<td>[Auto Search of Device]</td>
<td>Search and register connected devices (page 45)</td>
</tr>
<tr>
<td>[File(.csv) Registration of Device]</td>
<td>Register devices by importing a file (page 48)</td>
</tr>
<tr>
<td>[Geometry Manager Pro]</td>
<td>Register devices by importing an external setup file (Geometry Manager Pro) (page 50)</td>
</tr>
<tr>
<td>[Network camera registration]</td>
<td>Register a network camera (page 53)</td>
</tr>
</tbody>
</table>

**Notes**

- The monitoring and control terminal cannot register devices when it is communicating with a device. Register at another time.
- When registering a flat-panel display that belongs to the Rich information model group, set [LAN Control Protocol] to [Protocol 2]. (page 18)
- To register DIGITAL LINK Switchers after completing registration of a device, see page 57.
- A DIGITAL LINK Switcher cannot be registered independently without linking it to a device.
- More DIGITAL LINK Switchers than devices cannot be registered.
- The same peripheral device can also be registered to multiple devices.
- To update the Device Profile Library of a device before it is registered and categorized into a model group, see page 36. (Early warning function (paid))
- After registering a device, if you change the [User Name] or [Password] of the administrator account or the [Password] of the PJLink of the device that is used with the WEB control function or the content manager function, the device will no longer be able to communicate and will need to be re-registered.

### Registering devices or DIGITAL LINK Switchers manually

1. Select [Create New Device] → [Individual Registration of Device] from the menu.
2 Enter the [IP Address], [User Name], and [Password] stored in the device you want to register.

- **[IP Address]**: Carefully enter the IP address assigned to the device you want to register. You cannot register the same IP address to multiple devices. If you want to register an individual device using an IP address that has already been assigned, see page 70.

- **[User Name]**: Carefully enter the user name that was configured on the device you want to register.
  - Basic information model: Registration is possible without entering a name.
  - Rich information model: If you enter a user name that does not match the name stored on the device, registration will not be possible.

- **[Password]**: Carefully enter the password that was configured on the device you want to register.

- **PJLink [Password]**: Carefully enter the password that was configured on the device you want to register.

- **[Use Early warning function]**: For each registered device, you can select or deselect this check box to change the number of devices that use the early warning function.

- **[Number of registered early-warning devices: XXXX/2048]**: The total number of devices with the check box selected is displayed as “XXXX” of the number of registered early-warning devices. (The number of devices that can be registered differs depending on the license.)

- Up to 512 characters may be entered into the fields [Memo1] and [Memo2]. Enter any comment you may want to add.
- Click [Close] to stop the device registration.
- If you are registering the device only, skip ahead to step 4.
Registering a Device to Monitor and Control

Registering Devices and Peripheral Devices to Monitor and Control

3 Select the check box of ③ and enter the DIGITAL LINK Switcher’s set [IP Address], [User Name], and [Password].

4 Click [Create] (④).
   • Devices in which an administrator account is not set, cannot be registered. Set the administrator account of the device, and then click [Create] (④).
   • Click [Close] if you decide not to perform the registration.

5 When the “registration successful” message appears, click [OK].

6 Click [Close] (⑤).
The registered device will appear in the tree pane on the <Device Monitoring> window.
Registering Devices and Peripheral Devices to Monitor and Control

Registering a new DIGITAL LINK Switcher to a device that has already been registered

1. From the tree pane on the <Device Monitoring> window, select the device to which the DIGITAL LINK Switcher is to be added then right-click it, and select [Property].

2. Click [Change peripheral device] (①) and register the DIGITAL LINK Switcher.

3. Click [Close] (②).
Registering connected devices by Auto Search

1. Select [Create New Device] → [Auto Search of Device] from the menu.

2. Enter the following items regarding the device to be registered.
   - [User Name] and [Password] of the administrator account
   - [Password] of the PJLink
   • For more information about the [User Name] and [Password], see page 42.
Registering Devices and Peripheral Devices to Monitor and Control

3. Choose a search method (①) and click [Start search] (②).

- **[Auto search (local network)]:** Find registerable devices that are connected on the same network as the monitoring and control terminal.
- **[Address range specification]:** Search the specified IP address range.

4. In the search results (③), select the leftmost check boxes of the devices to be registered.
   - If you want to use the early warning function, also select the [Early Warning registration] check box.

5. Click [Create] (⑤).
   - The registered devices will appear in the tree pane on the <Device Monitoring> window.
Registering Devices and Peripheral Devices to Monitor and Control

When an administrator account is not set

1. Click [Detected device(Not set password)] (④) (page 46).
   The detected devices will be displayed as a list.

2. Confirm the IP Address and click [WEB].
   When the setting window of the device is displayed on the web browser, perform network settings.

3. When the network settings are completed, return to the screen of step 2, and then click [Close] (⑥).
   It will return to the [Auto Device Registration] screen of step 3 on page 46.

4. Click [Start search] (②) on the [Auto Device Registration] screen, and continue to perform steps 4 and 5 of page 46.

Notes

- Searching and registering devices may take a long time.
- Depending on the state of the devices and the network environment, it may not be possible to recognize devices using the search function.
- The number of units that can be selected for early warning registration is limited by the license being used.
- Devices that can be searched for with [Auto search (local network)] are limited to those supporting the proprietary command for search. To see if a device being used supports [Auto search (local network)], refer to the “List of Compatible Device Models” on the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/
Registering devices by importing a file

1. Select [Create New Device] → [File(.csv) Registration of Device] from the menu.

2. Select the CSV file that stores the information on the devices to be registered, and click [Open].
   - A CSV file is a text file in which the fields are separated by commas. The CSV files used in this software are written in the format “IP address, user name, password, PJLink password”, with one device represented per line.
   - Example:
     192.168.0.8,User name1,Password1,PJLinkPassword1 [line break]
     192.168.0.9,User name2,Password2,PJLinkPassword2 [line break]
3 Place a check on the check box on the left side of the device you want to register.

If you want to use the early warning function, also select the [Early Warning registration] check box.

4 Click [Create] (1).

The registered devices will appear in the tree pane on the <Device Monitoring> window.

Notes

- Displaying the registered device information may take a long time.
- The passwords will be hidden behind asterisk characters (**`).
- The number of units that can be selected for early warning registration is limited by the license being used.
- Device files including devices that use a comma (,) in the user name or password cannot be imported. When registering devices that use a comma (,) in the user name or password, please register manually. (page 41)
Registering from “Geometry Manager Pro”

This function is used to register in this software the setup information of the projectors registered in “Geometry Manager Pro” which is a software application that supports the geometry correction and installation adjustments of the projectors. It is useful at such times when there are a large number of projectors to be registered because it obviates the need to register the projectors again using this software.

1. Select [Device Management] → [Importing an external setup file] → [Geometry Manager Pro] from the menu.

2. The message [The device with the same IP Address cannot be registered. OK?] is displayed.
   - [Yes]: If the IP address of the projector to be imported matches the IP address of a registered device, the projector will not be registered.
   - [No]: Cancel the import process.

3. Click [Select file].
4 Select the projector registration information file (extension: .ugk) and click [Open].

5 When the import results are displayed, check the contents and click [OK].
   • If importing has failed because the file is damaged, for instance, the message is displayed. Check whether there is problem in the projector registration information file.
Export device information

It is a function that exports registered device information for Screen Transfer.

1. Select [Device Management] → [Export of Registration device] → [Screen Transfer] from the menu.

   If you select menu after selecting (group folder) or (network camera) at the tree pane of the <Device Monitoring> window, you can only export the device information under the selected group.

2. Set the save destination and file name, and click [Save].
Registering a Device to Monitor and Control

Register a network camera

You can individually register a network camera as a peripheral device. (Maximum of 32)

- To link a registered network camera to devices or group folders, see page 55.

1. Select [Create New Device] → [Network camera registration] from the menu.

2. Enter the set [IP Address], [User Name], and [Password] of the network camera you will register.
Registering a Device to Monitor and Control

Register a network camera

3 Enter [Network camera Name] and [Memo] as necessary then click [Create].

[Network camera Name]: You can enter a maximum of 32 characters.
[Memo]: You can enter a maximum of 512 characters.

4 Click [Close].

and the [Network camera Name] (CAM-XXX (XXX: network camera’s IP address) will be displayed if not entered) entered in Step 3 will be displayed on the tree pane of the <Device Monitoring> window.
Registering a Device to Monitor and Control

Register a network camera

Linking a device

By linking a registered network camera to a device or group folder, you can monitor devices with video.

To link devices or group folders that are already registered

1 Drag the device icon or (group folder) you want to link directly under and drop it.
   - When you move a group, the groups or devices under the group will also move together.
   - Up to 99 hierarchical levels can be set for the groups.

To create and link new devices and group folders

1 Select the you want to link then right-click it and select [Create New Device] or [Create New Group].
   For further steps, see the following pages.
   - [Create New Device] (page 41)
   - [Create New Group] (page 61)

Notes

- You cannot directly link a network camera to another network camera.
- To display a registered network camera's video as an image, see page 88.
Registering a Device to Monitor and Control

Register a network camera

Change registered information

1 Select the 📷 (network camera) of the registration information you will change then right-click it and select [Property] from the tree pane of the <Device Monitoring> window.

2 Change the registered information and click [Update] (①).

3 Click [Close] (②).
Changing the Registration Information of a Device or Peripheral Device

1 From the tree pane on the <Device Monitoring> window, select the device whose registration information is to be changed, right-click it, and select [Property].
   • If you are changing a network camera’s information, see page 56.

2 Change the registered information and click [Update] (①).
   • When changing the user name and password for Content Manager authentication, uncheck [Use Administrator account settings] (②) in [User name/Password for Content Manager].
   • You can change the registration details of a DIGITAL LINK Switcher by clicking [Change peripheral device] (③).

3 Click [Close] (④).
Setting up the Fail Soft Function

If the video signal is momentarily interrupted, resulting in a continuing no-signal condition, the fail soft function on flat panel displays performs recovery processing automatically so that video continues to be displayed.

To enable the fail soft function, select one of the following.

\[ \text{Enable hot plug reset processing.} \]:
The video signal is redetected for the selected input. (Normally, you would select this option.)

\[ \text{Enable hot plug reset processing and power supply reset processing.} \]:
If recovery is not possible using hot plug reset processing, the device is powered off and then back on again.

Notes

- Enabling the fail soft function is recommended in cases where video content is played continuously over an extended period of time, such as signage applications. This function will automatically attempt to recover if an unanticipated no-signal condition occurs.
- Do not use the fail soft function in usage situations where video content is not played continuously and sometimes there is no input signal. This software will display a notification each time automatic recovery processing occurs, whether or not it is necessary.
- If recovery from a no-signal condition often fails even when [Enable hot plug reset processing.] is selected, select [Enable hot plug reset processing and power supply reset processing.] instead.
- For flat panel displays that support the fail soft function.
To see if a flat panel display being used is supported, refer to the “List of Compatible Device Models” on the following website.
https://panasonic.net/cns/prodisplays/download/software/

1. From the tree pane on the <Device Monitoring> window, select the flat panel display to which the fail soft function is to be set, right-click it, and select [Property].
Setting up the Fail Soft Function

2 Open the [Early Warning] tab, and select functions ① by checking them.

[Enable hot plug reset processing.]:
The video signal is redetected for the selected input. (Normally, you would select this option.)

[Enable hot plug reset processing and power supply reset processing.]:
If recovery is not possible using hot plug reset processing, the device is powered off and then back on again.

3 Click [Setting] ②.

After changing settings, the following message is displayed. Click [OK].

4 Click [Close] ③.

Notes

• The fail soft function is not guaranteed to prevent all situations in which video display stops.
• The fail soft function can be used when the video input signal being input to the flat panel display is a digital signal (HDMI, DVI, or DIGITAL LINK).
• The interval of the fail soft function is updated depends on the [Interval Time of Device Information] (page 220) setting.
  Example) If you set the [Interval Time of Device Information] to 60 minutes
  Even if the video connection momentarily cuts off and is in a no-signal condition, the software will not be able to recognize the momentary no-signal condition between the 60 minutes the device information is being automatically retrieved till the next automatic retrieval.
• Enabling the fail soft function also requires making settings on the flat panel display.
Changing the Device Name

You can change the registered device name.

1. From the tree pane on the <Device Monitoring> window, select the device name you want to change, and press the [F2] key on the keyboard.
   • Alternatively, you can use the following method.
     - Select the device name you want to change, and click on the device name once again.

2. Enter a new device name, and press the [Enter] key.
   You can enter up to 8 half-width upper-case letters or numerals for a flat panel display and up to 12 for a projector.

Notes
• If you change the device name on the software side, the device name on the device side will also be changed. For devices that does not support the change device name function, the device name will change back even if you change the device name.
Creating a Group

Use the steps below to manage specific groups of devices, for example by floor or by type. A total of 100 groups can be created.

1. Select (group folder) from the tree pane on the <Device Monitoring> window, right-click it, and select [Create New Group].
   - Alternatively, you can use the following method.
     - Select [Device Management] → [Create New Group] from the menu.

2. Enter a [Group Name].
   - You can enter up to 128 characters.
   - [Memo] may be added if desired. You can enter up to 512 characters.

3. Click [OK].
   - A new group icon will be created in the tree pane.

Notes
- The same name may be used for more than one group.
Moving a group

1. Drag the device icon and drop it under the (group folder) where you want to register it.
   • When you move a group, the groups or devices under the group will also move together.
   • Up to 99 hierarchical levels can be set for the groups.

Moving registered devices to a different group

Newly register a device under a group

1. Select the (group folder) you want to register then right-click it and select [Create New Device] or [Create New Group].
   For further steps, see the following pages.
   • [Create New Device] (page 41)
   • [Create New Group] (page 61)
Creating a Keyword

You need to create the keyword first when you want to monitor and control the devices as a keyword unit.

1. Select [Device Management] → [Create New Keyword] from the menu.

2. Enter the [Keyword].
   A character string of your choice of up to 128 single-byte characters may be used.
   • [Memo] may be added if desired. You can enter up to 512 characters.

3. Click [OK].
   A new keyword icon will be created in the tree pane.
Assigning a Keyword to a Device

1. From the tree pane on the <Device Monitoring> window, select the device you want to assign a keyword to, right-click it, and select [Property].
   - Alternatively, you can use the following method.
     - Select [Device Management] → [Property] from the menu.
     - Select the device in the Brief information display pane, right-click it, and select [Property] in the displayed menu.
Registering a Device to Monitor and Control

Creating a Keyword

2 Open the [Property] tab, select the keyword you want to assign from [Keyword List], and click ✂️.

The selected keyword will move to the [Registered Keyword List] on the right side. If you click ✂️, it will return to the left side.

• In order to assign multiple keywords, repeat the process above for each keyword.

3 Click [Update] (①).

4 When the “update successful” message appears, click [OK].

5 Click [Close] (②).
Creating Brightness Control

Brightness control can be registered to prevent the brightness on the projected screen from being inconsistent between each projector as a result of individual characteristics and time degradation of lamps when, for example, a group of projectors are used to display one integrated image.

1. Select [Device Management] → [Create Brightness Control] from the menu.

2. Enter a [Brightness Control Name].
   A character string of your choice of up to 128 single-byte characters may be used.
   • [Memo] may be added if desired. You can enter up to 512 characters.

3. Click [OK].
   A new brightness control icon will be created in the tree pane.
Assigning brightness control to a projector

1. From the tree pane on the <Device Monitoring> window, select the projector you want to assign a brightness control to, right-click it, and select [Property].

   • Alternatively, you can use the following method.
     - Select [Device Management] → [Property] from the menu.
     - Select the projector displayed on the Brief Information Display, right-click it, and select [Property] from the displayed menu.

   ![Image of the software interface showing the tree pane and property selection]

   **Notes**

   • The same brightness control cannot be assigned to projectors of different series. Assign a different brightness control to each projector series.
Registering a Device to Monitor and Control

Creating Brightness Control

2 Open the [Property] tab and select the brightness control you want to assign from [Brightness Control Setting].

   The brightness controls that are already created will be listed. (page 66)

3 Click [Update] (①).

4 When the “update successful” message appears, click [OK].

5 Click [Close] (②).

Notes

- Assignment of brightness control is possible only for projectors equipped with a brightness control function. The pull-down menu will not appear for projectors without this function.
- To assign the brightness control, from the [MAIN MENU] of the projector’s onscreen menu → [PROJECTOR SETUP] → [Brightness Control] → [Brightness Control Setting] → [Mode] (or [Fixed Mode]) set to “PC”.
- The brightness control that has been assigned to a projector in a series different from that of the selected projector will not be displayed in [Brightness Control Setting].
Deleting (A device, group, keyword, brightness control, or network camera)

1 From the tree pane of the <Device Monitoring> window, select the icon of the device, group, keyword, brightness control, or network camera to be deleted, right-click it, and select [Delete].
   - Alternatively, you can use the following method.
     - Select [Device Management] → [Delete] from the menu.
   - When you select a folder, the folder and all its contents are deleted. (A parent group ([Group] folder) cannot be deleted.)

2 When the confirmation message is displayed, click [Yes].
   The selected item is deleted from the tree pane.
Registering a Device to Monitor and Control

Updating Device Registration Information

If a device with a different model name from the registered device is detected such as when replacing the device already registered with this software with a device with the same IP address, administrator account (user name and password) and PJLink (password), the “Connected icon of a different model” is displayed in the Brief Information Display pane of the <Device Monitoring> window (page 78).

When registering a device with a different model name by replacing the previously registered device, perform the following procedure.

1. From the tree pane on the <Device Monitoring> window, select the device that is marked with the ❌ icon, right-click it, and select [Update the device registration information].
Registering a Device to Monitor and Control

Updating Device Registration Information

2 Check the user name, password, keyword setting, memo, etc., and if there is no problem, click [Update].

3 Click [Update] updates the device registration information. The message that is displayed differs in each of the cases of (a), (b), (c), and (d).

(a) When the update is complete successfully
   The following message appears if the updating of the registration information is successful.

(b) When a device to which brightness control is assigned is updated to a device that does not support brightness control, or the brightness control adjustment mode of the device to be updated is set to other than “PC” mode.
   Then the following message is displayed.
   Clicking [OK] updates the device registration information in the state where the device to be updated is excluded from the brightness control target.
Registering a Device to Monitor and Control

Updating Device Registration Information

(c) When a device scheduled for [Simultaneous image distribution] or [Distribution image deletion] is updated to a device that does not support the image distribution function.
Then the following message is displayed.
Clicking [OK] updates the device registration information in the state where the corresponding schedule is deleted from the device to be updated.

(d) When the update failed
When updating the registered information fails, the following message is displayed.
• Confirm the following settings of the device to be updated.
  - [User Name] and [Password] of the administrator account
  - [Password] of the PJLink

Notes
• The group folder or keyword settings registered for the device will be transferred as-is after the update.
• The previously registered device schedule will be transferred as-is. If brightness control is released, then the schedule of brightness control is not taken over.
• If schedule for operation of a function not available with the updated device (such as DVI input switch control for a model that does not have DVI input) is taken over, then the function is not operated and results in error when the schedule is performed.
• Even if you update a device scheduled to [Simultaneous image distribution] or [Distribution image deletion] to a device that does not support the image distribution function, if the schedule is set to the group, the message (c) will not be displayed.
Registering Device Location Information

You can arrange registered devices on the map in groups in order to visually check their installation status. You can also select devices from the map to carry out device control or schedule registration.

1. Open the [Monitor on Map] tab and select the [Group] tab to import the map.

   All the existing groups including the parent group ([Group] folder) will be displayed in the tab.

2. Click [Specify Map Image] (①) and select the map to import.

   Select an image and click [Open] to import the image into the selected group.
   • Selectable image files
     - Extension: .jpg/.jpeg/.png/.bmp
     - Maximum number of pixels: 4,096 × 4,096
   • To switch the map, click [Specify Map Image] again and select another image. You can also switch images after the devices are installed.
Registering a Device to Monitor and Control

Registering Device Location Information

3 Drag and drop devices from the tree pane onto the map.

A list of the placed devices is displayed (2).
• Click [Large] or [Small] (3) to enlarge or reduce the size of the placed icons.
• Selecting the check box (4) of a device icon on the map causes the corresponding check box in the [Select] column on the device list information side to be selected as well. (It is not possible to select check boxes in the device list information selection column directly.)
• Devices can be placed inside the registered group tab.
• Group folders can be placed in a registered group one level higher.
Registering a Device to Monitor and Control

Registering Device Location Information

Deleting a device or group folder that has been placed on a map

1 Select the device or group folder to delete, and drag and drop it onto the trash can (①).
   • To delete all devices or group folders all at once, click [Delete all] (②).

2 When the confirmation message is displayed, click [Yes].
   The device moved to the trash can will be deleted from the map.

Notes
   • If you click [Delete Map image] (③), the map image will disappear, but the placed devices and group folders will remain.
Performing device control and scheduling from the map

1. Select the group tab where the devices to be configured were placed.

2. Select the check boxes of the devices and group folders to be configured and click [Control Command] (①) or [Schedule] (②).

3. (When [Control Command] is selected)
   Follow the steps in “Executing a Control Command” (page 110) to configure the control settings.

   (When [Schedule] is selected)
   Follow the steps in “Scheduling Function” (page 120) to configure the schedule settings.
Displaying the Early Warning function

1. Select a device and click the icon (1).

   This function displays detailed information about early warnings related to selected devices.
   • You can select devices from the list or from the map.
Monitoring Function

About the Brief Information Display

The <Device Monitoring> window displays brief information relating to the registered devices as a Group/Keyword/Brightness Control unit.

<Device Monitoring> window

1. **Tree pane** (page 79)
2. **Brief information display pane** (page 80)
3. **Command execution display pane**: Displays the execution results of the control command (page 110), scheduling function (page 120), connection status and the log history information of the devices.
## Icons in the tree pane

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Device is in a normal status.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Device is in a warning status. (Details of warning are displayed in the Brief information display pane to be confirmed.)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Device is in an error status. (Details of errors are displayed in the Brief information display pane to be confirmed.)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The device has a notification. (The notification can be viewed using the early warning function.)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>When you link a registered network camera to a device, and then set the video stop determination, this icon is displayed to the right side of the device name.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network camera</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A network camera is registered.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>An error has been detected with the connection of the network camera.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A group has been made.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>More than one device is in a warning status in the group.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>More than one device is in an error status in the group.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>More than one device in the group has notifications.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A keyword has been made.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Brightness control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A brightness control has been created.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>There are one or more projectors in the group for which brightness control failed to execute properly and a warning was detected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A schedule has been set up to the device, group, keyword, or brightness control.</td>
</tr>
</tbody>
</table>

### Notes
- When both a warning and an error are detected simultaneously from the same device, the error icon will be displayed. Also when a warning and an error occur simultaneously in the group, the icon is indicated as an error.
- Depending on the flat panel display model, when a warning or error has occurred, or a new warning or error occurs, icons that indicate the warning or error will not appear in the tree pane on the <Device Monitoring> window and the normal status icon will be displayed instead. For details on the models for which this limitation applies, refer to “List of Compatible Device Models” from the website below.
  https://panasonic.net/cns/prodisplays/download/software/
- You can view information on all device warnings or errors that have occurred under the [Self Test] item in the [Details] tab of the [Device Property] window. (page 86)
## Icons in the Brief information display

**[Device Name]**: Displays the projector name (host name) set for each device or displays the display name (host name) set for each flat panel display.

**[Status]**: Displays the status of the device as an icon.

### Status indication icons for the power, network connection, and shutter/AV mute

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power On" /></td>
<td>Device power is ON.</td>
</tr>
<tr>
<td><img src="image" alt="Power Off" /></td>
<td>Device power is OFF (in standby status).</td>
</tr>
<tr>
<td><img src="image" alt="Power Cool Down" /></td>
<td>Device power is OFF and cooling down.</td>
</tr>
<tr>
<td><img src="image" alt="Power Warm Up" /></td>
<td>Device power is ON and warming up.</td>
</tr>
<tr>
<td><img src="image" alt="Network Disconnected" /></td>
<td>Device has been disconnected from the network.</td>
</tr>
<tr>
<td><img src="image" alt="Same IP Address" /></td>
<td>The device connected to the network has the same IP address but different from the time of registration. The device needs to be updated. Execute the device registration information update. (page 70)</td>
</tr>
<tr>
<td><img src="image" alt="Device Information" /></td>
<td>Device information can not be acquired.</td>
</tr>
<tr>
<td><img src="image" alt="Shutter Open" /></td>
<td>Shutter is open/device is in the audio and visual mute OFF status.</td>
</tr>
<tr>
<td><img src="image" alt="Shutter Closed" /></td>
<td>Shutter is closed/device is in the audio and visual mute ON status.</td>
</tr>
<tr>
<td><img src="image" alt="Shutter Audio Mute" /></td>
<td>Shutter is open/device is in the audio mute ON status.</td>
</tr>
<tr>
<td><img src="image" alt="Shutter Visual Mute" /></td>
<td>Shutter is closed/device is in the visual mute ON status.</td>
</tr>
</tbody>
</table>

### Warning indication icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Lamp Near" /></td>
<td>Lamp replacement time is near. Please obtain a new lamp unit.</td>
</tr>
<tr>
<td><img src="image" alt="Temperature High" /></td>
<td>Intake temperature or exhaust temperature is high. Optics module temperature is high or low. Check the ventilation and exhaust temperatures to ensure that the device is used within the operating temperature.</td>
</tr>
<tr>
<td><img src="image" alt="Filter Clogged" /></td>
<td>Filter clogged warning, low remaining ARF/ACF. Please obtain a new ARF/ACF unit. Perform maintenance of the filter except for ARF/ACF.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>All other warnings Consult your retailer.</td>
</tr>
</tbody>
</table>
About the Brief Information Display

■ Error indication icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Lamp Icon" /></td>
<td>Lamp replacement is overdue, lamp illumination failed, lamp is not installed, or lamp is malfunctioning. Please exchange lamp if the replacement time is overdue. For other instances, consult your retailer.</td>
</tr>
<tr>
<td><img src="image" alt="Intake Icon" /></td>
<td>Intake temperature, exhaust temperature or optics module temperature is high. Optics module temperature is low for a certain time duration. Check the ventilation and exhaust temperatures to ensure that the device is used within the operating temperature.</td>
</tr>
<tr>
<td><img src="image" alt="Filter Icon" /></td>
<td>Filter clogged error, ACR/ARF/ACF/air filter unit not installed, filter winding failed, or there is no remaining ARF/ACF. If the remaining ARF/ACF is low, please replace the ARF/ACF unit. Perform maintenance or replacement of the filter except for ARF/ACF. Remove any foreign matter that is present. For other instances, consult your retailer.</td>
</tr>
<tr>
<td><img src="image" alt="All Errors Icon" /></td>
<td>All other errors (Lamp unit cover remaining open, fan error, shutter error, aperture error, color wheel error, ACR/ARF/ACF not installed, filter cleaning process time-out, DC voltage error, lens shift error, internal clock battery replacement is required, etc.) Consult your retailer.</td>
</tr>
</tbody>
</table>

■ Notification indication icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Notification Icon" /></td>
<td>Displayed by the early warning function when there is a notification message. Check the detailed information.</td>
</tr>
</tbody>
</table>

Notes

- When both a warning and an error are generated simultaneously, an error icon will be displayed. Refer to operating manual for the relevant device for how to respond to warnings and errors.
- Depending on the flat panel display model, when a warning or error has occurred, or a new warning or error occurs, icons that indicate the warning or error may not appear under [Status] in the brief information display pane. For details on the models for which this limitation applies, refer to “List of Compatible Device Models” from the website below.

https://panasonic.net/cns/prodisplays/download/software/

You can view information on all device warnings or errors that have occurred under the [Self Test] item in the [Details] tab of the [Device Property] window. (page 86)

■ Status icons for devices monitored for early warning

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Device Icon" /></td>
<td>Device is in a normal status.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td>Warning information has been detected by the early warning function.</td>
</tr>
<tr>
<td><img src="image" alt="Error Icon" /></td>
<td>Error information has been detected by the early warning function.</td>
</tr>
<tr>
<td><img src="image" alt="Notification Icon" /></td>
<td>Notification information has been detected by the early warning function.</td>
</tr>
</tbody>
</table>
About the Brief Information Display

■ Other brief information
You can change the items to display from [Monitor Information] (page 225) from the setting window of option.

[Camera]: When you link a network camera with a device (page 55), an icon will be displayed.

- When you click the icon, the network camera’s video will be displayed as an image. (page 88)
  - When you click the [Camera View] tab, you can display the network camera’s video as an image all at once. (page 89)
- The network camera is not linked to a device.

[Remote Preview]: An icon will be displayed when a device supports the remote preview function.

- When you click the icon, the video input into the device will be displayed as an image. (page 90)
  - When you click the [Remote Preview] tab, you can display the video input into the device as an image all at once. (page 91)
- The device does not support the remote preview function.

[ECO setup level]: The icon is displayed when the device supports the ECO management function (page 165).

- Green area increases when ECO setting items increase in the ECO management setting of the device.
- The device does not support the ECO management function.

[Image distribution]: The execution status of devices set to [Simultaneous image distribution] (page 125) or [Distribution image deletion] (page 125) is displayed as an icon.

- State where image has not been delivered yet, delivered image was just deleted, or this software has just started.
- Currently delivering an image.
- Image has been delivered.
- Image has been delivered and the image is displayed.
- Image is being delivered, or an error occurred while deleting a delivered image. Check the following points.
  - Is the device’s LAN connection normal?
  - Is the device connected with the wireless manager?
  - Is the network password set to the device?
- The device does not support the image delivery function and delivered image deletion function.
## About the Brief Information Display

<table>
<thead>
<tr>
<th><strong>[Signage information]</strong>:</th>
<th>Displays the signage playback status of devices equipped with Content Manager.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[IP Address]</strong>:</td>
<td>Displays the device’s IP address.</td>
</tr>
<tr>
<td><strong>[Lamp/Light device Runtime]</strong>:</td>
<td>Displays the runtime for the lamp or light device with the longest runtime. (The time of the installed lamp/light source number is indicated as a tooltip.)</td>
</tr>
<tr>
<td><strong>[Closed Caption]</strong>:</td>
<td>Displays closed caption mode.</td>
</tr>
<tr>
<td><strong>[Input]</strong>:</td>
<td>Displays the selected input terminal information of the device.</td>
</tr>
<tr>
<td><strong>[Source Signal]</strong>:</td>
<td>Displays the current signal name of the device.</td>
</tr>
<tr>
<td><strong>[Model Name]</strong>:</td>
<td>Displays the device model name.</td>
</tr>
<tr>
<td><strong>[Wireless Settings]</strong>:</td>
<td>Displays the WIRELESS LAN connection method (SIMPLE, S-DIRECT, M-DIRECT, etc.) configured in the projector’s menu.</td>
</tr>
<tr>
<td><strong>[Intake Air Temperature]</strong>:</td>
<td>Displays the intake air temperature information of the projector.</td>
</tr>
<tr>
<td><strong>[Optics Module Temperature]</strong>:</td>
<td>Displays the optics module temperature information of the projector.</td>
</tr>
<tr>
<td><strong>[Around Air Temperature]</strong>:</td>
<td>Displays the around air temperature information of the projector.</td>
</tr>
<tr>
<td><strong>[OSD Setting]</strong>:</td>
<td>Displays the OSD setting information of the projector.</td>
</tr>
<tr>
<td><strong>[AC Voltage]</strong>:</td>
<td>Displays the AC voltage information of the projector.</td>
</tr>
<tr>
<td><strong>[Serial Number]</strong>:</td>
<td>Displays the device serial number.</td>
</tr>
<tr>
<td><strong>[Geometry]</strong>:</td>
<td>Displays the setting information of the projector’s geometry correction.</td>
</tr>
<tr>
<td><strong>[Board Temperature (FP)]</strong>:</td>
<td>Displays the board temperature information of the flat panel display.</td>
</tr>
<tr>
<td><strong>[Exhaust Temperature (FP)]</strong>:</td>
<td>Displays the exhaust temperature information of the flat panel display.</td>
</tr>
<tr>
<td><strong>[Intake Temperature (FP)]</strong>:</td>
<td>Displays the intake air temperature information of the flat panel display.</td>
</tr>
<tr>
<td><strong>[Panel Temperature (FP)]</strong>:</td>
<td>Displays the panel temperature information of the flat panel display.</td>
</tr>
</tbody>
</table>

### Notes
- Depending on the model, some information may not be obtained from the devices. Information that cannot be obtained is displayed as "---".
- When using a projector whose lamp output can be set to Hi/Low (or normal/eco), the runtime when the lamp is set to Low is converted to an equivalent runtime when the lamp is set to High, and the corresponding total runtime is displayed.
Update device information

■ Updating automatically
The information in the <Device Monitoring> window is updated automatically according to the settings configured in “Setting the Information Updating Interval” (page 220).

■ Updating manually
1 Select [Device Management] → [Update Information] from the menu.
   • Alternatively, you can use the following method.
     - Press the [F5] button on the keyboard.

   Information update is complete when the indication in the status bar of the <Device Monitoring> window (page 39) returns to [Ready], after it changes from [Ready] to [Updating Device Information.] and a progress bar appears on the right side.
About the Brief Information Display

If the number of registered devices increases, then updating the information will take longer. If you wish to abort the update before completion, select [Device Management] → [Abort] from the menu.

The operation above changes the status bar on the <Device Monitoring> window (page 39) from [Updating Device Information.] to [Canceling...]. When the abort process is complete, the message on the status bar indicates [Ready].
Detailed Information Display

1. From the tree pane on the <Device Monitoring> window, select the device whose detailed information you want to view, right-click it, and select [Property].
   • Alternatively, you can use the following method.
     - Select [Device management] → [Property] from the menu.
     - Select the device in the Brief information display pane, right-click it, and select [Property] in the displayed menu.

2. Open the [Details] tab to view the detailed information.
   • Click [Close] to complete the Detailed Information Display.
### Displayed items

The detailed information display shows the information listed in the table below.

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Item Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Optics Module Temperature</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Device module temperature</td>
</tr>
<tr>
<td>Model Name</td>
<td>Device Runtime</td>
</tr>
<tr>
<td>Power</td>
<td>Main Version</td>
</tr>
<tr>
<td>Power supply status</td>
<td>Sub Version</td>
</tr>
<tr>
<td>Shutter (AVMute)</td>
<td>Network Version</td>
</tr>
<tr>
<td>Input</td>
<td>Serial Number</td>
</tr>
<tr>
<td>Input terminal</td>
<td>Self Test</td>
</tr>
<tr>
<td>Source Signal</td>
<td>Fan Status (FP)</td>
</tr>
<tr>
<td>Input signal</td>
<td>H Clock</td>
</tr>
<tr>
<td>Lamp/Light device Select</td>
<td>V Clock</td>
</tr>
<tr>
<td>Lamp/Light device Power</td>
<td>Power Save Setting (FP)</td>
</tr>
<tr>
<td>Lamp/Light device 1 Status</td>
<td>Board Temperature (FP)</td>
</tr>
<tr>
<td>Lamp/Light device 1 Runtime</td>
<td>Exhaust Temperature (FP)</td>
</tr>
<tr>
<td>Lamp/Light device 1 Remaining Time</td>
<td>Intake Air Temperature (FP)</td>
</tr>
<tr>
<td>Lamp/Light device 2 Status</td>
<td>Panel Temperature (FP)</td>
</tr>
<tr>
<td>Lamp/Light device 2 Runtime</td>
<td>Light Device 1 Runtime</td>
</tr>
<tr>
<td>Lamp/Light device 2 Remaining Time</td>
<td>Light Device 2 Runtime</td>
</tr>
<tr>
<td>Lamp/Light device 3 Status</td>
<td>Light device Temperature 1</td>
</tr>
<tr>
<td>Lamp/Light device 3 Runtime</td>
<td>Light device Temperature 2</td>
</tr>
<tr>
<td>Lamp/Light device 3 Remaining Time</td>
<td>Light device Temperature 2</td>
</tr>
<tr>
<td>Lamp/Light device 4 Status</td>
<td>Light device Temperature 2</td>
</tr>
<tr>
<td>Lamp/Light device 4 Runtime</td>
<td>USB Memory Capacity</td>
</tr>
<tr>
<td>Lamp/Light device 4 Remaining Time</td>
<td>AC Voltage</td>
</tr>
<tr>
<td>Intake Air Temperature</td>
<td>Geometry</td>
</tr>
<tr>
<td>Around Lamp/Light device Temperature</td>
<td>Geometry correction settings</td>
</tr>
</tbody>
</table>

### Notes

- Items indicated in the Detailed information display can be changed in the [Detailed Information] on the <Setting> window (page 225).
- If the content of a detailed information display item does not fit into its respective display area, you can display the content in its entirety as a tooltip by placing the mouse pointer on the [Item].
- In the Detailed information display, if a lamp life warning is detected, the remaining lamp time will turn yellow in the row for the problematic lamp. If a lamp life error is detected, it will turn red.
- Depending on the connected device, there may be some items that cannot be displayed. In this case, "---" is displayed.
- When using a projector whose lamp output can be set to Hi/Low (or normal/eco), the runtime when the lamp is set to Low is converted to an equivalent runtime when the lamp is set to High, and the corresponding total runtime is displayed.
Display network camera video

You can display the video of a registered network camera as an image.

Notes

- For details on registering a network camera, see the following pages.
  - Register a network camera (page 53)
  - Linking a network camera and device (page 55)

Selecting a linked device and displaying it

Preparation:
- Display the [Camera] item in the brief information display. (page 225)

1. Select 📷 (Network camera) or an icon of a device linked to a network camera or group from the <Device Monitoring> window.

2. Click 📷 on the brief information display.

A network camera image will be displayed.
- If the network camera and device is not linked, it will be displayed as “--”.
- If an image was not able to be retrieved, a [No Image] message will be displayed.
Display all at once

1. Click the [Camera View] tab in the <Device Monitoring> window.
   - The camera monitoring window will be displayed.

   ![Camera Monitoring Window]

   ① Update button
   The image display area will be updated to the latest state.
   (Automatic update interval: 5 seconds)

   ② Camera setting button
   You can display the setting window of the network camera.
   - It may be required to install the necessary plug-in software to display the setting window of
     the network camera depending on your environment. Follow the on-screen instructions and
     install the plug-in software.
   - If you cannot install the plug-in software, use the Web browser of the computer being used,
     and display the setting window of the network camera.

   ③ Image display area
   All registered network camera images will be displayed.
   - The device image selected from the tree pane will be indicated by a yellow box.
   - If a problem has occurred, a [No Image] message and the icons below will be displayed.
     - (Error): The camera is not connected to the network.
     - (Warning): It is connected to the network, but the image was not able to be retrieved.

   ④ Page switching button/Page number
   If the images in the display area do not fit in 1 page, click ▲▼ and move the page.
Display the image input into the device

Displays the video input into the device that supports the remote preview function as an image.

Notes

- To see if the device you are using supports the remote preview function, refer to “List of Compatible Device Models” on the following websites.
  - https://panasonic.net/cns/projector/download/
  - https://panasonic.net/cns/prodisplays/download/software/

Select a device and display it

Preparation:
- Display the [Remote Preview] item in the brief information display. (page 225)

1 Select a device icon that supports the remote preview function from the tree pane of the <Device Monitoring> window.

2 Click on the brief information display.

   The video input into the device will be shown as an image.
   - Devices that do not support the remote preview function will be displayed as “-”.
   - If an image was not able to be retrieved, a [No Image] message will be displayed.
Display the image input into the device

**Display all at once**

1. **Click the [Remote Preview] tab in the <Device Monitoring> window.**
   - The remote preview window will be displayed.

   ![Remote Preview Window](image)

   - **Update button**
     - The image display area will be updated to the latest state.
     - (Automatic update interval: 5 seconds)
   
   - **Image display area**
     - The video input into the device will be shown as an image.
     - The device image selected from the tree pane will be indicated by a yellow box.
     - If you drag the selected thumbnail, you can move (Change the layout) thumbnail within the image display area.
     - If an image was not able to be retrieved, a [No Image] message will be displayed.
   
   - **Page switching button/Page number**
     - If the images in the display area do not fit in 1 page, click and move the page.
   
   - **Device information display area**
     - The device status and video input information will be displayed.
Displaying the Simple System History Information

1. Click the [Simple System history] tab.

You can display the system history information in a table format.

• The information displayed is the system history for the number of items that correspond to [System log entry save count] in the [Options] → [Settings] → [General] tab of the menu. (page 221)

Simple system history information display area
Displays the following fields from the detected system history information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Checked Time]</td>
<td>Displays the date and time when the warning and error were detected.</td>
</tr>
<tr>
<td>[Group]</td>
<td>Displays the group name which target device belongs. (If the group folder of the tree pane is , the camera name set at the time of network camera registration or CAM-XXX (XXX: network camera’s IP address) will be displayed as the group name.)</td>
</tr>
<tr>
<td>[Device Name]</td>
<td>Displays the target device name (or host name).</td>
</tr>
<tr>
<td>[IP Address]</td>
<td>Displays the device’s IP address.</td>
</tr>
<tr>
<td>[Model Name]</td>
<td>Displays the device model name.</td>
</tr>
<tr>
<td>[Serial Number]</td>
<td>Displays the serial number of a device.</td>
</tr>
<tr>
<td>[Status]</td>
<td>Displays the status that occurred on the device as an icon. For detailed information on the icons, see the Brief information display (page 78).</td>
</tr>
<tr>
<td>[Details]</td>
<td>Displays the contents of the notification.</td>
</tr>
</tbody>
</table>
Displaying the Simple System History Information

Notes

- You can view information on the device warnings or errors that have occurred under the [Self Test] item in the [Details] tab of the [Device Property] window. (page 86)
- The warning information and error information are not displayed on [Self Test] even when warning or error icon is displayed on [Status] of the simple system history screen of the flat panel display. Confirm the device history information of the early warning function (page 187), or check with the device.
- Depending on the flat panel display, the warning or error icon may not be displayed on [Status] of the simple system history screen even when a warning or error occurs.
- When multiple error warnings occur at the same time, the same icon may appear more than once in [Status].
- If you want to check the details of the system history information, check [History (All Device)] in the early warning function (page 187), or select [Device Management] → [Save simple system log] and check the output file that is saved (page 93).

Saving the Simple System History Information

Perform the following procedure to output the simple system history information to a file.

1. Select [Device Management] → [Save simple system log] from the menu.

2. Set the save destination and file name, and click [Save].

The simplified system history is saved as csv format. You can see the information with Text Editor and Microsoft Excel.
Displaying the Simple System History Information

Example showing saved data

The simple system history file describes as following.

<table>
<thead>
<tr>
<th>Software name</th>
<th>Version</th>
<th>Time</th>
<th>Device Name</th>
<th>Manufacturer</th>
<th>Model Name</th>
<th>IP Address</th>
<th>Serial Number</th>
<th>Checked Time</th>
<th>Error Status</th>
<th>Self Diagnose</th>
<th>Detailed Information</th>
<th>Self Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi Monitoring &amp; Control Software</td>
<td>V03.14</td>
<td>2018/3/25 14:32</td>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:43:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>40XFIHJ</td>
<td>Panasonic</td>
<td>40XF1HJ</td>
<td>************</td>
<td>012345ABC</td>
<td>9:34:43</td>
<td>1</td>
<td>OK</td>
<td>Warning: Can't communicate</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>NAME:6366</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

1. Software name
2. Version
3. File save date and time
4. Description items: Device name, Manufacturer’s name, Model name, IP Address, Serial number, Date and Time when error generation was detected, Error status (6 digits), Contents of error, Detailed error information, Self-diagnosis information (16, 32 or 64 digits: depending on model)
5. File end indication
Managing Light IDs

1. Click the [Light ID Information] tab.
   <Light ID Information> window will be displayed.
   • If you retrieve Light ID, [Managed ID] and [Expiration date] will be displayed and you can simultaneously manage several Light IDs.

   ![Monitoring Function Interface]

   - [Get a Light ID]
     By clicking it, you can import a Light ID distribution file that includes a Light ID. When you select a file for import in the file selection screen and click [Open], the entry screen for the Light ID distribution file decompression password appears.
     • To use an encrypted Light ID distribution file, enter the password for the Light ID distribution file, and click [Setting].
     • If the Light ID distribution file is not encrypted, password entry is not required. In such cases, click [Setting] without entering a password.

   - Notes
     • An error message will appear if the password is incorrect or the Light ID information cannot be acquired. In such cases, be sure to check the Light ID distribution file and password.

   - [Delete]
     If you check the [Delete selection] field of the Light ID you want to delete at the Light ID information display area (④), and click it, the checked Light ID will be deleted.

   - [Select/deselect all]
     When you select it and click [Delete], all displayed Light IDs will be deleted.
Managing Light IDs

④ Light ID information display area
Displays the [Managed ID] and [Expiration date] of the imported Light IDs.
• Expiration date field will be displayed in yellow for expired Light IDs.
• Managed ID is a management number assigned during Light ID distribution.

Notes
• Light ID information can only be used on Panasonic displays equipped with the Light ID function.
  To see if a device being used supports [Auto search (local network)], refer to the “List of Compatible
  Device Models” on the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/
• Expired Light IDs cannot be used with the content list delivery function and Light ID control function.
• Light ID distribution files are used for issuing Light IDs to customers when Light ID purchase is
  complete. For details on purchasing a Light ID distribution file, refer to the following website.
  https://panasonic.net/cns/LinkRay/
### Displaying the ECO Power Level Monitor

This function displays the ECO power consumption level and the runtime of the projector on a daily basis. The past 30 days’ worth of ECO power level monitor information starting back from the most recent day is stored internally on the projector and can be checked by the ECO power level monitor display function.

#### Notes
- For projectors that support the ECO power level monitor display function. To see if the projector being used supports these functions, see the “List of Compatible Device Models” on the following website. https://panasonic.net/cns/projector/download/

1. From the tree pane on the *<Device Monitoring>* window, select the projector you want to assign a ECO power level monitor to, right-click it, and select [ECO Power Level Monitor].
   - When a projector that does not support the ECO power level monitor display function is selected in the tree pane of the *<Device Monitoring>* window, [ECO Power Level Monitor] cannot be selected.
   - To use this function, the date/time of the computer where this software is installed must be synchronized with the date/time of the projector.
2 When acquisition of the log is completed, the ECO power level monitor is displayed.

[ECO Power Level]
By clicking it, the ECO power level for each day of projector use is displayed.

[Runtime]
By clicking it, the runtime for each day of projector use is displayed.

The more green Leaf marks (🍏) are displayed, this indicates that a higher ECO power level has been attained and that the projector has been run with less power consumed. If information for a particular day could not be normally acquired, then the Leaf mark is displayed by a broken line. The graph is not displayed for days when the projector is not used.

To reduce the power consumed by this projector, the ECO management function on the projector must be set. Change the settings in [MAIN MENU] → [PROJECTOR SETUP] → [ECO MANAGEMENT] → [LIGHT POWER] and [AUTO POWER SAVE] in the on-screen menu of each projector.
For details, refer to the instruction manual for each projector.

Graphs displayed by the ECO power level monitor show data collected every day. The ECO management settings of a projector sometimes are not reflected immediately in the graph.

3 By clicking [Save Log] (3) on the [ECO Power Level] or [Runtime] tab, you can save the data of the ECO power level monitor.
Select the location to save the file, enter a file name of your choice, and click [Save], then you can save it in a CSV format.

4 Click [Close] to close the window.
Example showing saved data

Data is saved as follows:

1. Software name
2. Version
3. File save date and time
4. Device name
5. Model name
6. IP address
7. Description Items: Data save date, ECO power level (0 to 10), Device runtime (mins)
8. End-of-file display

Example:

```
Multi Monitoring & Control Software,,
Version,V****(**),
Time,****/** 17:28,
Device Name,Projector3,
Model Name,RW330,
IP Address,127.0.0.8,

Checked Date, ECO Level (0-10), Device Running Time (min)
*****/**, 5.60
*****/**, 4.60
*****/**, 4.60
*****/**, 8.60
*****/**, 5.60
*****/**, 7.60
*****/**, 4.420

[EOF],
```
Saving a Maintenance Log

You can save the log information containing the operating status of the device being monitored or controlled by this software in the form of files. When a problem occurs, you can give these log files to the serviceman who can use them as analysis information.

Notes

- For projectors that support the saving a maintenance log display function. To see if the projector being used supports these functions, see the “List of Compatible Device Models” on the following website. https://panasonic.net/cns/projector/download/

1. From the tree pane on the <Device Monitoring> window, select the device or group folder whose log you want to save, right-click it, and select [Save Maintenance Log File].
   - To save a batch log for all target projectors, select the parent group ([Group] folder), right-click, and select [Save Maintenance Log File].

![Image of the Software Interface]
2 A confirmation message will be displayed. Perform the operation in accordance with the information in the message.
When you click [Yes], maintenance log retrieval begins. To cancel retrieval of the maintenance log, click [No].

3 Select a folder in which to save the maintenance log and click [OK].
The acquisition of the maintenance log (system log/lamp log/brightness sensor log) of the monitored or controlled device commences. To save to a new folder, click [Make New Folder] to create a new folder.

Depending on the device, the maintenance log is saved in one of the following file formats.

<table>
<thead>
<tr>
<th>Save method</th>
<th>Log Type</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save logs individually</td>
<td>System log</td>
<td>Model Name_Serial No_System_log (without extension)</td>
</tr>
<tr>
<td></td>
<td>Lamp log</td>
<td>Model Name_Serial No_Lamp_log (without extension)</td>
</tr>
<tr>
<td></td>
<td>Brightness sensor log</td>
<td>Model Name_Serial No_BrightSensor_log (without extension)</td>
</tr>
<tr>
<td>Save logs all at once*1</td>
<td>Batch log</td>
<td>Device Name_Model Name_Serial No. (extension: .log/.bin)</td>
</tr>
</tbody>
</table>

*1 Batch logs contain all the information contained in system logs, lamp logs, and brightness sensor logs.
4 When the confirmation message is displayed, click [OK].

**Notes**
- Maintenance logs are saved in binary format.
- Maintenance log information can be checked by service personnel only.
- Maintenance logs are recorded only on devices that support them.
Saving the Information of a Registered Device

You can export all information of a registered device to a CSV file. To export device information, follow the following steps.

1. Select [Device Management] → [Save Registration Device] from the menu.

2. Set the save destination and file name, and click [Save].
   The registered device information is saved in an auto-generated file name that indicates the year, month, day, hour, minute, and second when the file was saved. You can change the file name by entering the desired file name.
   • The registered device information will be saved in CSV format. You can see the information with Text Editor and Microsoft Excel.

3. When the “saved successfully” message appears, click [OK].
Example showing saved data

The following descriptions are saved in the registered device information file.

<table>
<thead>
<tr>
<th>Software name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
</tr>
<tr>
<td>File save date and time</td>
</tr>
<tr>
<td>Description Items: Device Name</td>
</tr>
<tr>
<td>Group (If the group folder of the tree pane is , the camera name set at the time of network camera registration or CAM-XXX (XXX: network camera’s IP address) will be displayed as the group name.)</td>
</tr>
<tr>
<td>Status (Current status, error/warning information)</td>
</tr>
<tr>
<td>Camera</td>
</tr>
<tr>
<td>Remote Preview</td>
</tr>
<tr>
<td>ECO setup level (displayed numerically)</td>
</tr>
<tr>
<td>Image distribution</td>
</tr>
<tr>
<td>Signage information</td>
</tr>
<tr>
<td>IP Address</td>
</tr>
<tr>
<td>Lamp (Lamp 1 to Lamp 4)/Light device Runtime</td>
</tr>
<tr>
<td>Input</td>
</tr>
<tr>
<td>Source Signal</td>
</tr>
<tr>
<td>Model Name</td>
</tr>
<tr>
<td>Wireless Settings</td>
</tr>
<tr>
<td>Intake Air Temperature</td>
</tr>
<tr>
<td>Optics Module Temperature</td>
</tr>
<tr>
<td>Around Air Temperature</td>
</tr>
<tr>
<td>OSD Setting</td>
</tr>
<tr>
<td>AC Voltage</td>
</tr>
<tr>
<td>Serial Number</td>
</tr>
<tr>
<td>Geometry</td>
</tr>
<tr>
<td>Board Temperature (FP)</td>
</tr>
<tr>
<td>Exhaust Temperature (FP)</td>
</tr>
<tr>
<td>Intake Air Temperature (FP)</td>
</tr>
<tr>
<td>Panel Temperature (FP)</td>
</tr>
</tbody>
</table>

End-of-file display
Notes

• The content of description items that will be displayed will only be the items currently displayed in the brief information display. To change the items displayed or the display order on the brief information display, see page 225.
• “---” is shown for unsupported information or information that cannot be obtained.
Saving the Information of a Registered Device

Importing Device Registration Information

Export data created using this software can be imported. This function is useful for transferring settings information from another computer that this software is installed.

1. Select [Device Management] → [Import Settings] from the menu.

2. Select the folder containing the file to be imported and click [OK].
3 A confirmation dialog will be displayed. Perform the operation in accordance with the information in the message.

   Click [Yes] to start importing.

4 When the “imported data successfully” message appears, click [OK].
   • This software restarts automatically, and various setting information items of the computer that imported data such as device, group, keyword, brightness control, and schedule are updated.

Notes
   • Items other than devices, groups, keywords, brightness control, schedules, and setting information cannot be imported.
   • Export data created using Multi Projector Monitoring & Control Software Ver 1.* can also be imported into this software (Multi Monitoring & Control Software).
   • When “Simultaneous image distribution” is scheduled, the image being used is also imported. Due to the image data size, the file size of import data becomes larger.
   • Importing will delete all acquired signage schedules. If a signage schedule is required after importing, acquire the signage schedule again.
   • Only the data used by the multi monitoring and control functions is imported. Data from the early warning function is not included.
Exporting Device Registration Information

Devices, groups, keywords, brightness control, schedules, and setting information that are set up in this software can be exported to a file. This function is useful when transferring setting information to another computer.

1. Select [Device Management] → [Export Settings] from the menu.

2. Select export destination and click [OK].
3 When the “export successful” message appears, click [OK].

A folder containing the export data is created at the designated export destination and named according to the date and time of export.

Example: Name of data folder if export is performed at 19:56:48 on January 13, 2017: 20170113195648

Notes

- Items other than devices, groups, keywords, brightness control, schedules, and setting information cannot be exported using this function. (The data accumulated by the early warning function is not exported.)
- When “Simultaneous image distribution” is scheduled, the selected image is also exported. Depending on the image data size, the file size of the export data may become large, and it may take time to perform export process.
- Do not import the export data created with this software (Multi Monitoring & Control Software) into Multi Projector Monitoring & Control Software Ver 2.0, Ver 2.5, Ver 2.6, Ver 2.7, Ver 2.8, Ver 2.9, Ver 3.0, Ver 3.1 and Multi Monitoring & Control Software Ver 1.0. The software may stop operating.
Controlling Devices

Executing a Control Command

Devices can be controlled on an individual device basis, or on the basis of group, keyword, or brightness control.

Attention

• When turning the projector on, take care to ensure that light from the light source cannot enter the eyes of people near the projector.

1 From the tree pane of the <Device Monitoring> window, select the icon for the device, group, keyword, or brightness control that is the target of the control command.

2 Select [Control] → [Control Command] from the menu.

3 Select and click the command to be executed.

• You can execute a control command repeatedly by repeating the command execution steps.
• The result of executing the control command will be displayed under [Command Execution Result] (1) and in the "Command execution log pane" (page 39). If an invalid control command is executed or a timeout occurs, [NG] is displayed.
### Executing a Control Command

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| [Power] | **Command to use: PJLink command**
Off/on control for the power. |
| [Shutter(AVMute)] | **Command to use: PJLink command**
Open/close control for the shutter or off/on control for AV mute. |
| [OSD] | **Command to use: Proprietary command**
Controls if the Projector’s OSD information will be displayed or not. |
| [Device Input] | **Command to use: PJLink command**
Click an input terminal to select it. (For items with a [▼], hovering the mouse pointer shows the available choices.)
- Operations not listed under [Device Input] are carried out by selecting combinations of [PJLink Control] and [Status]. |
| [Direct Playback]*1 | **Command to use: Proprietary command**
The buttons numbered [1] to [6] work the same way as the numbered buttons on the remote control supplied with the device. |
| [Command Input]*2 | **Command to use: Proprietary command**
Enter the command, and click [Start]. The device is controlled according to the contents of the command entered. (You can select registered commands from a pull-down menu.)
- **[Register command]**: You can register commonly used commands. (page 112)
- **[Create command list]**: Creates a list of commands, allowing for easy sequence control. (page 113)
- After the software starts, you cannot use [Start] with a command until the device information has been updated. First update the device information, then click [Start] for a command. (page 110)
- This method cannot be used for switching of the Digital Interface Box and DIGITAL LINK Switcher inputs. |
| [DIGITAL LINK Switcher] | **Command to use: Proprietary command**
Select this to switch the input of the DIGITAL LINK Switcher. |
| [PJLink Control] / [Status] | **Command to use: PJLink command**
Select the operation to be executed by creating a combination of [PJLink Control] and [Status].
- For more information about the combinations, see page 115. |
| [Set Light ID] / [Manage ID] | **Command to use: Proprietary command**
- Clicking [Get Light ID] ② allows you to import files on which Light ID information is registered. For details, see page 95.
- For more information about the combinations, see page 118. |

*1 [Direct Playback] only works on devices that support the “Signage Schedule Acquisition and Delivery Functions”.

*2 [Command Input] only works on devices that support the “Command Transmission Function”.

*3 Panasonic displays (such as projectors and flat panel displays) supporting PJLink can perform the operations that use the PJLink command.

4 Click [Close] ③ to close the <Control Command> window.
Executing a Control Command

Registering and transmitting commands (maximum of 20)

1. Click [Register command] for [Command Input].

2. Enter the command you want to register.
   - If you read in command information (CSV format) (page 114) using [Read File] (①), you can then select the read-in commands from a pull-down menu.

   ② [Command]: Enter a command directly, or select a read-in command from a pull-down menu.
   [Memo]: If necessary, enter additional information here (maximum: 128 half-width or 64 full-width characters).
   [Send]: Transmit the command you entered to the device.

3. Click [Close] (③) to close the window.
   The command you entered is registered.
   - Registered commands can be selected from a pull-down menu on the [Control Command] window when entering commands.

Notes
- After the software starts, you cannot transmit commands until the device information has been updated. First update the device information, then transmit a command.
### Executing a Control Command

#### Creating and transmitting command list (maximum of 100)

1. Click [Create command list] for [Command Input].

2. Add an input line with [Add line] (①), and enter a command.
   - If you read in a command list (CSV format) (page 114) using [Read file] (②), you can then select the read-in commands from a pull-down menu.

   ![Command List Menu](image)

   - **[Add Interval]**: Add a line with the Interval (wait time) command. You can set the execution interval before and after the Interval command from 0 to 999 seconds.
   - **[Delete selected line]**: Delete the selected command.
   - **[All delete]**: Delete all commands from the list.
   - **[▲]/[▼]**: Change the order of the selected command in the list.

3. Click [Start] (⑤).
   - Commands are transmitted to the target device in order, starting from the top of the command list.
   - If you quit without clicking [Start], the list you created is deleted. To retain the command list you created, click [Save file] (③) to save the list in CSV format to a folder of your choice.

4. Click [Close] (⑥) to close the window.

#### Notes

- After the software starts, you cannot transmit commands until the device information has been updated. First update the device information, then transmit commands.
Executing a Control Command

■ Creating command information
Use [Register command] to create command information conforming to the following conditions that can be read into the software.
- File format: CSV
- The maximum number of commands that can be read in is 20.
- The command information consists of one command per line, with each line ending with a comma (,) and a line break.
- To enter a comment line, omit the comma (,) at the end of the line.

Example: Power ON
         Power OFF
         PON, Power ON [line break]
         POF, [line break]

■ Creating a command list
Use [Create command list] to create a command list conforming to the following conditions that can be read into the software.
- File format: CSV
- The maximum number of commands that can be read in is 100.
- The command information consists of one command per line, with each line ending with a comma (,) and a line break.
- To insert an interval between commands, add the Interval command ("Interval,XX" (XX: enter a wait time of 0 to 999 seconds)) between the commands between which you wish to insert an interval.

Example: Turn on power, then turn off power after 20 seconds.
         PON, [line break]
         Interval, 20 [line break]
         POF, [line break]
## Combinations of [PJLink Control] and [Status]

<table>
<thead>
<tr>
<th>[PJLink Control]</th>
<th>[Status]</th>
<th>Combination result</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Power]</td>
<td>[OFF]</td>
<td>Power OFF</td>
</tr>
<tr>
<td></td>
<td>[ON]</td>
<td>Power ON</td>
</tr>
<tr>
<td>[Input RGB]</td>
<td>[1]</td>
<td>Switching to the RGB input that corresponds to parameter “11” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[2]</td>
<td>Switching to the RGB input that corresponds to parameter “12” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[3]</td>
<td>Switching to the RGB input that corresponds to parameter “13” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[4]</td>
<td>Switching to the RGB input that corresponds to parameter “14” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[5]</td>
<td>Switching to the RGB input that corresponds to parameter “15” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[6]</td>
<td>Switching to the RGB input that corresponds to parameter “16” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[7]</td>
<td>Switching to the RGB input that corresponds to parameter “17” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[8]</td>
<td>Switching to the RGB input that corresponds to parameter “18” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[9]</td>
<td>Switching to the RGB input that corresponds to parameter “19” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td>[Input VIDEO]</td>
<td>[1]</td>
<td>Switching to the VIDEO input that corresponds to parameter “21” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[2]</td>
<td>Switching to the VIDEO input that corresponds to parameter “22” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[3]</td>
<td>Switching to the VIDEO input that corresponds to parameter “23” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[4]</td>
<td>Switching to the VIDEO input that corresponds to parameter “24” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[5]</td>
<td>Switching to the VIDEO input that corresponds to parameter “25” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[6]</td>
<td>Switching to the VIDEO input that corresponds to parameter “26” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[7]</td>
<td>Switching to the VIDEO input that corresponds to parameter “27” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[8]</td>
<td>Switching to the VIDEO input that corresponds to parameter “28” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[9]</td>
<td>Switching to the VIDEO input that corresponds to parameter “29” of the PJLink input switching command INPT.</td>
</tr>
</tbody>
</table>
### Executing a Control Command

<table>
<thead>
<tr>
<th>[PJLink Control]</th>
<th>[Status]</th>
<th>Combination result</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Input DIGITAL]</td>
<td>[1]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “31” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[2]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “32” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[3]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “33” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[4]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “34” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[5]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “35” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[6]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “36” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[7]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “37” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[8]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “38” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[9]</td>
<td>Switching to the DIGITAL input that corresponds to parameter “39” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td>[Input STORAGE]</td>
<td>[1]</td>
<td>Switching to the STORAGE input that corresponds to parameter “41” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[2]</td>
<td>Switching to the STORAGE input that corresponds to parameter “42” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[3]</td>
<td>Switching to the STORAGE input that corresponds to parameter “43” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[4]</td>
<td>Switching to the STORAGE input that corresponds to parameter “44” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[5]</td>
<td>Switching to the STORAGE input that corresponds to parameter “45” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[6]</td>
<td>Switching to the STORAGE input that corresponds to parameter “46” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[7]</td>
<td>Switching to the STORAGE input that corresponds to parameter “47” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[8]</td>
<td>Switching to the STORAGE input that corresponds to parameter “48” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[9]</td>
<td>Switching to the STORAGE input that corresponds to parameter “49” of the PJLink input switching command INPT.</td>
</tr>
</tbody>
</table>
## Executing a Control Command

<table>
<thead>
<tr>
<th>[PJLink Control]</th>
<th>[Status]</th>
<th>Combination result</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Input NETWORK]</td>
<td>[1]</td>
<td>Switching to the NETWORK input that corresponds to parameter “51” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[2]</td>
<td>Switching to the NETWORK input that corresponds to parameter “52” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[3]</td>
<td>Switching to the NETWORK input that corresponds to parameter “53” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[4]</td>
<td>Switching to the NETWORK input that corresponds to parameter “54” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[5]</td>
<td>Switching to the NETWORK input that corresponds to parameter “55” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[6]</td>
<td>Switching to the NETWORK input that corresponds to parameter “56” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[7]</td>
<td>Switching to the NETWORK input that corresponds to parameter “57” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[8]</td>
<td>Switching to the NETWORK input that corresponds to parameter “58” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td></td>
<td>[9]</td>
<td>Switching to the NETWORK input that corresponds to parameter “59” of the PJLink input switching command INPT.</td>
</tr>
<tr>
<td>[AVMute VIDEO]*</td>
<td>[ON]</td>
<td>AV mute (video only) ON/shutter closed</td>
</tr>
<tr>
<td></td>
<td>[OFF]</td>
<td>AV mute (video only) OFF/shutter open</td>
</tr>
<tr>
<td>[AVMute AUDIO]*</td>
<td>[ON]</td>
<td>AV mute (audio only) ON</td>
</tr>
<tr>
<td></td>
<td>[OFF]</td>
<td>AV mute (audio only) OFF</td>
</tr>
<tr>
<td>[AVMute VIDEO + AUDIO]</td>
<td>[ON]</td>
<td>AV mute (video and audio) ON/shutter closed</td>
</tr>
<tr>
<td></td>
<td>[OFF]</td>
<td>AV mute (video and audio) OFF/shutter open</td>
</tr>
</tbody>
</table>

* Panasonic devices are not currently supported.
## Executing a Control Command

### Combinations of [Set Light ID] and [Manage ID]

<table>
<thead>
<tr>
<th>[Set Light ID]</th>
<th>[Manage ID]</th>
<th>Combination result</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ON]*1</td>
<td>Select the management number (ID) of the Light ID to be used.</td>
<td>A specified Light ID signal can be transmitted from a device.</td>
</tr>
<tr>
<td>[OFF]*1</td>
<td>–</td>
<td>Light ID signals are not transmitted from a device.</td>
</tr>
<tr>
<td>[WRITING]*2</td>
<td>Select the management number (ID) of the Light ID to be rewritten.</td>
<td>The internal Light ID of a device is rewritten to a specified Light ID.</td>
</tr>
</tbody>
</table>

*1 Refer to the instruction manual and set [Light ID] to [External Control] of your device for control.
*2 Refer to the instruction manual and set [Light ID] to [Internal ID] of your device for control.

### Notes
- For the supported functions for each device model, refer to the “List of Compatible Device Models” on one of the following websites:
  - https://panasonic.net/cns/projector/download/
  - https://panasonic.net/cns/prodisplays/download/software/
- For details on individual functions and device-side operations, refer to the instruction manual of the device or peripheral device.
- If an input switching command that does not exist for a particular model has been set, “Unsupported” will be displayed in [Command Execution Result] and in the command execution log pane of the <Device Monitoring> window.
- TH-D3500 does not support the [Device Input].
- Switching of the Digital Interface Box inputs can be executed only when a Digital Interface Box is connected to a device that supports DIGITAL LINK.
- Switching of the DIGITAL LINK Switcher inputs can be executed only when a DIGITAL LINK Switcher is connected to a device that supports DIGITAL LINK.
- When the Digital Interface Box or DIGITAL LINK Switcher switch command is sent to a device that does not support DIGITAL LINK, “Unsupported” is displayed at [Command Execution Result] and in the command execution log display area of the <Device Monitoring> window.
Saving or Deleting the Log

You can save and delete the log information displayed in the log pane.

**Notes**

- Up to 10,000 log entries can be saved. Once 10,000 log entries are reached, old log entries are deleted to make room for new ones.

1. Right-click on the command execution log pane of the `<Device Monitoring>` window to display the `<Menu>` window.

2. Select [Save Log Information] or [Clear Log Information].

- [Save Log Information]: The log information is saved in CSV format in the specified folder.
- [Clear Log Information]: The log information displayed in the log pane is deleted.
Scheduling Function

1 From the tree pane of the <Device Monitoring> window, select the icon for the device, group, or device-registered keyword or brightness control group whose schedule is to be set, right-click it, and select [Schedule].
   • Alternatively, you can use the following method.
     - Select [Device Management] → [Schedule] from the menu.

2 On the schedule setting screen, select from the following operations.
   1 [Date and time specification]: Select the date and time specification to view what has already been scheduled.
   2 [Schedule addition]: Create a new schedule. (Go to step 3 in page 121)
   3 [Edit]: Edit the selected schedule. (Go to step 3 in page 121)
   4 [Delete]: Remove the selected schedule. (Go to step 4 in page 121)
3 Select the date and time, the control function to be executed, and the order to perform the operation, and then click [OK] (5).

- The following is the screen when [Schedule addition] is selected. If [Edit] is selected, the settings will be the same.

<table>
<thead>
<tr>
<th>Date Settings</th>
<th>Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time]. (You cannot set a time that is before the creation date and time.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting and Control</td>
<td>Select one of the following items and set the execution details.</td>
</tr>
<tr>
<td></td>
<td>• [Operation Settings] (page 123)</td>
</tr>
<tr>
<td></td>
<td>• [Command Settings] (page 124)</td>
</tr>
<tr>
<td></td>
<td>• [Simultaneous image distribution] (page 125)</td>
</tr>
<tr>
<td></td>
<td>• [Distribution image deletion] (page 125)</td>
</tr>
<tr>
<td></td>
<td>• [Interrupting delivery] (page 134)</td>
</tr>
<tr>
<td></td>
<td>• [Distribute captions] (page 138)</td>
</tr>
<tr>
<td></td>
<td>• [Stop caption distribution] (page 138)</td>
</tr>
<tr>
<td></td>
<td>• [Brightness Control] (page 146)</td>
</tr>
<tr>
<td></td>
<td>• [Deliverying contents list] (page 149)</td>
</tr>
<tr>
<td></td>
<td>• [Light ID Control] (page 162)</td>
</tr>
</tbody>
</table>

4 Return to the screen in step 2 and click [Close].

- When the schedule settings are done, will appear in the tree pane of the <Device Monitoring> window. If the schedule is deleted, the disappears.

Notes

- When using the schedule settings to power on a projector, the schedule should only be set up for a projector installed in an environment where light from the projector cannot enter the eyes of nearby people when the projector starts.
- Up to 100 schedules can be set.
- To see if the equipment being used supports a particular control function, see the “List of Compatible Device Models” on the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/
Checking schedules that have been set up

You can view a list of the schedules that have been set up.

1. Select [Options] → [All Schedule List] from the menu.

   ![Image of Schedule List window]

- If there are overlapping schedules for a specified device, its lines will be indicated in red. If there are overlapping schedules (with the same start time specified for multiple commands for the same device), proper operation of the device cannot be guaranteed. To change an overlapping schedule, select [Edit] or [Delete] in step 2 of “Scheduling Function”. (page 120)
- The <Schedule List> window displays a list of schedules that have been set up for each device. Schedules for up to 100 devices can be displayed at any one time. If there are schedules for more than 100 devices, buttons for moving between pages, the page number, and the total number of pages will appear at the bottom of the window.
Controlling Devices by Selecting Commands to be Sent ([Operation Settings])

Configuration by specifying a date and time in [Schedule]

1 Select the icon for the desired device, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule].

(page 120)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Operation Settings].
   • Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Select the check boxes of the items to be controlled, and then configure their settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Power]</td>
<td>Off/on control for the power.</td>
</tr>
<tr>
<td>[Shutter (AVMute)]</td>
<td>Open/close control for the shutter or off/on control for AV mute.</td>
</tr>
<tr>
<td></td>
<td>• To control AUDIO and VIDEO individually, select either [VIDEO], [AUDIO],</td>
</tr>
<tr>
<td></td>
<td>or [VIDEO + AUDIO] from the left-side pull-down menu and select [ON] or</td>
</tr>
<tr>
<td></td>
<td>[OFF] from the right-side pull-down menu.</td>
</tr>
<tr>
<td>[Input]</td>
<td>[Device Input]: Select this to switch the input to the device. (For items</td>
</tr>
<tr>
<td></td>
<td>with [▼], hovering the mouse pointer shows the available choices.)</td>
</tr>
<tr>
<td></td>
<td>[DIGITAL LINK Switcher]: Select this to switch the input of the Digital</td>
</tr>
<tr>
<td></td>
<td>Interface Box or DIGITAL LINK Switcher.</td>
</tr>
<tr>
<td></td>
<td>• Click an input terminal to select it.</td>
</tr>
<tr>
<td></td>
<td>• If you want to execute individual control, select the operation to be</td>
</tr>
<tr>
<td></td>
<td>executed by creating a combination of [PJLink Control] and [Status].</td>
</tr>
<tr>
<td></td>
<td>[PJLink Control] / [Status]: Select the operation to be executed by creating</td>
</tr>
<tr>
<td></td>
<td>a combination of [PJLink Control] and [Status].</td>
</tr>
<tr>
<td></td>
<td>• For more information about the combinations, see page 115.</td>
</tr>
</tbody>
</table>

5 Use the [Order] selectors to specify the order of the operations and then click [OK].
   The content set will be added to the schedule.
Configuring Devices by Entering Commands
([Command Settings])

The commands that can be set and the periods for disabling command reception vary depending on the device you are using. For details, refer to the instruction manual for your device.

■ Configuration by specifying a date and time in [Schedule]

1 Select the icon for the desired device, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule].
   (page 120)
2 On the schedule setting screen, click [Schedule addition] or [Edit].
3 Specify the date and time, and select [Command Settings].
   • Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Enter the command to send in [Transmitting command].
   You can only use single byte capital/small letters (alphabet), numbers, and symbols. You can enter up to 256 characters.
   • When you enter the execution file name (@“XXXXX” (XXXXX: Full pass name of the execution file)) of the application installed in your computer, you can start the application. (When the start has failed, nothing will be displayed.)
5 Put a check on the commands to send. (All commands are checked by default.)
   Checked commands will be sent in order from the top.
6 Set the command sending interval in [Transmission interval].
   Select [5], [10], [15], or [30] seconds as the sending interval for multiple commands (up to 3 commands can be sent). (Default setting value: 5 seconds)
   • The number of seconds that you select in [Transmission interval] will be invalid, if a call command is entered at Step 4.
7 Click [OK].
   The content set will be added to the schedule.
Delivering/Deleting Images
([Simultaneous image distribution] / [Distribution image deletion])

[Simultaneous image distribution]: This is a function to deliver and display specified image data to multiple devices. Additionally, characters can also be delivered superimposed on the images using the simple edit function. (page 127)

[Distribution image deletion]: This is a function to set multiple devices to the initial Panasonic APPLICATION input screen. If a delivered image is being displayed, the image can be deleted. Depending on the device, the screen may turn all black. (page 131)

Specifications for files that can be delivered

<table>
<thead>
<tr>
<th>File type</th>
<th>JPEG format and BMP format image files that the OS gives standard support (extension: .jpg/.jpeg/.bmp)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliverable image size (image resolution)</td>
<td>Up to 4,096×2,160 pixels (delivered after resizing to XGA (1,024×768) size or WXGA (1,280×800) size.)</td>
</tr>
</tbody>
</table>

- To see if the equipment being used supports [Simultaneous image distribution] and [Distribution image deletion], see the “List of Compatible Device Models” on the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/

Notes

- When [Simultaneous image distribution] or [Distribution image deletion] is performed, the device input switches to NETWORK or Panasonic APPLICATION, and remains on NETWORK or Panasonic APPLICATION input even after the completion of distribution or deletion. If the device input does not switch to NETWORK or Panasonic APPLICATION, press the “Panasonic APP” button or “NETWORK/USB” button on the remote control to change the input to “Panasonic APPLICATION”. Then, perform the simultaneous image distribution again.

- If [Display option] → [Onscreen display] → [Input guide] is set to other than Off in the device menu, and [Simultaneous image distribution] or [Distribution image deletion] is performed, the device input switches to NETWORK or Panasonic APPLICATION input, and at the same time, the input guide is momentarily displayed on the screen. In some models, after switching to NETWORK or Panasonic APPLICATION input, the input guide may continue to be displayed for about 5 minutes.

- If you do not want the input guide to be displayed when [Simultaneous image distribution] or [Distribution image deletion] is performed, set [Display option] → [Onscreen display] → [Input guide] to Off in the device menu.

- In some models, when this software is started up, an undelivered status icon is displayed in the Brief Information Display regardless of the state of the device.

- Images cannot be delivered by performing [Simultaneous image distribution] for devices in which the computer screen is displayed by using the Panasonic application software “Wireless Manager ME” used for image transfer, or “Plug and Share”. However, you can deliver images by selecting [Live mode interrupt] or [Panasonic APPLICATION] from the [Network] menu and setting [Interrupt] to [ON].

- Images cannot be delivered by performing [Simultaneous image distribution] for devices that are using the Multi Live mode of “Wireless Manager ME”. The Multi Live mode is a mode in which the images of multiple computer screens are displayed on one device.
Controlling Devices

Delivering/Deleting Images ([Simultaneous image distribution] / [Distribution image deletion])

- In some models, when the setting of [No signal auto off] is enabled in the device menu, the power supply to the device is turned off if the time set in [No signal auto off] has elapsed after [Simultaneous image distribution] or [Distribution image deletion] is performed even if the delivered image data is still being displayed. To use this function, disable the setting of [No signal auto off] in the device menu.
- When scheduling image delivery with a specified character font and exporting the setting of that device to another computer, if the font does not exist in the destination computer, the characters are displayed in the default font of the OS. The default font varies according to OS and language.
- In some models, after [Simultaneous image distribution] or [Distribution image deletion] has been performed, it may not be possible to set each item of [Image adjustment] and [Position adjustment] in the device menu.
- Images cannot be delivered by performing [Simultaneous image distribution] for devices in which the device network password is on (enabled). When the simultaneous image distribution function is used, turn off (disable) [Network] → [Password setting] in the device menu.
Distributing image data to multiple devices

**Configuration by specifying a date and time in [Schedule]**

1. Select the icon for the desired device, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule]. *(page 120)*

2. On the schedule setting screen, click [Schedule addition] or [Edit].

3. Specify the date and time, and select [Simultaneous image distribution].
   - Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4. Select the image to be delivered and the background color. *(①)*

   **[Select]:** The Image Select window appears. After you select an image to be delivered and click [OK], the image will be displayed in ④ and ⑤.

   **[Cancel]:** Delete the image selected in [Select].

   **[Color spec.]:** A color palette appears, and the selected color is set as the background color of the image.

   - The images that can be delivered are as follows.
     - Extension: .jpg, .jpeg, .bmp
     - Image size: Not exceeding 4,096 pixels on the long edge or 2,160 pixels on the short edge
   - If there is a blank in the display area when selected image is displayed on the device, the blank area will be displayed with the specified background color.
   - Image delivery is possible even in the state in which just a background color has been set without performing image selection.
5 To place text on the image to be delivered, set the text style in ② and enter the text to be displayed in ③.

[Font]: Set the text font.
[Size]: Set the text size. (10 point to 150 point)
[Position]: Specify the position where the text is to be displayed.
(Maximum: 128 single-byte characters (64 double-byte characters))
[Color]: Select the text color from the color palette.

Example: When upper left is specified in [Position]

6 Verify the results of your settings on the right side of the window under [The layout image of the picture distributed].

④: Layout of the image on the screen when delivered to a device with a resolution aspect ratio of 4:3
⑤: Layout of the image on the screen when delivered to a device with a resolution aspect ratio of 16:10

• If the delivery destination is a device with a resolution aspect ratio of 4:3, the image (4:3) in ④ is delivered, and if it is a device 16:10, the wide image (16:10) in ⑤ is delivered.

7 When you click [OK], the following message appears.
If there is no problem switching to NETWORK or Panasonic APPLICATION input forcefully when the schedule is executed, apply the schedule by clicking [Yes]. If there is a problem, reset the schedule by clicking [No].

Notes
• [The layout image of the picture distributed] is only for checking screen layout. The image is not guaranteed to exactly match the image displayed on the delivery destination screen.
• When the aspect setting of the device is changed, images might not be displayed with normal aspect.
• For details about setting the display aspect of a device, check the operation manual of the device you use.
Controlling Devices

Delivering/Deleting Images ([Simultaneous image distribution] / [Distribution image deletion])

■ Executing directly from the menu
You can set [Simultaneous image distribution] directly from the menu without setting the execution date and time in the schedule.

1. From the tree pane of the <Device Monitoring> window, select the icon for the delivery target device, group, or keyword, right-click it, and select [Simultaneous image distribution].

2. Configure the image to be delivered.
For how to configure the settings, see “Configuration by specifying a date and time in [Schedule]”. (page 127)
* When [Turn on the device power and distribute an image] (①) is checked, images are delivered after turning on the power of a device if the device is not turned on. (This operation is enabled only when devices are selected individually. This option cannot be set when a group, keyword, or brightness control is selected.)
3 When you click [Distribution] (②), the following message appears. If there is no problem switching to NETWORK or Panasonic APPLICATION input forcefully, execute the image delivery by clicking [Yes]. If there is a problem, cancel the image delivery by clicking [No].

Notes
- When turning the projector on, take care to ensure that light from the light source cannot enter the eyes of people near the projector.
- If the power of the device unit is turned off or the connection with the unit is disconnected during delivery, the delivery will fail. Check the status of the connection with the unit and then execute delivery again.
Deleting distribution images

- Deletion by specifying a date and time in [Schedule]

1. Select the icon for the desired device, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule]. (page 120)

2. On the schedule setting screen, click [Schedule addition] or [Edit].

3. Specify the date and time, and select [Distribution image deletion].
   - Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4. When you click [OK] (①), the following message appears.
   Apply the schedule by clicking [Yes] if there is no problem switching to NETWORK or Panasonic APPLICATION input forcefully when the schedule is executed. If there is a problem, reset the schedule by clicking [No].
Controlling Devices

Delivering/Deleting Images ([Simultaneous image distribution] / [Distribution image deletion])

**Directly deleting from the menu**

You can set [Distribution image deletion] directly from the menu without setting the execution date and time in the schedule.
- The Panasonic APPLICATION standby screen will appear. (Depending on the device, the screen may turn all black.)

1. From the tree pane of the <Device Monitoring> window, select the icon for the delivery target device, group, or keyword, right-click it, and select [Distribution image deletion].

2. The following message is displayed.

   If there is no problem switching to NETWORK or Panasonic APPLICATION input forcefully, execute the deletion of the delivered image by clicking [Yes]. To cancel the deletion of the delivered image, click [No].
Checking the image distribution/deletion execution status

When you execute [Simultaneous image distribution] or [Distribution image deletion], the setting status will be displayed under [Image distribution] in the Brief information display area.

- For details about the icons that are displayed, see page 82.
Delivering Images by Interruption during Signage Playback ([Interrupting delivery])

Separate content stored on a computer can be displayed on projectors during signage playback by specifying a time to interrupt playback. In addition, files stored on a computer can be copied to memory, such as SD memory cards, used by projectors.

Notes
- To see if a device being used supports [Interrupting delivery], see the “List of Compatible Device Models” on the following website.
  https://panasonic.net/cns/projector/download/

■ Types of content files that can be delivered

Still images

<table>
<thead>
<tr>
<th>Extension</th>
<th>Format</th>
<th>Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>jpg/jpeg</td>
<td>JPEG</td>
<td>- Maximum number of pixels: 8,000 × 8,000 (For progressive JPEG, maximum is 4,096 × 4,096)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- YUV format: Only YUV444, YUV422, and YUV411 supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Color mode: Only RGB supported</td>
</tr>
<tr>
<td>bmp</td>
<td>Windows Bitmap</td>
<td>- Maximum number of pixels: 2,000 × 2,000 (1, 4, 8, 16, 24, and 32 bit supported)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Following formats are not supported: Run-length encoding, Bit fields, Top to bottom, Transparent data</td>
</tr>
</tbody>
</table>

Movie

<table>
<thead>
<tr>
<th>Extension</th>
<th>Video</th>
<th>Audio</th>
<th>Video</th>
<th>Audio</th>
</tr>
</thead>
<tbody>
<tr>
<td>mov</td>
<td>H.264 / MPEG-4 AVC Motion JPEG</td>
<td>AAC</td>
<td>Resolution: Maximum 1,920 × 1,080 Minimum 240 × 180</td>
<td>Sample rate: Maximum 48 kHz (For Linear PCM, maximum 16 kHz)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linear PCM</td>
<td>Frame rate: Maximum 30 fps</td>
<td>Channel: Maximum 2 ch</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit rate: Maximum 40 Mbps</td>
<td>Bit rate: Maximum 384 kbps</td>
</tr>
<tr>
<td>avi</td>
<td>H.264 / MPEG-4 AVC Motion JPEG MPEG-4</td>
<td>MPEG-1/2 Audio Layer-3 (MP3) AAC Linear PCM</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mp4</td>
<td>H.264 / MPEG-4 AVC MPEG-4</td>
<td>AAC MPEG-4 AAC-LC</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mpg/mpeg</td>
<td>MPEG-2</td>
<td>MPEG-1/2 Audio Layer-2</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>wmv</td>
<td>WMV9</td>
<td>WMA</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

*1 Following movie files are not supported.
  - Files with the video codec of WMV7, WMV8, DivX, or Xvid
  - Uncompressed video
  - Multi-angle video
  - Files with the profile of Advanced Simple Profile @ Level 0 or Advanced Simple Profile @ Level 1

*2 Only audio playback is supported on Windows 10, and videos cannot be displayed in the preview window.
Configuration by specifying a date and time in [Schedule]

1. Select the icon for the desired projector, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule]. (page 120)

2. On the schedule setting screen, click [Schedule addition] or [Edit].

3. Specify the date and time, and select [Interrupting delivery].
   • Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4. Click [Select] (①), then select an image for interrupt playback.
   An image selection window will appear.
   • When cancelling a selected image, click [Cancel] (②).
   • When you click [OK] (③) after selecting an image, the selected image will be displayed in ④. For videos, when you click [Preview] (⑤), you can check the selected video.
5 Set the playback method.

6 [Delivering contents only]:
   Select this check box to copy a file stored on the computer to an SD memory card or similar memory device inserted in the projectors. (If this box is checked, [Playback information] cannot be entered.)

7 Enter [Playback information]:
   To specify interrupt playback of separate contents for projectors during signage playback, enter [Playback information] such as the playback start time, etc. Enter [Title], [Playback start time] and [Playback end time], or [Playback start time] and [Playback time] of the contents to deliver.

- Enter the name of the contents to deliver in [Title]. Up to 24 alphanumeric characters can be entered.
- To set the time, specify [Playback start time] and [Playback end time], or [Playback start time] and [Playback time]. Times between 00:00:10 and 24:00:00 can be specified.
- If a file with the same name as the contents for delivery already exists on the delivery destination, the destination file will be overwritten, even if the contents have a different name. In this case, the contents registered in the signage schedule will be replaced by the delivered contents.

6 Click [OK] (8).
Controlling Devices

Delivering Images by Interruption during Signage Playback ([Interrupting delivery])

Configuration directly from the menu
You can set [Interrupting delivery] directly from the menu without setting the execution date and time in the schedule.

1 From the tree pane of the <Device Monitoring> window, select the icon for the delivery target projector, group, or keyword, right-click it, and select [Interrupting delivery].

![Image of device monitoring window with interrupting delivery highlighted]

2 Select the image for interrupt playback and choose a playback method. For how to configure the settings, see “Configuration by specifying a date and time in [Schedule]”. (page 135)

![Image of interrupting delivery settings window]

3 Click [Delivery] (①) to deliver the contents information. The delivery progress status is displayed.

4 Click [Close] (②) to close the window.

Notes
• It may take a while for delivery to complete depending on the sizes of the content files.
• If the power of the device unit is turned off or the connection with the unit is disconnected during delivery, the delivery will fail. Check the status of the connection with the unit and then execute delivery again.
Caption distribution/stop
([Distribute captions]/ [Stop caption distribution])

[Distribute captions]: You can distribute a caption of your choice onto the specified position on the display to a flat panel display that is equipped with a caption playback function. (page 142)

[Stop caption distribution]: Delete a distributed caption. (page 144)

Notes
• To see if the device you are using supports the caption playback function, refer to “List of Compatible Device Models” on the following websites.
https://panasonic.net/cns/prodisplays/download/software/
• In some models, when the setting of [No signal auto off] is enabled in the device menu, the power supply to the device is turned off if the time set in [No signal auto off] has elapsed after [Distribute captions] or [Stop caption distribution] is performed even if the delivered image data is still being displayed. To use this function, disable the setting of [No signal auto off] in the device menu.
• When scheduling image delivery with a specified character font and exporting the setting of that device to another computer, if the font does not exist in the destination computer, the characters are displayed in the default font of the OS. The default font varies according to OS and language.
• Display a preview of the setting status of the caption distribution using the specified font. Preview display is a guide for operation check so it may differ from the caption display of the actual device.

Create and edit a caption list.

1 Select the icon for the desired device, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Edit and distribute captions].

• Alternatively, you can use the following method.
  - Display the schedule setting screen with Step 1 and 2 from page 120, and place a check on [Edit] or [Schedule Addition] → [Setting and Control] → [Distribute captions].
Caption distribution/stop ([Distribute captions]/ [Stop caption distribution])

2 Click [Edit caption list].

3 Select a caption to create or edit from [Caption list].

[Caption list]: To create new content, select a content that has not been created yet (or is no longer needed). To edit content, choose a list name you want to edit.

[Change]: When you click the selected List name after directly rewriting the name, the changed list name will be confirmed. Up to 32 alphanumeric characters can be entered.

[Clear]: The List name will return to its default state and the set content of the [Caption information] will be discarded.
Controlling Devices

Caption distribution/stop ([Distribute captions]/ [Stop caption distribution])

4 Input the caption you will distribute into [Input for the characters to be displayed] (①).
You can input a maximum of 512 characters.

5 Set the caption display position with [Background] (②).
- **[Position]**: Select the position to display.
- **[Transmittance]**: Set the transmittance of the background color.
- **[Color]**: Select the text color from the color palette.

6 Select whether to scroll or not with [View] of [Scroll] (③).
- To allow scrolling, click [On] and set the following items.
  - **[Position]**: Select the position to align the character string.
  - **[Speed]**: Select the caption scrolling speed from 3 levels.
  - **[Repeat count]**: Set how many times the caption distribution will repeat.
    - If you select [Infinite], it will continue repeating during distribution.
  - **[Repeat wait time]**: Set the distribution interval between captions.

7 Set a character style with [Character] (④).
  - **[Font]**: Set the text font.
    - The fonts saved in the computer being used can only be selected.
    - Since preview display is only an image, it may differ from the actual font caption displayed in the device.
  - **[Size]**: Set the text size.
  - **[Color]**: Select the text color from the color palette.
8 Click [Setting] (⑤).

The setting will be completed, and the list created will be displayed in [Distribute captions].

- Click [Setting] for each list. If you change the [List name] without pressing [Setting], the content set in [Caption information] will be discarded.
- If you click [Close] (⑥), the set content will be discarded and the setting screen will close.
Distribute the caption list

Notes
- The caption list will not be distributed to devices not connected to the network during distribution.
- When caption list distribution is performed, the content set at [Device list setting] will automatically be saved.
  The next time the caption list distribution window is started, the automatically saved set content will be displayed.
- If the power of the device unit is turned off or the connection with the unit is disconnected during delivery, the delivery will fail. Check the status of the connection with the unit and then execute delivery again.

Configuration by specifying a date and time in [Schedule]

1 Select the icon for the desired projector, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule]. (page 120)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Distribute captions].
  • Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Select a list to distribute from [Distribute captions] (1).
  • If a group or keyword icon is selected at Step 1, you can select a different list for each device.
  • If nothing is displayed in the list, it is necessary to create a caption list. (page 138)

5 Click [OK].
  The caption list distribution will be completed.
  • After the setting is complete, leave the software running. If the software ends or the computer goes into sleep mode, caption list distribution will not be performed on the date and time set.
Controlling Devices

Caption distribution/stop ([Distribute captions]/ [Stop caption distribution])

■ Configuration directly from the menu

1. From the tree pane of the <Device Monitoring> window, select the icon for a device, group, or keyword, right-click it, and select [Edit and distribute captions].

2. Select a list to distribute from [Distribute captions] (①).
   • If a group or keyword icon is selected at Step 1, you can select a different list for each device.
   • If nothing is displayed in the list, it is necessary to create a caption list. (page 138)

3. Click [Distribution].
   The set content of the list will be sent to the device to be distributed via LAN and caption list distribution will be performed.
   • To save the set content, click [Apply].
Deleting distributed captions

Delete by specifying a date and time in [Schedule]

1. Select the icon for the desired projector, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Schedule]. (page 120)

2. On the schedule setting screen, click [Schedule addition] or [Edit].

3. Specify a date and time then select [Stop caption distribution].
   Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4. Click [OK].
   Distribution settings will be deleted.
Directly deleting from the menu
Deleting captions being distributed, directly from the menu.

1. From the tree pane of the <Device Monitoring> window, select the icon for the delivery target device, group, or keyword, right-click it, and select [Caption deletion].
   Distribution settings will be deleted.
Adjusting Brightness on a per-Screen Basis
([Brightness Control])

When multiple projectors equipped with the brightness control function is used to project an integrated image, the function automatically controls the projectors so that the brightness between the projected images from each of the projectors are held uniform.

- Brightness control is a function to help you maintain the brightness of multiple projectors at a uniform level. It does not guarantee that the brightness of all projectors will completely match.

Notes
- To see if a device being used supports [Brightness Control], see the “List of Compatible Device Models” on the following website.
  https://panasonic.net/cns/projector/download/

An illustration of brightness control

During setup (uniform brightness)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

Brightness changes over time

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

Change in brightness

Brightness control

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

Brightness is corrected to be uniform

Projector settings

Configure the following settings from the on-screen menu of each projector.

1. Adjust the gain value so that the brightness of the projectors match.

2. Go to [MAIN MENU] → [PROJECTOR SETUP] → [Brightness Control] → [Brightness Control Setting], and set the [Mode] (or [Fixed Mode]) to [PC].

Notes
- For how to adjust the brightness of the projector, please refer to the operating manual for the projector being used.
Controlling Devices

Adjusting Brightness on a per-Screen Basis ([Brightness Control])

■ Execution by specifying a date and time in [Schedule]

1 From the tree pane of the <Device Monitoring> window, select the icon for the brightness control whose schedule is to be set, right-click it, and select [Schedule]. (page 120)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Brightness Control].
   • Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Click [OK] to end the setting.

■ Executing directly from the menu

You can set [Brightness Control] directly from the menu without setting the execution date and time in the schedule.

1 From the tree pane of the <Device Monitoring> window, select a brightness control icon, right-click it, and select [Manual Brightness Control].
Adjusting Brightness on a per-Screen Basis ([Brightness Control])

Checking the progress status of brightness control

When the brightness control is executed, the status bar at the bottom of the screen changes from [Ready] to [Brightness Control is being executed.] and a progress bar appears on the right side. When the display returns to [Ready], it means that brightness control execution has completed.

- If brightness control is not successful, a warning icon is displayed next to the brightness control icon on the tree pane of the <Device Monitoring> window.

---

Notes

- Brightness control may not be successful when the projector is in the following states. Check the projector status before attempting brightness control again.
  - A projector is undergoing lamp relay.
  - A projector is in standby mode (it is turned off)
  - The computer cannot connect to a projector (e.g. poor LAN cable connection)
Creating a List to Distribute Images (Delivering contents list)

The content list delivery function delivers content (still images and movies) that can be played with a USB media player or Scenario playback function, together with the corresponding play list for the content. The content must be delivered to a flat panel display equipped with the USB media player function or a projector equipped with the “Scenario” playback function in its “Memory Viewer” function.

Notes

- To use the content list delivery function, you need to insert a formatted USB memory device into the device unit. For details on the specifications of USB memory devices that can be used, refer to the instruction manual for your device.
- When you use the content list delivery function, the delivered content list (content and play list) is written to the USB memory device inserted in the device unit. If there is already content or a play list with the same file name in the delivery destination USB memory device, it will be overwritten regardless of the write-protect setting.
- Even if content is directly saved to the USB memory device after delivering the content and play list using the content list delivery function, that content will not be played as it is not registered in the play list.
- To see if a device being used supports [Auto search (local network)], refer to the “List of Compatible Device Models” on the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/
- For details on the USB media player function, refer to the instruction manual for your flat panel display.
- For details on the Memory Viewer Scenario playback function, refer to the instruction manual for your projector.
- For details on purchasing a Light ID distribution file, refer to the following website.
  https://panasonic.net/cns/LinkRay/
Creating a List to Distribute Images ([Delivering contents list])

**Types of content files that can be delivered**

<table>
<thead>
<tr>
<th>Extension</th>
<th>Format</th>
<th>Restrictions*1</th>
<th>Projector</th>
<th>Flat panel display</th>
</tr>
</thead>
<tbody>
<tr>
<td>jpg/jpeg</td>
<td>JPEG</td>
<td>Maximum number of pixels: 4,096 × 4,096</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YUV format: Only YUV444, YUV422, and YUV411 supported</td>
<td></td>
<td></td>
</tr>
<tr>
<td>jpe</td>
<td></td>
<td>Color mode: Only RGB supported</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>bmp</td>
<td>Bitmap</td>
<td>Maximum number of pixels: 2,000 × 2,000</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color bit depth: 1, 4, 8, 16, 24, 32 bits supported</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Movie**

<table>
<thead>
<tr>
<th>Extension</th>
<th>Codec</th>
<th>Restrictions*2</th>
<th>Projector</th>
<th>Flat panel display</th>
</tr>
</thead>
<tbody>
<tr>
<td>mov</td>
<td>H.264</td>
<td>AAC, HE-AAC Linear PCM</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>avi</td>
<td>H.264, MPEG4 part2</td>
<td>MPEG1 Layer2 Linear PCM</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mp4</td>
<td>H.264, MPEG4 part2</td>
<td>AAC</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ts/mts</td>
<td>H.264, MPEG4 part2</td>
<td>MP3 MPEG1 Layer2 HE-AAC</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>wmv</td>
<td>WMV9 VC-1 Simple &amp; Main</td>
<td>WMA Standard WMA9/10 Pro</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>avi</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>asf</td>
<td>H.264, MPEG4 part2 VC-1 Advanced AP@L3 VC-1 Simple &amp; Main</td>
<td>WMA Standard WMA9/10 Pro</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3gp</td>
<td>H.264, MPEG4 part2</td>
<td>AACHE-AAC</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mkv</td>
<td>H.264, MPEG4 part2</td>
<td>MPEG1 Layer2 HE-AAC</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>flv/f4v</td>
<td>H.264</td>
<td>MP3 AAC Linear PCM</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mpg/mpeg</td>
<td>MPEG2</td>
<td>MPEG1Layer2</td>
<td>○</td>
<td>×</td>
</tr>
</tbody>
</table>

---

*1 Progressive JPG is not supported.

*2 Following movie files are not supported.
- Multi-angle video
- Files with the profile of Advanced Simple Profile @ Level 0 or Advanced Simple Profile @ Level 1

*3 Depending on the type of codec, playback may not be possible even if it is within the numerical values of restrictions.
Creating a List to Distribute Images ([Delivering contents list])

Creating and editing content lists

1. Select the icon for the desired device, group, or keyword from the tree pane of the <Device Monitoring> window, right-click it, and select [Content list editing and delivery].
   - Alternatively, you can use the following method.
     - Display the schedule setting screen with Step 1 and 2 from page 120, and place a check on [Edit] or [Schedule Addition] → [Setting and Control] → [Delivering contents list].

2. Click [Content list editing].
3 Select the content list to be created or edited from the [List name] pull-down menu.

[List name]: To create new content, select a content that has not been created yet. To edit content, choose a list name you want to edit.

[Change]: When you click the selected [List name] after directly rewriting the name, the changed list name will be confirmed. Up to 32 alphanumeric characters can be entered.

[Clear]: The [List name] will return to its default state and the set content of the [Play List] will be discarded.

4 Click [Add] and select the content to be played back.

The file selection window appears. Select the content file to register to the play list and then click [Open]. (Multiple files can be selected by clicking them while pressing the Shift key.)
- If the selected file is a still image, the image is displayed in ①. If it is a movie, an icon representing the movie is displayed in ①.
- The selected file name will appear in [Play List].
5 Click [▲] / [▼] to specify the content playback sequence.

- The files displayed in [Play List] are played in order from top to bottom on the USB media player or Memory Viewer.
- To delete a file from [Play List], select the [Select] check box for the file you wish to delete and then click [Delete].

6 Enter the playback duration for each content file under [Playback time (sec)] in the [Play list].

A playback time within the range of 3 to 86,400 seconds (equivalent to 24 hours) can be set.
- In the case of a still image, the default value is 10 seconds. In the case of a movie, the playback time of the selected movie file is the initial value. The playback time may not be acquired for some of the selected movie files. If the playback time cannot be acquired, the default playback time is 10 seconds.
Creating a List to Distribute Images ([Delivering contents list])

7 **Assign the Light ID management ID to the content.**

If you import the Light ID beforehand, the Light ID pull-down menu will appear in the [Play List]. Select the Light ID management ID to assign to the content from the pull-down list.

- To add a new Light ID, click [Get a Light ID] (②) and import a Light ID distribution file. For details, see “Managing Light IDs” (page 95).
- Management IDs can only be selected during single playback.
- When selecting management IDs, it may take a while to display the management ID list depending on the performance of your computer.

![Image of Light ID management](image1)

8 **Click [Setting] (③).**

The setting will be completed, and the list created will be displayed in [Delivery content list].

- Click [Setting] for each list. If you change the [List name] without pressing [Setting], the content set in [Play List] will be discarded.
- When you click [Save] (④), the created content list can be saved on your computer or an external memory device of your choice, and not on the device. You can also use saved content lists in a USB memory by directly inserting the USB memory into the device.
Using Files Created with PowerPoint for Delivery
A file created in PowerPoint can be converted to still images or a movie and then delivered as content.

- When a file created in PowerPoint is converted to still images or a movie, conversion may take a while depending on the animation effects and number of slides.

Preparation:
- Make sure Microsoft PowerPoint is installed on your computer.
- Supported versions: Microsoft PowerPoint 2010/2013

1 Click [Content list editing].
   Display the screen with the methods below. (The same with Step 1 of page 151)
   - From the <Device Monitoring> window, select the icon for a device, group, or keyword then right-click it and select [Content list editing and delivery].
   - Display the schedule setting screen with Step 1 and 2 from page 120, and place a check on [Edit] or [Schedule Addition] → [Setting and Control] → [Delivering contents list].

2 Click [Use a PowerPoint].
Creating a List to Distribute Images ([Delivering contents list])

3 Click [Select], and select the PowerPoint file.
   The first image of the selected PowerPoint slide is displayed in ①.
   • If you select [New/Edit] (②) after selecting a file, the selected file will open in PowerPoint. If you select [New/Edit] (②) before selecting a file, you can create a new file.
   • If you select [New/Edit] (②) after selecting a file, the selected file will open in PowerPoint.

4 Click (③) [Convert(.JPG)] or [Convert(.WMV)].
   The selected file is converted to a still image (JPG) or movie (WMV), and a completion message is displayed.
   • When a file is converted to still images, settings such as animation effects are discarded.
   • Conversion to a still image can be done at the resolution selected in [Size]. When [Default (PPT)] is selected, the image will be converted according to the configuration of your PowerPoint presentation tool.
   • When a file is converted to a movie, conversion may take a while depending on the animation effects, number of slides, and other settings.

5 Click [Close] (④) and return to the screen of step 2.
   The power point file selected will be displayed in [Play List].

6 Set the playback order, playback time, and Management ID, then click [Setting].
   For more details, see steps 5 to 8 of "Creating and editing content lists". (page 153)
Creating a List to Distribute Images ([Delivering contents list])

Delivering a content list

**Execution by specifying a date and time in [Schedule]**

1. From the tree pane of the <Device Monitoring> window, select the icon for a device, group, or keyword, right-click it, and select [Schedule]. (page 120)
2. On the schedule setting screen, click [Schedule addition] or [Edit].
3. Specify the date and time, and select [Delivering contents list].
   - Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4. Select the list to be delivered from the [Delivery content list] (①).
   - When a group or keyword icon is selected in step 1, different lists can be selected for each device.
   - If nothing appears in the pull-down lists, it means content lists need to be created. (page 151)
Creating a List to Distribute Images ([Delivering contents list])

5 Select the [Playback mode setting] (2).

- [Single-Playback]: For playback on a single projector or a single flat panel display
- [Multi-Playback]: For starting playback simultaneously on multiple flat panel displays
  - If the delivery target device is a projector, you cannot select [Multi-Playback].

6 If you selected [Multi-Playback] in step 5, set the [Parent] and [Group No].

- The [Group No] setting is identical to the group ID used to classify networks when using USB media players in Multi Media Player mode.
- You must also specify one flat panel display within the group as the Parent. When USB media player playback on the flat panel display specified as the Parent (primary display) starts, USB media player playback on the other flat panel displays in the same group (sub displays) also starts.
- If another flat panel display on the same network and with the same group ID is already specified as the primary display, [Parent] cannot be specified.
- To view the content that will be delivered, click [Confirmation]. The input signal, display mode (aspect ratio), and other information will be displayed on the corresponding flat panel display.

7 Click [OK].

Clicking [OK] will complete the content list delivery setting.

- After the setting is complete, leave the software running. If the software is exited or the computer enters the sleep state, content list delivery will not be performed on the set date and time.

Notes

- It may take a while for delivery to complete after it is started depending on the sizes of the content files.
- The content list is not delivered to any device that is not connected to the network at the time of delivery.
- The functions set in “POWER MANAGEMENT SETTINGS” of the flat panel display are disabled during content list delivery.
- If a flat panel display that is a delivery target is playing existing content with the USB media player, playback stops simultaneously with the start of content list delivery and then resumes with the new content after delivery completes.
- If the delivery target projector is playing back an existing scenario in Memory Viewer, playback stops simultaneously with the start of content list delivery and then resumes with the new scenario after delivery completes.
- When content list delivery is executed, the settings specified in [Device list setting] are automatically saved. The automatically saved settings will appear in the <Content list delivery> window the next time you open it.
- If the power of the device unit is turned off or the connection with the unit is disconnected during delivery, the delivery will fail. Check the status of the connection with the unit and then execute delivery again.
Creating a List to Distribute Images ([Delivering contents list])

Configuration directly from the menu

1. From the tree pane of the <Device Monitoring> window, select the icon for a device, group, or keyword, right-click it, and select [Content list editing and delivery].

2. Select the list to be delivered from the [Delivery content list].
   - When a group or keyword icon is selected in step 1, different lists can be selected for each device.
   - If nothing appears in the pull-down lists, it means content lists need to be created. (page 151)

3. Select the [Playback mode setting] (①).
   - [Single-Playback]: For playback on a single projector or a single flat panel display
   - [Multi-Playback]: For starting playback simultaneously on multiple flat panel displays
     • If the delivery target device is a projector, you cannot select [Multi-Playback].
4 If you selected [Multi-Playback] in step 3, set the [Parent] and [Group No].

- The [Group No] setting is identical to the group ID used to classify networks when using USB media players in Multi Media Player mode.
- You must also specify one flat panel display within the group as the Parent.
- If another flat panel display on the same network and with the same group ID is already specified as the primary display, [Parent] cannot be specified.
- To view the content that will be delivered, click [Confirmation]. The input signal, display mode (aspect ratio), and other information will be displayed on the corresponding flat panel display.

5 Deliver or save the content list.

② [Delivery]: The files are saved to the USB memory inserted in the device of the delivery destination, and the content list delivery is executed.

③ [Save]: The content list is saved on the computer you are using. Specify a save destination. If a USB memory device used with a delivery destination device has been inserted into the computer, it can be directly saved on the USB memory device.

- The files to be saved as a content list are as follows.
  - **File list (filelist.dat):**
    The file name of the content to be played back is recorded in this file.
  - **Scenario file (scenario.dat):**
    The playback time of each content file, and the playback order of the content are recorded in this file.
  - **Light ID definition file (lightid.dat):**
    Light ID information assigned to the contents within the scenario is recorded in this encrypted file. Light ID definition files will be saved even for devices not equipped with the Light ID function.
  - **Playback file:**
    This is the still image or movie file used for playback.

- To temporarily save the content lists during the editing process, click [Apply] (④). The mid-edit content lists will appear in the <Content list delivery> window the next time you open it.
- To discard content lists mid-creation or mid-edit, click [Cancel] (⑤). You will return to the <Create Schedule>, <Edit Schedule>, or <Device Monitoring> window.
Creating a List to Distribute Images ([Delivering contents list])

Notes

- It may take a while for delivery to complete depending on the sizes of the content files.
- The functions set in “POWER MANAGEMENT SETTINGS” of the flat panel display are disabled during content list delivery.
- If a flat panel display that is a delivery target is playing existing content with the USB media player, playback stops simultaneously with the start of content list delivery and then resumes with the new content after delivery completes.
- If the delivery target projector is playing back an existing scenario in Memory Viewer, playback stops simultaneously with the start of content list delivery and then resumes with the new scenario after delivery completes.
- When content list delivery is executed, the settings specified in [Device list setting] are automatically saved. The automatically saved settings will appear in the <Content list delivery> window the next time you open it.
- If the power of the device unit is turned off or the connection with the unit is disconnected during delivery, the delivery will fail. Check the status of the connection with the unit and then execute delivery again.
- Even if content to which Light ID management IDs are assigned is transmitted to a device not equipped with the Light ID function, playback of that content will not be affected.
- Light ID definition files cannot be created on their own. They are generated when Light ID management IDs are assigned to contents according to the step 7 of "Creating and editing content lists" (page 154).
Delivering Images with Light ID Added ([Light ID Control])

The Light ID control function controls whether to add Light IDs to the images displayed on devices equipped with the Light ID function.

- To see if a device being used supports Light ID Control, see the “List of Compatible Device Models” on the following websites.
  https://panasonic.net/cns/projector/download/
  https://panasonic.net/cns/prodisplays/download/software/
- For details on purchasing a Light ID distribution file, refer to the following website.
  https://panasonic.net/cns/LinkRay/

1. From the tree pane of the <Device Monitoring> window, select the icon for a device, group, or keyword, right-click it, and select [Schedule]. (page 120)
   - When a group or keyword icon is selected, you can configure the same schedule for multiple devices simultaneously.

2. On the schedule setting screen, click [Schedule addition] or [Edit].

3. Specify the date and time, and select [Light ID Control].
   - Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4. Turn [Light ID Setting] to [ON], and select the Light ID you want to add from [Managed ID].
   - To not add the Light ID, set [Light ID Setting] to [OFF].
   - To add a new Light ID, click [Get a Light ID] (①) and import a Light ID distribution file. The imported Light ID will also appear in the <Light ID Information> window. (page 95)

5. Click [OK] to complete the setting.
   - After the setting is complete, leave the software running. Light ID control will not be executed at the scheduled time if the software is closed or the computer enters sleep mode.
### Calling the Web Control Window

The software can be used to call up the device web control function.

**Preparation:**
- Uncheck “Use automatic configuration script” in your web browser.
- Uncheck “Use a proxy server for your LAN” in your web browser, or specify the device IP address in “Exceptions” in the advanced proxy settings.

1. In the Brief information display area in the <Device Monitoring> window, select the device you want to display, right-click it, and select [WEB Control].
   - You can also display it by double-clicking the selected row.
   - To display from the web browser of the early warning function, select the device you want to display and click [WEB Control]. (page 174)
Notes

- For details about the web control function, please refer to the operating manual for the device being used.
- The <Web Control> window will vary according to the device being used.
- When the web control function is opened, the administrator password change screen may appear. If the administrator password is changed, acquisition of detailed information will not be possible until the device is re-registered. Re-register the device as described in “Registering Devices and Peripheral Devices to Monitor and Control” (page 41).
- If the connection setting on the device side is HTTPS communication, you cannot call up the WEB control function from this software. In that case, enter the device’s IP address into the URL input field of the WEB browser, and call up the WEB control function.
Controlling Devices

Using the ECO Management Function

Bring up the <Web Control> window while the [ECO management set up] screen is displayed. You can configure the power consumption reduction settings for the projector in [ECO management set up].

- To display the <Web Control> window from [WEB Control] on the menu, select [Detailed set up] from the menu on the left, and click [ECO management set up]. (page 163)

Preparation:
- Uncheck "Use automatic configuration script" in your web browser.
- Uncheck "Use a proxy server for your LAN" in your web browser, or specify the device IP address in "Exceptions" in the advanced proxy settings.

1 In the Brief information display area in the <Device Monitoring> window, select the device you want to display, right-click it, and select [ECO setup].

2 Change the settings and click [Submit].

The settings will be applied to the projector. After some time, the [ECO setup level] icon in the row selected in step 1 will be updated. The time it takes to update differs depending on the [Interval time] set at [Interval Time of Device Information]. (page 220)

- What appears in the setting window will be different depending on the projector you are using.

Notes
- For details of the ECO Management function, refer to the operation manual of the device you are using.
Calling the Content Manager

The Content Manager of the projector can be called up from this software.

**Preparation:**
- Uncheck “Use automatic configuration script” in your web browser.
- Uncheck “Use a proxy server for your LAN” in your web browser, or specify the device IP address in “Exceptions” in the advanced proxy settings.

1. **In the Brief information display area in the <Device Monitoring> window, select the device you want to display, right-click it, and select [Content Manager].**
   - The Content Manager can be called only on devices that display the signage playback status in [Signage information].

**Notes**
- For details about [Content Manager] after login, refer to the operating manual of the projector you are using.
This function allows you to acquire the signage schedule configured for a projector and then deliver the signage schedule to multiple other projectors. This eliminates the need to create the same signage schedule for each projector.

- The signage schedule acquisition and delivery functions are supported only on projectors equipped with Content Manager. To see if the projector being used supports these functions, see the “List of Compatible Device Models” on the following website.

https://panasonic.net/cns/projector/download/

**Acquiring a Signage Schedule**

1. In the Brief information display area in the <Device Monitoring> window, select a projector, right-click it, and select [Acquiring signage schedule].

2. Click [List view].
   - The signage schedule set to the selected projector will be displayed.
   - The list of acquired signage schedules is displayed in tabs labeled [By day] and [By weekday].
3 Place a check mark in [Select] for the signage schedule you want to acquire and click [Acquisition].

- Because the contents (video or audio) registered in the schedule are also acquired, acquisition may take some time to complete, depending on signage schedule.
- When acquiring a signage schedule any previously acquired signage schedule is deleted.
- If the names of files included in a signage schedule include invalid URL characters (#, %, [ ], { }, '), acquisition of the signage schedule will not be possible.

The signage schedule list is displayed when acquisition is successful. The following message is displayed if acquisition fails. In this case, check whether there is a registered signage schedule for the target projector, then try to acquire the schedule again.
Delivering a Signage Schedule

1. In the Brief information display area in the <Device Monitoring> window, select a projector, right-click it, and select [Delivering signage schedule].

2. Place a check mark in [Select] for the signage schedule you want to deliver.
   - The list of acquired signage schedules is displayed in tabs labeled [By day] and [By weekday].
3 Click [Delivery].

A confirmation message appears. Click [OK] to distribute the selected signage schedule.
- If a file with the same name as the contents, registered in the schedule, for delivery already exists on the delivery destination, the destination file will be overwritten, even if the contents have a different name. In this case, the contents registered in the signage schedule on the destination will be replaced by the contents registered in the delivered schedule.
- Because the contents (video or audio) registered in the schedule are also acquired, acquisition may take some time to complete, depending on the schedule.
- When the power supply to the projector is turned off such as disconnecting the AC plug during delivery, or when the network connection is cut off, no delivery will be possible. Check the status of the connection with the unit and then execute delivery again.
- If no signage schedule has been acquired, an error message is displayed. Acquire the signage schedule first and then carry out [Delivery]. (page 167)

4 Click [Close] to close the window.

Deleting a Signage Schedule

1 In step 2 of “Delivering a Signage Schedule” (page 169), place a check mark in [Select] for the signage schedule you want to delete and click [Delete].

A confirmation message appears. Click [OK] to delete the selected signage schedule.
- The contents (video or audio) registered in a signage schedule are retained on the computer after the acquired signage schedule is deleted. The contents (video or audio) are deleted from the computer only after all acquired signage schedules have been deleted.
Using the Early Warning Function (paid)

Confirming the Status of Devices and Peripheral Devices

If you add the early warning function, you can check the status of the devices and their peripheral devices registered on the monitoring and control terminal from the Multi Monitoring & Control area or from a web browser.

1. **Window switching button:**
   - [Detailed/Overview]: Every time you press it, the Details (page 174) and Overview (page 182) window will switch.
   - [History (All Device)] (page 187)
   - [Control] (page 190)

2. **Tree view area:**
   The registered equipment in each group is listed in tree format. When an error, warning or notification occurs in a device, an icon appears next to the corresponding device. (page 172)

3. **Data display area:**
   Displays information about the devices selected in the tree view area. (page 174)

**Notes**

- The items and information displayed will vary depending on the registered device or peripheral device.
Confirming the Status of Devices and Peripheral Devices

Tree View Area

1 Unread information
When there are unread status notification (2). ① will turn red and the number of unread messages will be displayed.
• When you click this, the data display area on the right becomes the History (All Device) screen (page 187), which shows unread errors against a red background and warnings and notifications against a yellow and blue background, respectively.

2 Status notification tab
The [Errors], [Warnings], and [Notices] tabs indicate the number of devices that have generated errors, warnings, and notifications, respectively. Selecting a tab indicating that events have occurred will show a list of the devices in the tree view area where the events have occurred.

[Errors]:
The software detects and indicates filter clogging errors, intake/exhaust/optical module and other temperature errors, lamp or light device runtime errors, lamp or light source on errors, fan errors and other errors. In addition, errors based on status notifications received from devices can be displayed.
• For more information about setting the status notification function, see page 224.

[Warnings]:
The software detects and indicates filter clogging warnings, intake/exhaust/optical module and other temperature warnings, lamp or light device runtime warnings, LAN disconnected warnings and other warnings.

[Notices]:
The software can detect and display notifications such as the cleaning time and replacement time of each part, and when video stop occurs.
• For more information about configuring notifications, see page 236.
• See page 193 and 242 for video stop determination settings.
### Confirming the Status of Devices and Peripheral Devices

<table>
<thead>
<tr>
<th>3 Tree pane</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon] <strong>[Group]</strong>: This is the folder that the tree is composed from. It cannot be changed or deleted.</td>
</tr>
<tr>
<td>![Folder Icon] <strong>Group folder created on the monitoring and control terminal side</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>Group folder created on the monitoring and control terminal side with a network camera as the parent.</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>A group folder created on the monitoring and control terminal side with a network camera as the parent.</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>Projector (Rich information model)</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>Flat panel display (Rich information model)</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>Basic information model device</strong></td>
</tr>
<tr>
<td>![Folder Icon] **When you set video stop determination with a device linked to a network camera, <strong>will be displayed on the right side of the device name.</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>In the following cases, the device's icon changes.</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>A device cannot be found</strong></td>
</tr>
<tr>
<td>![Folder Icon] <strong>A device that differs from the registered device type has been detected</strong></td>
</tr>
</tbody>
</table>

### Notes

- When the name of a device or group is too long to fit in the display area, "..." follows the name.
- Depending on the network connection status, it may take some time to display the unread information count.
- The detection items that generate notifications vary with the device.
- For details about “Rich information model” and “Basic information model”, see page 27.
174

Confirming Device and Peripheral Device Status
(Detail Screen)

Data Display Area

1 Select a device at the tree view area, then click the [Status] tab.
The status (condition) of the selected device appears in the data display area.

- **1** Select a device at the tree view area, then click the [Status] tab.
- **2** The status (condition) of the selected device appears in the data display area.
- **3** Power on hours
- **4** Peripheral Device
- **5** Remote Preview
- **6** Intake temperature
- **7** Exhaust temperature
- **8** DMD-R temperature
- **9** Remaining Filter Life
- **10** Exhaust-1 FAN
- **11** Exhaust-2 FAN
- **12** Exhaust-3 FAN
- **13** DIGITAL LINK
- **14** Camera
### Confirming Device and Peripheral Device Status (Detail Screen)

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device name</strong></td>
<td>Displays the device name.</td>
</tr>
<tr>
<td><strong>[Group Name]</strong></td>
<td>Displays the device’s group name. (If the group folder is [folder], the set network camera name at the time of network camera registration or CAM-XXX (XXX: network camera’s IP address) will be displayed as the group name.)</td>
</tr>
<tr>
<td><strong>[Model Name]</strong></td>
<td>Displays the device model name.</td>
</tr>
</tbody>
</table>
| **[Power]** | Displays the power status of a device.  
**[STANDBY]**: Standby status  
**[COOLING]**: Power supply is being cooled  
**[ON]**: Power supply is on |
| **[Selected LIGHT]** | (Projector only)  
Displays lamp selection status. The displayed content varies with the registered device.  
**[SINGLE]**, **[DUAL]**, **[TRIPLE]**, **[QUAD]**, **[LIGHT1/2/3]**, **[LIGHT1/2/4]**, **[LIGHT1/3/4]**, **[LIGHT2/3/4]**, **[LIGHT1/4]**, **[LIGHT2/3]**, **[LIGHT1]**, **[LIGHT2]**, **[LIGHT3]**, **[LIGHT4]** |
| **[Main Version]** | Displays the version of the device’s main microcomputer. |
| **[IP Address]** | Displays the device’s IP address. |
| **[Serial Number]** | Displays the serial number of a device. |
| **[Power on count]** | Indicates the number of times a device has been powered on. |
| **[LIGHT Power]** | (Projector only. The displayed content varies with the registered device.)  
Displays the setting status of the light power (lamp power, lamp output, light output) of a device. |
| **[Operating Mode]** | (Projector only. The displayed content varies with the registered device.)  
Displays configuration status of the device’s Operation Mode.  
If the brightness control function is enabled on the device, the configuration status of the device is not displayed. |
| **[Power consumption reduction setting]** | (Flat-panel display only)  
Displays the power consumption reduction setting of the device.  
**[Off]** / **[On]** / **[Sensor]** |
| **[Long Life Mode]** | (Flat-panel display only)  
Displays the Long Life Mode setting status of the device.  
**[Off]** / **[On 1]** / **[On 2]** |
| **[Network Version]** | Displays the version of the device’s network microcomputer. |
| **[Shutter (AV Mute)]** | Displays device shutter status or AV mute status.  
**[OPEN(OFF)]**: When shutter is open or AV is unmuted (video and audio)  
**[CLOSE(ON)]**: When shutter is closed or AV is muted (video and audio) |
| **[Selected input]** | Displays the status of a selected input. |
| **[Source Name]** | Displays the source name of device. |
| **[Signal Freq.]** | Displays the signal frequency of a device.  
For flat-panel displays*, the indication is displayed in red to indicate a warning/error if a no-signal condition is continuous. |

---

*In the following situations, warning and error detection for no-signal conditions are not possible for flat-panel displays that support USB input:*

- When USB input is selected and a USB storage device is not inserted in the USB port
- When USB input is selected and an unplayable file exists on the USB storage device
Using the Early Warning Function (paid)

Confirming Device and Peripheral Device Status (Detail Screen)

**① [AC Voltage]**
(Projection only)
Displays the voltage of the AC power supply being input to the device.

**③ [Power on hours]**
Displays a graph that shows the power on hours for a device for a 30-day period in 1-day increments.
It does not display data for the day when a device is registered or days when it is not in use.
For a “Basic information model” device, the light device runtime will be used to determine the device usage time.
Depending on the “Basic information model” device, as the light device runtime will be a converted value, it may be shorter than the actual device usage time. In addition, graph display is not possible for “Basic information model” devices for which the light device runtime cannot be obtained.

**④ [WEB Control]**
Displays the log in screen for connecting devices. Entering the user name and password of a device will open its <Web Control> window.
The log in screen and the <Web Control> window will not appear for “Basic information model” devices and devices that do not support web control.

**⑤ [Refresh]**
The data display area will be updated to the latest state. (It may take time to update depending on the network connection.)

**⑥ Temperature**
Displays thermometers and temperature values in Celsius (°C) and Fahrenheit (°F) for points within the device.

- **[All]**: Displays the status of the temperature sensor as a list.

   ![Temperature Sensor List](image)

   **Green**: Normal  
   **Orange**: Warning  
   **Red**: Error

Note that the displayed temperature parameters vary with the device.

- For projectors, the intake air temperature, optics module temperature, and temperature near the lamps or light sources are displayed.
The numerical temperature values will change from white to orange when the warning temperature is reached. In this case, take corrective action immediately. If no action is taken and the temperature continues to rise, the color will change to red and the device will shut down.
- For flat-panel displays, the internal temperature, panel temperature, intake air temperature, and exhaust air temperature are displayed.
If the temperature reaches the warning level, the temperature value readout changes from white to orange, and if the temperature continues to increase, it changes to red and an error message is displayed prompting you to take immediate action. If no action is taken and the temperature continues to rise, the device will shut down.

**⑦ LIGHT status**
(Projection only)
Indicators show lamp status and power on hours.
The indicator turns orange if the lamp usage time reaches the replacement warning time, and turns red when it reaches the time for replacement.
For projectors that allow setting of the lamp power or lamp output to “ECO” or “low”, the displayed lamp usage time is calculated as if the lamp was used with the lamp power or lamp output set to “normal” or “high”.

---

176
### Using the Early Warning Function (paid)

#### Confirming Device and Peripheral Device Status (Detail Screen)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remaining ACF service life</strong></td>
<td>(Only projectors equipped with the auto cleaning filter function) This indicator shows remaining life of the ACF in percentage. When the remaining life of the filter is less than 200 hours, the indicator lights orange.</td>
</tr>
<tr>
<td><strong>Fan status</strong></td>
<td>Displays the name of the fan equipped on the device and a meter indicating its status.</td>
</tr>
<tr>
<td><strong>Flat panel display</strong></td>
<td></td>
</tr>
<tr>
<td><strong><a href="#">Projector</a></strong></td>
<td><strong>Actual fan speed</strong></td>
</tr>
<tr>
<td><strong><a href="#">Flat panel display</a></strong></td>
<td><strong>Target fan speed</strong></td>
</tr>
<tr>
<td><strong>[All]</strong></td>
<td>Displays the status of the fans equipped on the devices as a list.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Fan status screenshot" /></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Note that the displayed meters vary with the device.</td>
</tr>
<tr>
<td></td>
<td>• For projectors, if the fan speed drops and normal speed cannot be maintained, the meter needle changes from white to red, and the status changes from [Good] to [Service].</td>
</tr>
<tr>
<td></td>
<td>• For flat-panel displays, if the temperature rises and the fan speed is abnormal, the meter needle changes to orange, and the status changes from [Good] to [Notice]. If the fan stops due to a failure, the meter needle changes from white to red, and the status changes to [Service].</td>
</tr>
<tr>
<td><strong>Peripheral Device</strong></td>
<td>The current delivering image of the network camera is displayed which is registered to the device displayed in the status screen. The video of the network camera is updated at about 4-second intervals.</td>
</tr>
<tr>
<td><strong>Camera WEB</strong></td>
<td>A button is displayed when the [Peripheral Device] tab is double-clicked. This is enabled when a network camera is registered to the device displayed in the status screen. It displays the Web screen of the network camera.</td>
</tr>
<tr>
<td><strong>DIGITAL LINK</strong></td>
<td>A button is displayed when the [Peripheral Device] tab is double-clicked. This is enabled when a DIGITAL LINK Switcher is registered via linking to the device displayed in the status screen. It displays the input/output condition and the built-in fan condition of the DIGITAL LINK Switcher. For details of [DIGITAL LINK] settings, see page 179.</td>
</tr>
<tr>
<td><strong>Remote Preview</strong></td>
<td>Footage input into a device displayed in the status screen can be resized as snapshot images. The snapshot image will be updated in approximately 5 second intervals.</td>
</tr>
</tbody>
</table>

* Flat-panel display only

---

**177**
Notes

• The items and content displayed in the status screen will vary depending on the device.
• The video from the network camera can be displayed when the network camera is connected to the same network as the monitoring and control terminal.
• The network settings and authentication settings of network cameras differ depending on the camera. Refer to the instruction manual of the corresponding network camera and then configure the settings.
• The video of the network camera is intended to be used for the purpose of monitoring a specific display video, and is not for preventing crime or other purposes.
• It is the customer’s responsibility to give sufficient consideration to not violating the privacy of any person, group, or other entity that becomes a subject in the video of the network camera.
• The video of a network camera may not appear clear depending on the type of projector.
• See the following websites for network cameras recommended for this software.  https://panasonic.net/cns/projector/download/application/multiprojector/ https://panasonic.net/cns/prodisplays/download/software/multi/
• The <Web Control> window of the device may become unable to be displayed properly in iOS (Safari) depending on the network camera.
Confirming Device and Peripheral Device Status (Detail Screen)

**DIGITAL LINK Switcher input/output condition**

Clicking [Peripheral Device] in the data display area and then clicking [DIGITAL LINK] will display the input/output condition and the built-in fan condition of the DIGITAL LINK Switcher. This is enabled when a DIGITAL LINK Switcher is registered with the device displaying the status.

### Input signal conditions

<table>
<thead>
<tr>
<th>Input terminal name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the name of an input terminal of the DIGITAL LINK Switcher.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input video signal name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the input video signal name.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No video input signal*1</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the condition of the video input not selected and no video signal being input.</td>
<td></td>
</tr>
<tr>
<td>• If video input is selected, but no video signal is input, the status will be as follows.*2</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video input signal*1</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the condition of the video input not selected but a video signal being input.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video input signal*2</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the condition of the video input selected and a video signal being input. The signal name is also displayed.</td>
<td></td>
</tr>
</tbody>
</table>

*1 Status when not selected as input  
*2 Status when selected as input
Using the Early Warning Function (paid)

Confirming Device and Peripheral Device Status (Detail Screen)

Output signal conditions

6 Output terminal name | Displays the name of an output terminal of the DIGITAL LINK Switcher.

7 Output video signal name | Displays the output video signal name.

Other

8 Device name and fan status of the DIGITAL LINK Switcher

- Device name is displayed.
- When the fan built into the DIGITAL LINK Switcher is rotating unstably or is stopped, the color of the box of the DIGITAL LINK Switcher changes and a message is displayed to notify you of the status. When there is no problem with the fan, the box is displayed in gray as shown in (8).

9 Message display area

This area is for displaying messages about the condition of the fan of the DIGITAL LINK Switcher and when there are other notices.

10 Close button

Closes this status screen and returns to the status screen of the device.
Using the Early Warning Function (paid)

Confirming Device and Peripheral Device Status (Detail Screen)

Notes
• The following messages may be displayed in the message area depending on the settings of the DIGITAL LINK Switcher.

<table>
<thead>
<tr>
<th>DIGITAL LINK Switcher Settings</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLOSED CAPTION setting is “ON”</td>
<td>CLOSED CAPTION is “ON”. VIDEO input status may not be displayed correctly.</td>
</tr>
<tr>
<td>[INPUT SETTING] of COMPUTER1 terminal is “Y/C”</td>
<td>COMPUTER1 INPUT SETTING is “Y/C”. VIDEO input status or COMPUTER1 input status may not be displayed correctly.</td>
</tr>
<tr>
<td>CLOSED CAPTION setting is “ON” and [INPUT SETTING] of COMPUTER1 terminal is “Y/C”</td>
<td>Closed caption is “ON” and COMPUTER1 INPUT SETTING is “Y/C”. VIDEO input status or COMPUTER1 input status may not be displayed correctly.</td>
</tr>
</tbody>
</table>

• If you want to obtain the input/output condition of the DIGITAL LINK Switcher again, click the close button (■) and then display this status screen again.
Displaying a List of Registered Devices (Overview screen)

1. Click [Detailed/Overview] to switch to the Overview screen.
   A list of registered devices appears.
   • Click [Detailed/Overview] again to return to the [Detail Screen].

   ![Overview Screen]

<table>
<thead>
<tr>
<th><strong>[Refresh]</strong></th>
<th>The data display area will be updated to the latest state.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[Group Name]</strong></td>
<td>Displays the group name of a device. (If the group folder of the tree pane is , the camera name set at the time of network camera registration or CAM-XXX (XXX: network camera’s IP address))</td>
</tr>
<tr>
<td><strong>[Device Name]</strong></td>
<td>Displays the device name.</td>
</tr>
<tr>
<td><strong>[IP Address]</strong></td>
<td>Displays the device’s IP address.</td>
</tr>
<tr>
<td><strong>[Model Name]</strong></td>
<td>Displays the device model name.</td>
</tr>
<tr>
<td><strong>[Serial Number]</strong></td>
<td>Displays the serial number of a device.</td>
</tr>
<tr>
<td><strong>[Status]</strong></td>
<td>Displays icons depending on status information (errors, warnings or notifications) sent by a device.</td>
</tr>
</tbody>
</table>
| **[Power]** | Displays the power status of a device.
   - ![Standby status](image)
   - ![Power supply is on](image)
   - ![Power supply is being cooled](image)
   - ![No information has been acquired from the device](image) |
| **[Main Version]** | Displays the version of the device’s main microcomputer. |
| **[Memo 1]** | Displays the [Memo 1] registered at register device. (page 42) |
| **[Memo 2]** | Displays the [Memo 2] registered at register device. (page 42) |
Using the Early Warning Function (paid)

Displaying a List of Registered Devices (Overview screen)

**Saving Device Management Information**

Saves management information for all registered devices.

1. Click [Detailed/Overview] to switch to the Overview screen.
2. Click [Save List].
   
   Device management information will be saved as a compressed CSV file.

![Early Warning Interface](image)

**Example showing saved data**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Application Name</td>
<td>Early Warning</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Stored</td>
<td>9/16/2018 12:00 PM</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>Group</td>
<td>Device Name</td>
<td>IP Address</td>
<td>Model Name</td>
<td>Serial Number</td>
<td>Runtime</td>
<td>Main Version</td>
<td>Memo1</td>
<td>Memo2</td>
</tr>
<tr>
<td>18</td>
<td>1</td>
<td>Tower0-1F</td>
<td>D221K</td>
<td>192.168.1.101</td>
<td>D221000-T007</td>
<td>1200</td>
<td>1.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>Tower0-1F</td>
<td>D221K</td>
<td>192.168.1.102</td>
<td>D221000-T012</td>
<td>115</td>
<td>1.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>3</td>
<td>Tower0-2F</td>
<td>D0200</td>
<td>192.168.1.103</td>
<td>DW03-D01</td>
<td>210</td>
<td>1.03</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>4</td>
<td>Tower0-3F</td>
<td>DAW300</td>
<td>192.168.1.104</td>
<td>DAW3-D01</td>
<td>50</td>
<td>1.02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>5</td>
<td>Tower0-4F</td>
<td>D2770</td>
<td>192.168.1.105</td>
<td>D2770-D01</td>
<td>401</td>
<td>1.02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>6</td>
<td>Tower0-5F</td>
<td>D2770</td>
<td>192.168.1.106</td>
<td>D2770-D02</td>
<td>124</td>
<td>1.02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>7</td>
<td>Tower0-6F</td>
<td>FW380</td>
<td>192.168.1.107</td>
<td>FW38-D01</td>
<td>1547</td>
<td>1.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>8</td>
<td>Tower0-7F</td>
<td>PX400</td>
<td>192.168.1.108</td>
<td>PX400-D01</td>
<td>552</td>
<td>1.04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>9</td>
<td>Tower0-8F</td>
<td>PX400</td>
<td>192.168.1.109</td>
<td>PX400-D02</td>
<td>594</td>
<td>1.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>10</td>
<td>Tower0-9F</td>
<td>PX400</td>
<td>192.168.1.110</td>
<td>PX400-D02</td>
<td>122</td>
<td>1.04</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes**

- [Save List] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Save List] button cannot be clicked when viewed with an OS other than Windows OS such as an iOS or Android.
Displaying or Saving a Maintenance Report

Use this procedure to display or save maintenance information for registered devices by specifying the items to display, interval, and cycle count.

**Preparation:**
- To display or save maintenance reports for a Basic information model device, you must configure the maintenance parts settings for the device beforehand. (page 209)

1. Click [Detailed/Overview] to switch to the Overview screen.
2. Click [Maintenance Report].
3. Place a check on the items of ① that you want to output, and set the interval or frequency.
   - If you click [Cancel] (②), it will return to the Overview screen of the device.
## Displaying a List of Registered Devices (Overview screen)

<table>
<thead>
<tr>
<th>List of Devices</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>which require Consumable Parts Replacement soon</td>
<td>Displays the time to replace the consumable parts of registered devices.</td>
<td>Sets the number of days beforehand to display a device's replacement or cleaning time. [in 10 days] / [in 20 days] / [in 30 days] / [in 60 days] / [in 90 days]</td>
</tr>
<tr>
<td>which require Regular Periodic Cleaning soon</td>
<td>Displays the time to perform regular periodic cleaning of registered devices.</td>
<td></td>
</tr>
<tr>
<td>which require Non-Consumable Parts Replacement soon</td>
<td>Displays the time to replace the non-consumable parts of registered devices.</td>
<td></td>
</tr>
<tr>
<td>which are Frequently having Errors</td>
<td>Extract and display the devices in which an error occurred more than the specified number of times.</td>
<td>Sets the number of times an error or warning occurs on a device before displaying the device. [Over 10 times] / [Over 30 times] / [Over 50 times] / [Over 90 times]</td>
</tr>
<tr>
<td>which are Frequently having Warnings</td>
<td>Extract and display the devices in which warnings occurred more than the specified number of times.</td>
<td></td>
</tr>
</tbody>
</table>

A maintenance report based on the configured settings will be displayed.

5. Click [Save Report].  
The maintenance report is saved as a compressed CSV file.  
• Click [Cancel] if you decide not to extract the report.

![Early Warning Screen](image-url)
Using the Early Warning Function (paid)

Displaying a List of Registered Devices (Overview screen)

- Example showing saved data

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Early Warning</th>
<th>Version, Ver.<em>.</em>.*</th>
<th>Stored, &quot;<strong>/</strong>/**** 8:12:55 PM</th>
</tr>
</thead>
</table>

- List of Devices which require Consumable Parts Replacement soon

  | Group Name, Model Name, Device Name, IP Address, Serial Number, Set Runtime, Main Ver., Memo1, Memo2... |
  | in 10 days, Group, DZ13K, DZ13K-001, ***.***.***.***, 012345ABC, 2240, 1.02, 2100, 200 |

- List of Devices which require Regular Periodic Cleaning soon

  | Group Name, Model Name, Device Name, IP Address, Serial Number, Set Runtime, Main Ver., Memo1, Memo2... |
  | in 10 days, Group, DZ13K, DZ13K-001, ***.***.***.***, 012345ABC, 2240 |

- List of Devices which require Non-Consumable Parts Replacement soon

  | Group Name, Model Name, Device Name, IP Address, Serial Number, Set Runtime, Main Ver., Memo1, Memo2... |
  | in 30 days, Group, DZ13K, DZ13K-001, ***.***.***.***, 012345ABC, 2240, 1.02 |

- List of Devices which Frequently having Errors

  | Group Name, Model Name, Device Name, IP Address, Serial Number, Set Runtime, Main Ver., Memo1, Memo2... |
  | 123times, Group, DZ13K, DZ13K-001, ***.***.***.***, 012345ABC, 2240, 1.02 |

- List of Devices which Frequently having Warnings

  | Group Name, Model Name, Device Name, IP Address, Serial Number, Set Runtime, Main Ver., Memo1, Memo2... |
  | 52times, Group, DZ13K, DZ13K-001, ***.***.***.***, 012345ABC, 2240, 1.02 |

Notes

- [Save Report] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Save Report] button cannot be clicked when viewed with an OS other than Windows OS such as an iOS or Android.
The status information (errors, warnings and notifications) and history for all devices registered in the monitoring and control terminal are displayed.

- History information is saved as a compressed CSV file. (page 183)

1. **Click [History (All Device)].**
   - Clicking a notification line will open the status screen for the device that was clicked.

①: If a notification is unread, a check mark is added to its check box, and each type of notification is displayed in a different color. When you remove the check mark to indicate that it was read, the color coding is canceled.

- ■ (Red): Error
- ■ (Yellow): Warning
- ■ (Blue): Notification

② **Items:** The following information is displayed for the device where the error, warning or notification occurred.

<table>
<thead>
<tr>
<th><strong>Item</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>[Date]</td>
<td>Displays the date of occurrence.</td>
</tr>
<tr>
<td>[Group Name]</td>
<td>Displays the group name of the device. (If the group folder of the tree pane is</td>
</tr>
<tr>
<td></td>
<td>[ ] , the camera name set at the time of network camera registration or CAM-XXX</td>
</tr>
<tr>
<td></td>
<td>(XXX: network camera’s IP address))</td>
</tr>
<tr>
<td>[Device Name]</td>
<td>Displays the device name.</td>
</tr>
<tr>
<td>[IP Address]</td>
<td>Displays the device’s IP address.</td>
</tr>
<tr>
<td>[Model Name]</td>
<td>Displays the device model name.</td>
</tr>
<tr>
<td>[Serial Number]</td>
<td>Displays the serial number of a device.</td>
</tr>
<tr>
<td>[Status]</td>
<td>Displays the type of notification as an icon.</td>
</tr>
<tr>
<td></td>
<td>✗ : Error</td>
</tr>
<tr>
<td></td>
<td>▼ : Warning</td>
</tr>
<tr>
<td></td>
<td>◼ : Notification</td>
</tr>
<tr>
<td>[Notice]</td>
<td>Displays the contents of the notification.</td>
</tr>
</tbody>
</table>
Confirming Device History Information ([History (All Device)])

3 [Result]:
If it is detected that video has stopped, a video stop detection notification is displayed in the [Notice] column and a [Result] button to the right of it. Click the button to check the video stop status.
• The image displayed is a composite of the image at the time of video stop detection and the previously set output image determination area (page 193).

Notes
• History can display up to 2,000 instances from the most recent data.
• You can select from 500, 1,000, or 2,000 for the number of system history entries that can be saved. (page 221)
• Clicking the history information of a device whose registration has been deleted will not open the status screen of that device.
• Serial numbers are not included in the history data for devices registered as Basic information model devices.
Using the Early Warning Function (paid)

Confirming Device History Information ([History (All Device)])

### Saving History Information

1. Click [History (All Device)] to display the history screen.
2. Click [Save History].

The history information is saved as a compressed CSV file.

### Example showing saved data

<table>
<thead>
<tr>
<th>Application Name, Early Warning Software</th>
<th>Version, Ver.<em>.</em>.*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored, <em>6:48:42 PM</em></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date, Group Name, Device Name, IP Address, Model Name, Serial Number, Status, Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>/**/</em>*** 6:17:01 PM, Group, &quot;DZ57-0002&quot;, 192.168.0.4, DZ57, 0123456890, Warning, &quot;Projector LAN Connection Error&quot;,</td>
</tr>
<tr>
<td><em>/**/</em>*** 6:17:01 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Warning, &quot;Projector LAN Connection Error&quot;,</td>
</tr>
<tr>
<td><em>/**/</em>*** 4:34:16 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Error, &quot;Internal Error&quot;, &quot;FPGA1/2 Configuration Error&quot;</td>
</tr>
<tr>
<td><em>/**/</em>*** 4:34:16 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Error, &quot;FAN Error&quot;, &quot;Color Prism3 FAN Error&quot;</td>
</tr>
<tr>
<td><em>/**/</em>*** 4:34:16 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Error, &quot;FAN Error&quot;, &quot;Color Prism2 FAN Error&quot;</td>
</tr>
<tr>
<td><em>/**/</em>*** 4:34:16 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Error, &quot;FAN Error&quot;, &quot;Color Prism1 FAN Error&quot;</td>
</tr>
<tr>
<td><em>/**/</em>*** 3:38:54 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Warning, &quot;Intake Air High Temperature Warning&quot;,</td>
</tr>
<tr>
<td><em>/**/</em>*** 3:34:42 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Error, &quot;FAN Error&quot;, &quot;Exhaust1 FAN Error&quot;</td>
</tr>
<tr>
<td><em>/**/</em>*** 3:33:32 PM, Group, &quot;DZ21K-0001&quot;, 192.168.0.3, DZ21K, AB12345678, Error, &quot;FAN Error&quot;, &quot;Exhaust1 FAN Error&quot;</td>
</tr>
</tbody>
</table>

### Notes

- [Save History] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Save History] button cannot be clicked when viewed with an OS other than Windows OS such as an iOS or Android.
Controlling Devices ([Control])

You can perform off/on controls for the power, shutter function, and AV muting function on registered devices individually or by groups.

- Functions other than these should be controlled from the software side on the monitoring and control terminal. (page 110)

1 Click [Control] to display the device control screen.

2 From the tree view area, select the devices or groups you want to control.

   The names of the selected devices will appear under [Device Name] (①) in [Command Transmission History].

3 Select the operation you want to perform from ②.

   The selected control command is sent to each device.

   ③ [Command]: The control command that was sent

   [Result]: Displays the result of sending the command. One of the following results will be shown.

   | [Success] | Transmission of the control command was successful. |
   | [Failed] | Transmission of the control command failed. Check the status of the device. |
   | [Failed. Busy with another control task.] | Data update or other processes were in progress on the device. Wait a moment before performing the operation again. |
   | [Failed. Different device has been detected.] | A device that differs from registered device is connected. Check the device. |

Notes

- Even if a control command is successfully sent to a device, the device’s status screen will not be updated until a data update is performed. If you want to check the status of the device immediately, click [Refresh] in the device’s status screen. The devices’ information will be updated to the most recent state.
- When a power-on operation is performed for a projector, it may take some time for it to be reflected on the status screen as it takes some time for the lamps to turn on.
Displaying Error/Warning and Notice Details

Use the steps below to display detailed information on the events a device reports (error, warning or notification details) and measures to handle them.

1. Click [Detailed/Overview] to display the detail screen and select the device where the event occurred from the tree pane.

2. Click the [Warning] tab.

   This tab provides details on the reports from the selected device and how to handle them. Take the required measures in accordance with the information in [Suggested Action].
Displaying Error/Warning and Notice Details

■ Overview of screen

1 Device information:

- **[Group Name]** Displays the group name of a device. (If the group folder of the tree pane is the camera name set at the time of network camera registration or CAM-XXX (XXX: network camera’s IP address))
- **[Device Name]** Displays the device name.
- **[IP Address]** Displays the device’s IP address.
- **[Model Name]** Displays the device model name.
- **[Serial Number]** Displays the serial number of a device.

2 Notices and suggested actions:

- **[Status]** Displays icons depending on status information (errors, warnings or notifications) sent by a device.
- **[Notice]** Displays information on error, warnings or notifications.
- **[Suggested Action]** Provides measures to handle error, warnings or notifications.
Using the Early Warning Function (paid)

Displaying Error/Warning and Notice Details

Using a Network Camera to Detect the Presence of an Output Image

You can use a network camera installed for video surveillance of a device and use it to receive notifications when a video being displayed stops.

Preparation:
• Link a device to a network camera. (page 55).
• Set the video stop determination for the device registered to a network camera (page 193).

To display stopped video detection:
• Display notifications on the monitoring and control functions (page 197).
• Confirm the detection result on your web browser (page 197).

Notes
• The valid resolution size of an image acquired from a network camera at the time of video stop determination is as follows.
  Maximum: 4,096 (horizontal) × 2,160 (vertical)
  Minimum: 640 (horizontal) × 360 (vertical)

Setting the video stop determination of a device linked to a network camera

1 Start the software. (page 23)

2 From the tree pane of the <Device Monitoring> window, select the device icon that is linked to the network camera for which you want to perform video stop determination, then right-click it and select [Property].
  • To link a device to a network camera, move the device icon below the network camera. (page 55)
Using the Early Warning Function (paid)

Displaying Error/Warning and Notice Details

3 Click [Change peripheral device].

4 Select the check box [Make video stop determination] (①) and click [Create] (②) → [Video stop determination setting].

Notes
- When video stop determination is performed, it will periodically acquire JPEG images from the network camera.
- To maximize the video stop determination's performance, it is recommended to set a high JPEG quality and resolution on the network camera.
5 Configure detection of interruption of output image.

3 Detection area rectangle setting
A linked camera’s video will be displayed. Move the dots “●” at the four corners to set the area to determine.
• Set 10% or more for each vertical and horizontal length of the screen.

4 [WEB browser]
You can display the setting window of the network camera.
• It may be required to install the necessary plug-in software to display the setting window of the network camera depending on your environment. Follow the on-screen instructions and install the plug-in software.

5 [Update Camera Image]
Every time you click it, the latest image of the linked camera is displayed.

6 [Judgment sensitivity adj.]
Set determination sensitivity at the time of video determination stop.
[Auto]: Automatically adjust determination sensitivity by using the camera’s video displayed within the determination area as a standard.

1 Click [Auto].
• A confirmation message will be displayed on whether or not there is movement in the video within the determination area.
  - [Yes]: When sensitivity adjustment will be performed for video contents with movement.
  - [No]: When performing sensitivity adjustment on video content (excluding signage switching scenes) with no movement.

2 Click [Start].
Automatic adjustment of the determination sensitivity will begin. It will take approximately 1 minute to adjust.
[Manual]: Manually adjust determination sensitivity by using the camera’s video displayed within the determination area as a standard.

7 [No Image Determination time]
Set the duration of continuous stopped video before a notification is sent from 1 to 10 minutes (in 1 minute increments) starting from the time the video interruption is detected.
Using the Early Warning Function (paid)

Displaying Error/Warning and Notice Details

8 Manual adjustment display

It will only be displayed when [Manual] is selected at [Judgment sensitivity adj.] (6).
Set the determination sensitivity with the following as a reference.

- [Big(+3)]: Set when a video with only large movements is running
- [Standard(0)]: Normal setting (Video with a mix of many/few movements)
- [Small(-3)]: Set when a video with only small movements is running

6 Click [Setting].
When the “setting successful” message is displayed, click [OK].

Notes
- For video stop determination, images are acquired from the network camera at intervals of 12 seconds.
- If the network camera setting window is not being displayed even if the plug-in software required at [WEB browser] (4) is installed, perform network camera setting from the WEB browser of your computer.
Displaying Error/Warning and Notice Details

**Display notifications on the monitoring and control functions**

Upon notification that the image output has stopped, an icon is displayed in the information display area for the corresponding device.

![Multi Monitoring & Control Software](image)

**Confirm the detection result on your web browser**

1. Log in to the early warning from your web browser. (page 37)
2. Click the [Warning] tab, and then click [Result] (①).
   
   If there is no notification that the image output has stopped, [Result] (①) will not be displayed.

![Early Warning](image)
Displaying Error/Warning and Notice Details

3 View the notification details.
- Depending on the network connection status, it may take some time to display.
- Click ② to close the video status confirmation screen.

![Network camera video status](image)

Notes
- When a moving object such as a person is captured in the designated area for video stop determination, the movement may be detected and video stop determination may not be properly detected. Background reflections may be particularly noticeable when using a display with a glossy (glare) LCD panel.
- Video images with slow movement or with a small area of movement as well as videos that have a low contrast between the area with movement and its surroundings may not be properly detected.
- Depending on the installation environment of the camera and device, the stopped video detection function may not work properly.
- If there is a problem with detection results, re-adjust the determination sensitivity at [Video stop determination setting]. (page 193)
Displaying Error/Warning and Notice Details

Confirming Errors, Warnings and Notification History

Use the steps below to display the history of error, warnings and notifications and when they occurred for a registered device.

1. Click [Detailed/Overview] to display the detail screen and select the device where the event occurred from the tree pane.

2. Click the [History] tab and select [Date] (①).
   Messages are displayed in the [Message] field in the data display area to the right.
Using the Early Warning Function (paid)

Displaying Error/Warning and Notice Details

About the screen display

1. **[Date]**: Displays a list of the dates (history) when error, warnings and notifications have occurred.
   - The date icons indicate system log status.
     - : System log available (on a device that supports system log acquisition)
     - : No system log (on a device that does not support system log acquisition)

2. **[Message]**: Displays the error, warnings and notifications that occurred at the selected date.

3. **[Save]**: Saves the message data as compressed files.
   - For devices with accessible system logs, text files (.txt) and log files (.log / .bin) are saved as a single compressed file. The file name is made up from the year, month, day, hour, minute, second plus the “serial number”.
   - If no date is selected, this cannot be clicked.

**Notes**

- [Save] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Save] button cannot be clicked when viewed with an OS other than Windows OS such as an iOS or Android.
- The system log (log file) is saved in binary format.
- System log information can be checked by service personnel only.
- System logs (log files) are acquired only on devices that support them.
- Although the message field may display a message stating that remaining lamp or light source life is 200 hours, some devices may indicate remaining lamp or light source life as 0 hours. The lamp or light source can be used for the remaining 200 hours.
## Displaying Error/Warning and Notice Details

### Example showing saved data

#### - Projector example

<table>
<thead>
<tr>
<th>Date of Notice</th>
<th>Projector Information</th>
<th>Contents of Notice</th>
<th>Power</th>
<th>Device Information</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>/</strong>**** 2:26:23 PM</td>
<td>Group Name: Group</td>
<td>Status: Error</td>
<td>ON</td>
<td>Group Name: Group</td>
<td>Flat-panel display example</td>
</tr>
<tr>
<td></td>
<td>Projector Name: DZ21K-0001</td>
<td>Detail1: FAN Error / LIGHT1 FAN Error</td>
<td>Total Runtime: 123 H</td>
<td>Device Name: LFX60-08</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IP Address: <em><strong>.</strong></em>.<em><strong>.</strong></em></td>
<td>Suggested Action1: Ask your dealer.</td>
<td>LIGHT1 Runtime: 11 H</td>
<td>IP Address: <em><strong>.</strong></em>.<em><strong>.</strong></em></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Model Name: DZ21K</td>
<td>Detail2: FAN Error / Exhaust1 FAN Error</td>
<td>LIGHT2 Runtime: 22 H</td>
<td>Model Name: 47LFX60J</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial Number: AB1234567</td>
<td>Suggested Action2: Ask your dealer.</td>
<td>LIGHT3 Runtime: 333 H</td>
<td>Serial Number: 1234567890A</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Main Ver.: 1.00</td>
<td></td>
<td>LIGHT4 Runtime: 444 H</td>
<td>Main Ver.: 1.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Network Ver.: 1.03</td>
<td></td>
<td>LIGHT1 Remain Time: 1111 H</td>
<td>Network Ver.: 01.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LIGHT2 Remain Time: 2222 H</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LIGHT3 Remain Time: 3333 H</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LIGHT4 Remain Time: 4444 H</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Power On Count: 20 times</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Intake Air Temperature: 25 degC / 77 degF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Exhaust Air Temperature: 60 degC / 140 degF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Temperature near Optical Module: 80 degC / 176 degF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### - Flat-panel display example

<table>
<thead>
<tr>
<th>Date of Notice</th>
<th>Device Information</th>
<th>Contents of Notice</th>
<th>Power</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>/</strong>**** 2:26:23 PM</td>
<td>Group Name: Group</td>
<td>Status: Error</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Device Name: LFX60-08</td>
<td>Detail1: Error: No input signal</td>
<td>Total Runtime: 1033 H</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IP Address: <em><strong>.</strong></em>.<em><strong>.</strong></em></td>
<td>Suggested Action1: Error: A valid input signal has not been detected while specific hours.</td>
<td>Power On Count: 147 times</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Model Name: 47LFX60J</td>
<td>Confirm the cabling, source signals, and installation conditions.</td>
<td>Internal Air Temperature1: 28 degC / 82 degF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial Number: 1234567890A</td>
<td>Hours can be specified at the display's menu setting.</td>
<td>Intake Air Temperature1: 23 degC / 73 degF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Main Ver.: 1.00</td>
<td></td>
<td>Intake Air Temperature2: 21 degC / 69 degF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Network Ver.: 01.03</td>
<td></td>
<td>Exhaust Air Temperature1: 23 degC / 73 degF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Exhaust Air Temperature2: 21 degC / 69 degF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Panel Temperature1: 25 degC / 77 degF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Panel Temperature2: 25 degC / 77 degF</td>
<td></td>
</tr>
</tbody>
</table>
Checking the Maintenance Timing

The software records the operating status and operating hours of registered devices to predict roughly when consumable parts replacement, regular periodic cleaning and non-consumable parts replacement will be required.

Preparation:
- To check the maintenance cycle for a Basic information model device, you must configure the maintenance parts settings for the device beforehand. (page 209)

1. Click [Detailed/Overview] to display the detail screen and select the device whose maintenance cycle is to be checked from the tree pane.

2. Click the [Hour Meter] tab.
   Detailed information of maintenance cycle will be displayed.
Checking the Maintenance Timing

About the screen display

1. [Average Daily hours of Operation]:
   Uses the past power on hours for a device to calculate and display daily average usage time.
   - Data for a minimum of seven days of operation is required to calculate average usage time.
   - “---” is displayed when there is not enough power on hour data.

2. [Consumable Parts Replacement]:
   Displays maintenance cycle information for consumables.

<table>
<thead>
<tr>
<th>Part name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A graph showing power on hours and the name of the consumable part appear.</td>
</tr>
<tr>
<td></td>
<td>The state of the part is indicated by the color of the graph.</td>
</tr>
<tr>
<td></td>
<td><strong>Green</strong>: Normal (there is still some time before a notification will be made)</td>
</tr>
<tr>
<td></td>
<td><strong>Light blue</strong>: A notification has occurred (the set number of remaining days has been reached). (page 207)</td>
</tr>
<tr>
<td></td>
<td><strong>Orange</strong>: Warning has occurred (time has come for Consumable Parts Replacement, Regular Periodic Cleaning, Non-Consumable Parts Replacement).</td>
</tr>
</tbody>
</table>

   | Power on hours   | Displays the power on hours for consumables. For projectors that allow setting of the lamp power or lamp output to “ECO” or “low”, the displayed light device runtime is calculated as if the lamp was used with the lamp power or lamp output set to “normal” or “high”. |

   | Predicting when a replacement will be required | Indicates the number of days after which a consumable will have to be replaced. Data for a minimum of seven days of operation is required to calculate the number of days until a warning is displayed. “---” is displayed when there is not enough power on hour data. |

   | [Reset]          | Resets the power on hours for consumables. Clicking [Reset] displays a confirmation message. Click [OK] to perform the reset. After processing, the graph and the number of days until parts replacement are initialized. Click [Cancel] if you decide not to reset. |
Checking the Maintenance Timing

### [Regular Periodic Cleaning]:
Displays maintenance information indicating when parts should be cleaned.

<table>
<thead>
<tr>
<th>Part name</th>
<th>The names of parts that need to be cleaned and a graph showing power on hours appear. The state of the part can be distinguished by the color of the graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Green</strong>: Normal</td>
</tr>
<tr>
<td></td>
<td><strong>Light blue</strong>: A notification was sent</td>
</tr>
<tr>
<td></td>
<td><strong>Orange</strong>: Warning occurrence</td>
</tr>
</tbody>
</table>

**Predicting when cleaning will be required**
Predicts the number of days after which a part will have to be cleaned. Data for a minimum of seven days of operation is required to calculate the number of days until a warning will be displayed. “---” is displayed when there is not enough power on hour data.

**[Reset]**
Resets the power on hours for part cleaning. Clicking [Reset] displays a confirmation message. Click [OK] to perform the reset. After processing, the graph and days until periodic cleaning are initialized. Click [Cancel] if you decide not to reset.

**[Reset All]**
Resets the power on hours for cleaning of all parts. Clicking [Reset All] displays a confirmation message. Click [OK] to perform the reset. After processing, the graph and days until periodic cleaning are initialized. Click [Cancel] if you decide not to reset.

### [Non-Consumable Parts Replacement]:
Displays maintenance information indicating when non-consumable parts should be replaced.

<table>
<thead>
<tr>
<th>Part name</th>
<th>The names of parts that need to be replaced and a graph showing power on hours appear. The state of the part can be distinguished by the color of the graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Green</strong>: Normal</td>
</tr>
<tr>
<td></td>
<td><strong>Light blue</strong>: A notification was sent</td>
</tr>
<tr>
<td></td>
<td><strong>Orange</strong>: Warning occurrence</td>
</tr>
</tbody>
</table>

**Predicting when a replacement will be required**
Indicates the number of days after which a part will have to be replaced. Data for a minimum of seven days of operation is required to calculate the number of days until a warning is displayed. “---” is displayed when there is not enough power on hour data.

**[Reset]**
Resets the power on hours for non-consumable parts replacement. Clicking [Reset] displays a confirmation message. Click [OK] to perform the reset. After processing, the graph and the approximate number of days until non-consumable parts replacement are initialized. Click [Cancel] if you decide not to reset.

**[Reset All]**
Resets the power on hours for replacement of all non-consumable parts. Clicking [Reset All] displays a confirmation message. Click [OK] to perform the reset. After processing, the graph and the approximate number of days until non-consumable parts replacement are initialized. Click [Cancel] if you decide not to reset.

**Notes**
- This function predicts time for replacements and cleaning based on customer usage and should be used as guidance only.
Output monthly report

The operating environment, history information, error information of the past 30 days, Warning content, notifications and maintenance information of the registered devices will be output as an operation report.

1. Click [Detailed/Overview] to display the detail screen and select a device to output maintenance information from the tree pane.

   - The operation report from the past 30 days is saved as a compressed CSV file.
## Example showing saved data

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[Monthly Report]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Period: 2023-01-01 to 2023-01-31</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Device Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Item</td>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Group Name</td>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Model Name</td>
<td>PT-RO60K</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Device Name</td>
<td>RO60K-001</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>IP Address</td>
<td>192.168.1.100</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Serial Number</td>
<td>SN1234567</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Power On Count</td>
<td>749</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Main Version</td>
<td>1.00</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Network Version</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Set Runtime (H)</td>
<td>3222</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Average Daily hours of Operation</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>LIGHT1 Runtime (H)</td>
<td>3222</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>LIGHT2 Runtime (H)</td>
<td>3222</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>LIGHT3 Runtime (H)</td>
<td>3222</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Notes</td>
<td>[Output Monthly Report] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Output Monthly Report] button cannot be clicked when viewed with an OS other than Windows OS such iOS or Android.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>[Current notification [Error/Warning/Information]]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>No</td>
<td>Status</td>
<td>Content</td>
</tr>
<tr>
<td>22</td>
<td>1</td>
<td>Error</td>
<td>FAN Error</td>
</tr>
<tr>
<td>23</td>
<td>2</td>
<td>Warning</td>
<td>FAN Warning</td>
</tr>
<tr>
<td>24</td>
<td>3</td>
<td>Warning</td>
<td>Chilled High Temperature Warning</td>
</tr>
<tr>
<td>25</td>
<td>4</td>
<td>Warning</td>
<td>Intake Air High Temperature Warning</td>
</tr>
<tr>
<td>26</td>
<td>5</td>
<td>Warning</td>
<td>Color Print FAN Error</td>
</tr>
<tr>
<td>27</td>
<td>3</td>
<td>Count of occurrences</td>
<td>3</td>
</tr>
</tbody>
</table>
Checking the Maintenance Timing

### Configuring Maintenance Cycle Settings

You can configure the length of time after which consumable parts replacement, parts cleaning, and regular parts replacement should be performed (maintenance cycles) for registered devices.

- When the maintenance cycles are configured for each maintenance item, green bar graphs that are linked to the device’s usage time indicate the elapsed time for each maintenance item. When the end of a maintenance cycle is reached, the corresponding bar turns orange, and notifications for the approximate replacement and cleaning periods are indicated in the tree view area.

1. **Click [Detailed/Overview]** to display the detail screen and select the device whose maintenance cycle is to be configured from the tree pane.

2. **Select the [Hour Meter] tab and click [Maintenance Cycle Editor]** (①).
   - The maintenance cycle configuration screen will differ between Rich information model and Basic information model devices.
Checking the Maintenance Timing

**For “Rich information model” devices**

When a device is registered as a “Rich information model”, the maintenance items and maintenance cycles for that device are displayed.

- Change the maintenance cycle settings as necessary.
- The setting ranges for the displayed maintenance items and maintenance cycles will vary depending on the device.

![Maintenance Cycle Settings Diagram]

<table>
<thead>
<tr>
<th></th>
<th><strong>Maintenance cycle settings</strong></th>
<th>Sets the maintenance cycle for each item.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[Return to the Default]</td>
<td>Restores maintenance cycle settings to the software’s pre-configured values.</td>
</tr>
<tr>
<td></td>
<td>[Update]</td>
<td>Updates the maintenance cycle settings with the settings configured here.</td>
</tr>
<tr>
<td></td>
<td>[Cancel]</td>
<td>Cancels the update, and restores the settings to the original values.</td>
</tr>
</tbody>
</table>
Checking the Maintenance Timing

For “Basic information model” devices
When a device is registered as a “Basic information model”, you must select the maintenance cycle items for which you want to configure settings before configuring them. The following maintenance cycle items typically appear for you to select and configure as necessary.

1. Maintenance items and cycle settings
   - Place a check next to the items you want to configure and set their maintenance cycles.
   - To change a maintenance cycle setting, enter an hour value from 1 to 99999.

2. [Update]
   - Updates the maintenance cycle settings with the settings configured here.

3. [Cancel]
   - Cancels the update, and restores the settings to the original values.

Notes
- As the light device runtime is used to determine the device usage time for Basic information model devices, the maintenance cycle confirmation and notification functions cannot be used for devices for which light usage information cannot be obtained, even when the related settings are configured.
- For projectors that allow setting of the lamp power or lamp output to “ECO” or “low”, the light device runtime is calculated as if the lamp was used with the lamp power or lamp output set to “normal” or “high”. For light maintenance cycles, configure times that are calculated as if the light was used with the lamp power or lamp output set to “normal” or “high”.
- The maintenance cycle confirmation and notification functions should be configured to serve in determining when parts replacement and cleaning will be necessary. They are intended to be used as a guide.
- Projectors equipped with five or more light sources are not supported.
- When a Basic information model becomes recognized as a Rich information model by updating the Device Profile Library, the maintenance settings and maintenance cycles that you previously configured for the Basic information model will be cleared and replaced with that device’s default settings.
Confirming Device Temperature and Voltage Information

Information from the device’s internal temperature sensors and projector voltage information is collected, and the trends for each can be displayed as graphs.

1. Click [Detailed/Overview] to display the detail screen and select the device whose temperature or voltage information is to be checked from the tree pane.

![Graph of device temperature and voltage information]

2. Click the [Environment Info] tab.
   - The following information is displayed as a graph on the [History] screen and the [Live] screen.
     - **[Temperature]:** Device temperature information (page 211, 213)
     - **[Voltage]:** Projector voltage information (page 215, 217)
Confirming Temperature Information Histories

The temperature information collected for the past 30 days are graphically displayed so that you can check for problems with the installation environment, etc. of the device.

1. Click the [Environment Info] tab. (page 210)

2. Click [Temperature] to display the [History] screen.

- **Temperature unit**: Allows you to switch the temperature unit of the graph display between Fahrenheit and Celsius.

- **Temperature range**: Allows you to specify the upper and lower limits of the vertical axis of the graph display within the following ranges.
  - **[Min. plot]**: Celsius: -20 °C to 190 °C, Fahrenheit: 0 °F to 420 °F
  - **[Max. plot]**: Celsius: -10 °C to 200 °C, Fahrenheit: 20 °F to 440 °F

- **[Graph Options]**: Clicking the button displays the corresponding temperature information.

- **Checked graph options will be displayed in the graph. (maximum of 10)**

- **Click to change the color displayed.**

- **The selected warning temperature is shown in orange.**
Using the Early Warning Function (paid)

Confirming Device Temperature and Voltage Information

4 **Graph view area:** Displays a temperature information graph for each of the selected items.

5 **Plot information tooltip:** Place the mouse pointer on a plot in the graph to display detailed temperature information. (You can also display it by tapping the plot.)
   - The device temperature status is indicated by the display color of the text.
     - **Black:** Normal
     - **Yellow:** Warning
     - **Red:** Error

6 **Date selection:** Displays a calendar you can use to select the start date of the graph.

7 **Display period:** Select the period of time covered by the horizontal axis of the graph display.
   - [6 hours], [12 hours], [1 day], [5 days], [10 days]*, or [30 days]*.
   - * Cannot be selected when using a tablet or iPhone.

8 **< / >:** Click these buttons to scroll the graph within the time period selected in (7).

9 **[Save History]:** Displayed graphs will be saved as a compressed CSV file.

### Example showing saved data

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IP Address</td>
<td><em><strong>-</strong></em>-<em><strong>-</strong></em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Model Name</td>
<td>PT-<em><strong>-</strong></em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Device Name</td>
<td>Name1 234</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Serial Number</td>
<td>SW-<em><strong>-</strong></em>-***</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Date</td>
<td>Intake temperature(DegC)</td>
<td>Intake temperature-Warning(DesC)</td>
<td>Optics Module temperature(DegC)</td>
<td>Optics Module temperature-Warning(DesC)</td>
<td>Exhaust temperature(DesC)</td>
<td>Exhaust temperature-Warning(DesC)</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>23</td>
<td>50</td>
<td>81</td>
<td>110</td>
<td>58</td>
<td>85</td>
</tr>
</tbody>
</table>

### Notes

- **[Save History] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Save History] button cannot be clicked when viewed with an OS other than Windows OS such as an iOS or Android.**
Confirming Device Temperature and Voltage Information

**Monitoring Temperature Changes on Devices**

The latest temperature information is displayed in a graph. By monitoring temperature information for a device during operation or events, you can react promptly to signs of problems.

1. Click the [Environment Info] tab. (page 210)
2. Click [Temperature], then select [Live].
   - The following message appears when displaying the [Live] screen for the first time after logging into the software. Click [OK] after viewing the content of the message.

---

**Temperature unit:** Allows you to switch the temperature unit of the graph display between Fahrenheit and Celsius.

**Temperature range:** Allows you to specify the upper and lower limits of the vertical axis of the graph display within the following ranges.

- **[Min. plot]:**
  - Celsius: -20 °C to 190 °C,
  - Fahrenheit: 0 °F to 420 °F

- **[Max. plot]:**
  - Celsius: -10 °C to 200 °C,
  - Fahrenheit: 20 °F to 440 °F
Confirming Device Temperature and Voltage Information

3 [Graph Options]: Clicking the button displays the corresponding temperature information.

- Checked graph options will be displayed in the graph. (maximum of 10)
- Click to change the color displayed.
- The selected warning temperature is shown in orange.

4 Graph view area: Displays a temperature information graph for each of the selected items.

5 Plot information tooltip: Place the mouse pointer on a plot in the graph to display detailed temperature information. (You can also display it by tapping the plot.)
- The device temperature status is indicated by the display color of the text.
  - Black: Normal
  - Yellow: Warning
  - Red: Error

6 Display period: Select the period of time covered by the horizontal axis of the graph display.
  - [10 minutes], [30 minutes], [1 hour]

Notes
- The temperature information items that appear vary depending on the device.
- The temperature information plots may not be displayed for some devices when they are turned off.
- Temperature information is not displayed for devices without built-in temperature sensors or devices belonging to the “Basic information model” group.
- The interval at which the monitoring screen is updated depends on the [Interval Time of Device Information] setting. The shorter the value specified for the [Interval Time of Device Information] setting, the faster the monitoring screen is updated, allowing for more detailed tracking of temperature changes. To check detailed changes in the graph, setting [Interval Time of Device Information] to 1 minute is recommended. However, this will result in heavier network loads, so adjust the [Interval Time of Device Information] setting as necessary. For details about the [Interval Time of Device Information] setting, see page 220.
Confirming Device Temperature and Voltage Information

### Checking the History of Collected Voltage Data

The voltage information collected for the past 30 days is graphically displayed so that you can check for problems with the installation environment, etc., of the device.

1. Click the [Environment Info] tab. (page 210)
2. Click [Voltage] to display the [History] screen.

- **Voltage Range**: Allows you to specify the upper and lower limits of the vertical axis of the graph display within the following ranges.
  - [Min. plot]: 0 V to 260 V
  - [Max. plot]: 10 V to 270 V
    - Measurement gradations are assigned automatically (integer values) so that there are 10 gradations between the specified upper and lower limits.

- **Graph view area**: Voltage information will be displayed in the graph. (Yellow)
  - For periods where no information could be obtained, there are gaps in the graph where nothing is displayed.

- **Plot information tooltip**: Place the mouse pointer on a plot in the graph to display detailed voltage information. (You can also display it by tapping the plot.)
  - The input voltage status is indicated by the display color of the text.
    - **Black**: The input power supply voltage is appropriate.
    - **Yellow**: The input power supply voltage is too low.

- **Date selection**: Displays a calendar you can use to select the start date of the graph.

- **Display period**: Select the period of time covered by the horizontal axis of the graph display.
  - [6 hours], [12 hours], [1 day], [5 days], [10 days]*, or [30 days]*.
  - * Cannot be selected when using a tablet or iPhone.

- **/**: Click these buttons to scroll the graph within the time period selected in (5).

- **[Save History]**: Displayed graphs will be saved as a compressed CSV file.
### Example showing saved data

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IP Address</td>
<td><em><strong>.</strong></em>.<em><strong>.</strong></em></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Model Name</td>
<td>PT-*********</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Device Name</td>
<td>Name1234</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Serial Number</td>
<td>SW*********</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Date</td>
<td>Date</td>
<td>AC Voltage</td>
</tr>
<tr>
<td>7</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>100</td>
</tr>
<tr>
<td>8</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>102</td>
</tr>
<tr>
<td>9</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>80</td>
</tr>
<tr>
<td>10</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>102</td>
</tr>
<tr>
<td>11</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>100</td>
</tr>
<tr>
<td>12</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>101</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>dd/MM/yyyy HH:mm:ss</td>
<td>1/1/2023</td>
<td>101</td>
</tr>
</tbody>
</table>

### Notes
- [Save History] can only be used when viewed with Internet Explorer or Microsoft Edge on a Windows OS. The [Save History] button cannot be clicked when viewed with an OS other than Windows OS such as an iOS or Android.
- In the following cases voltage information cannot be output even if a graph is displayed:
  - If the connected device does not match the registered details
  - If the projector has been removed
Monitoring Projector Voltage Trends

The latest voltage trend is displayed in a graph. By monitoring the voltage status of a device during operation or events, you can react promptly to signs of problems.

1. Click the [Environment Info] tab. (page 210)

2. Click [Voltage], then select [Live].

   • The following message appears when displaying the [Live] screen for the first time after logging into the software. Click [OK] after viewing the content of the message.

   ![Message]

   Voltage Range: Allows you to specify the upper and lower limits of the vertical axis of the graph display within the following ranges.

   [Min. plot]: 0 V to 260 V (Default setting value: 70 V)
   [Max. plot]: 10 V to 270 V (Default setting value: 270 V)

   Graph view area: Voltage information will be displayed in the graph. (Yellow)
Confirming Device Temperature and Voltage Information

③ Plot information tooltip: Place the mouse pointer on a plot in the graph to display detailed voltage information. (You can also display it by tapping the plot.)
- The input voltage status is indicated by the display color of the text.
  Black: The input power supply voltage is appropriate.
  Yellow: The input power supply voltage is too low.

④ Display period: Select the period of time covered by the horizontal axis of the graph display.
[10 minutes] (Default setting value), [30 minutes], [1 hour]

Notes
- Voltage information is not displayed for devices without built-in voltage sensors or devices belonging to the “Basic information model” group.
- The interval at which the monitoring screen is updated depends on the [Interval Time of Device Information] setting.
  The shorter the value specified for the [Interval Time of Device Information] setting, the faster the monitoring screen is updated, allowing for more detailed tracking of voltage changes. To check detailed changes in the graph, setting [Interval Time of Device Information] to 1 minute is recommended. However, this will result in heavier network loads, so adjust the [Interval Time of Device Information] setting as necessary.
  For details about the [Interval Time of Device Information] setting, see page 220.
Setting the Monitoring and Control’s option function

1. Select [Options] → [Setting] from the menu.

2. When the <Setting> window is displayed, select the tab you want to change the setting of and set the details.

3. After configuring the settings, click [Close] to close the <Setting> window.

For how to configure each setting, see the following pages.

- [General]
  - [Interval Time of Device Information] (page 220)
  - [System log entry save count] and system history deletion (page 221, 222)
  - [Port Number of Command Control] (page 223)
  - [Port number (UDP) for status notification (reception)] (page 224)

- [Detailed Information] (page 225)
- [Monitor Information] (page 225)
Setting the Monitoring and Control functions

Setting the Information Updating Interval

Information regarding devices being monitored/controlled can be updated at regular intervals.

1. **Click the [General] tab. (page 219)**

2. **Set the [Interval Time].**
   The time interval can be selected from 1 to 90 minutes in 1-minute increments.

   ![Setting Interface]

3. **Click [Update].**
   An update message appears. Click [OK].
   - If [Update] is clicked after characters other than 1 to 90 or no characters at all are entered in [Interval Time], the following message will appear.

   ![Error Message]

**Notes**

- It may not be impossible to acquire information for all devices when there are many registered devices and [Interval Time of Device Information] is short. In this case, extend [Interval Time of Device Information].

220
Setting the Number of System History Entries that can be Saved

Use the following steps to set the number of system history entries (page 187) that can be saved.

1. Click the [General] tab. (page 219)

2. Set [System log entry save count].
   From the pull-down menu, select [500], [1000] or [2000].

3. Click [Update].
   An update message appears. Click [OK].
Deleting the System History Information

Use the steps below to delete saved system history data.

1. Click the [General] tab. (page 219)

2. Click [Delete system log] (①).
   Click [Yes] in the delete confirmation message that appears. The system history data is deleted. However, the device history data (page 187) is not deleted.

Notes
- Deleting the system history information will delete the brief system history information as well.
Setting the Port Number for Command Control

Set the port number for the command control to be used in communication with the device.

1. Click the [General] tab. (page 219)

2. Enter the port number for command control in ①.  
   • If there is a port number setting for command control in the setting items of the device to be used, match this setting to that setting. (Default setting value: 1024)

3. Click [Update].  
   When the settings are complete, a message to inform updating is complete will be displayed. Click [OK].

Notes
   • For connecting to multiple devices, you need to make sure the port numbers match on all the devices.  
   • If the port number is incorrect, the information cannot be retrieved.
Setting the Status Notification Function

Set a port number for receiving status notifications from devices. By setting the status notification function, you can track via the software the status of flat panel displays when the power lamp flashes red due to a malfunction, even if the displays are in a remote location that prevents checking the power lamp directly.

1 Click the [General] tab. (page 219)

2 Place a check mark in [Setting enabled] (①).

3 Enter the port number for status notifications (reception) in (②).
   • Default setting value: 1024

4 Click [Update].
   When the settings are complete, a message to inform updating is complete will be displayed. Click [OK].

Notes
• To use the status notification function, it is necessary to make settings in the <Web Control> window of the device (status notification settings page). For details about setting the <Web Control> window, please refer to the operating manual for the device being used.
• It is not possible to receive status notifications from a device if the port number entered does not match the port number of the device.
• For connecting to multiple devices, you need to make sure the port numbers match on all the devices.
• In the tree view area (page 173) you can check errors based on status notifications received from devices. If an error or warning from the early warning function is displayed in the window, report the error number to your retailer.
• For flat panel displays that support the status notification function. To see if a flat panel display being used is supported, refer to the “List of Compatible Device Models” on the following website.
https://panasonic.net/cns/prodisplays/download/software/
Changing the Information Displayed on the Information Display Windows

Items displayed on the Detailed Information Display (page 87) and Brief Information Display (page 82), as well as the display sequence can be changed.

1 Click the [Detailed Information] or [Monitor Information] tab.

![Detailed Information] window
![Monitor Information] window

Items checked under [Display Item] will be displayed on each window. When you select an item and click [▲] / [▼], the item moves up or down and the display sequence changes.

2 Click [Update].
An update message appears. Click [OK].
Setting up the Early Warning Function (paid)

Setting the Early Warning Function of Monitoring and Control

1. Open the [Early Warning Configurations] tab and click [Others].

   ![Configuration Screen]

   For how to configure each setting, see the following pages.
   - [SNMP] (page 227)
   - [Mail] (page 230)
   - [Error/Warning] (page 234)
   - [Notification] (page 236)
   - [User account] (page 238)
   - [Video stop determination] (page 242)
Setting up the Early Warning Function (paid)

Setting SNMP Notifications

When an SNMP manager is installed on the same network as the monitoring and control terminal, this software can use SNMP traps to report the error, warnings and notifications that a device causes.

Types of SNMP traps that are sent

<table>
<thead>
<tr>
<th>Type</th>
<th>OID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error occurred</td>
<td>1.3.6.1.4.1.258.1000.1.1 101</td>
</tr>
<tr>
<td>Error cleared</td>
<td>1.3.6.1.4.1.258.1000.1.1 102</td>
</tr>
<tr>
<td>Warning occurred</td>
<td>1.3.6.1.4.1.258.1000.1.2 101</td>
</tr>
<tr>
<td>Warning cleared</td>
<td>1.3.6.1.4.1.258.1000.1.2 102</td>
</tr>
<tr>
<td>A notification was sent*</td>
<td>1.3.6.1.4.1.258.1000.1.3 101</td>
</tr>
<tr>
<td>A notification was cleared*</td>
<td>1.3.6.1.4.1.258.1000.1.3 102</td>
</tr>
</tbody>
</table>

*You can also configure notifications from [Notification]. (page 236)

1. Open the [Others] tab (page 226), and click [SNMP].
Setting SNMP Notifications

2 Select the [Notify by SNMP Trap] check box and configure the settings required for SNMP notifications.

[SNMP Manager IP Address]: Enter the IP address.
[SNMP Manager Host Name]: Enter the host name.
[SNMP Community Name]: Enter the community name to enable authentication between the SNMP manager and this software.

3 Click [Update] (①).
A message indicating that the update was successful appears. Click [OK] to update the settings.
• Click [Close] (②) if you decide not to update.

4 Click [Occur] and [Recover] under [Test SNMP Trap].
This sends an SNMP trap whenever an error, warning, or notification is issued or canceled.
Setting up the Early Warning Function (paid)

Setting SNMP Notifications

Notes

- This requires that an SNMP manager runs in the system configuration you use.
- The software can only send SNMP trap transmissions initiated by the SNMPv1 [RFC1155, RFC1157] trap command.
- The MIB (management information base) used for sending SNMP traps can be acquired as follows.
  ① Log in to PASS from one of the following websites.
     https://panasonic.net/cns/projector/pass/
     https://panasonic.net/cns/prodisplays/pass/
  ② Click [Download] from the side menu.
  ③ Click Select Utility Software → Early Warning Software → [MIB].
  ④ Click [Download] to begin downloading.
- For details on how to set up an SNMP manager, consult your network administrator.
Configuring the Required Settings for Sending Mail

Use the steps below to send data on errors, warnings and notifications caused by a device via mail to an E-mail address specified by this software.

1. Open the [Others] tab (page 226), and click [Mail].

2. Select the [Notify by E-Mail] check box and enter the [SMPT Server Name] and the [SMTP Server Port Number].
3 To make an authentication server setting, click [Authentication server settings].

The Authentication Server Setting area appears. Select the authentication method for sending mail.
• Go to step 4 if you do not need to set an authentication server.

1 [SMTP Authentication]: Select an authentication method from [PLAIN], [LOGIN], or [CRAM-MD5].
2 [POP Before SMTP]: Enter the [POP Server Name], [POP Server Port Number], [User Name] and [Password].

4 Enter the email addresses of the sender and recipients.

3 [Mail Sender Address]: Enter the email address of the monitoring and control terminal.
4 [Mail Recipient]: Select the check boxes and enter the email addresses of recipients in the same network. (Maximum of 5)
Configuring the Required Settings for Sending Mail

5 Select the [Prevent sending Mail during following days and time.] check box to disable sending mail at certain times.

- Check the day of the week to disable sending of mail.
- Enter the start time, in the range “00:00” to “23:59”, at which to disable sending of mail.
- Enter the number of hours, in the range “1” to “99”, to disable the sending of mail starting from the time set in 6.

Example:
To disable sending of mail from 9pm every Tuesday to 9am Thursday and from 9pm every Saturday to 9am Monday, check the [Tue.] and [Sat.] check boxes, enter “21:00” in the time boxes, and enter “36” for the number of hours.

6 Enter [Memo].
- Enter the text to appear in the body of the email. Fill in as necessary.

7 Click [Test Mail] to send a test mail.
- Send a test email to the destination email addresses you entered in step 4.

Test mail example:
Subject: Panasonic Device Report (Test)
Body: This is a test mail from Early Warning Software.

8 Click [Update].
A message indicating that the update was successful appears. Click [OK] to update the settings.

Notes
- Enter the mail address in the “***@***” format.
- To use the mail transmission function, you must have a mail server in your system configuration. The mail address of the monitoring and control terminal must be registered in the mail server.
- For details on how to register and configure a mail server, consult your network administrator.
## Configuring the Required Settings for Sending Mail

### Example of Mail Transmission

**Mail subject:** Panasonic Device Report (Error/Warning/Information)

**Mail send date:** June 7, 2013, 10:55:38

**Device Information:**
- **Group Name:** Group
- **Device Name:** DZ21K
- **IP address:** ***.***.***.***
- **Model Name:** DZ21K
- **Serial Number:** AB1234567
- **Main Version:** 1.00
- **Network Version:** 1.03

**Detected data:**
1. **Status:** Warning
   - **Detail 1:** Color prism 3, fan error
     - **Suggested action 1:** Have your dealer inspect the fan.
       - The color prism cooling fan 3 has reached the level threshold.
   - **Detail 2:** Projector LAN connection error
     - **Suggested action 2:** Check whether the LAN cable is properly connected.
     - Check whether the main power supply has been turned on.

**Power:** On
- Set power on hours: 16984 hrs
- LIGHT 1 power on hours: 4 hrs
- LIGHT 2 power on hours: 3 hrs
- LIGHT 3 power on hours: 3 hrs
- LIGHT 4 power on hours: 3 hrs
- Remaining time for LIGHT 1: 1996 hrs
- Remaining time for LIGHT 2: 1996 hrs
- Remaining time for LIGHT 3: 1997 hrs
- Remaining time for LIGHT 4: 1997 hrs
- Power on times: 154 times
- Color prism cooling 3 fan belt: 465
- Color prism cooling 3 fan data 1: 4CE
- Color prism cooling 3 fan data 2: 0AF
- Intake temperature: 25 degC/77 degF
- Exhaust temperature: 26 degC/78 degF
- Temperature around optical module: 30 degC/86 degF

**Memo:**
- Example of Mail Transmission
- **Device setting data**
- **Device error, warning, notification details and suggested action**
- **Light power on hours, remaining time and temperature data**
- **Memo data**
Setting a Warning to Report that a Device is Not Connected

Use the steps below to output a warning to notify when for some reason a device is not connected to the network. A warning is output when connection with a device cannot be confirmed after a preset number of connection attempts during a device update.

If you are aware in advance that a device will not be connected on specific days or times, you can configure settings to disable disconnection warnings during those days or times.

1. Open the [Others] tab (page 226), and click [Error/Warning].

2. Select the [Warn if device is not found in network] check box and enter [Number of retries before Warning].

   Enter a value between “1” and “99”.
   • If greater the number of retries before warning, the longer it will take to determine that a device is not connected.
Setting up the Early Warning Function (paid)

Setting a Warning to Report that a Device is Not Connected

3 Select the [Avoid warning even if device is not found in network during following days and time.] check box, and configure the settings to disable disconnection warnings at certain times.

- To keep disconnection warnings enabled at all times, proceed to step 4 without selecting [Avoid warning even if device is not found in network during following days and time.].

![Warning settings interface]

①: Select the check boxes for the days on which disconnection warnings will be disabled.
②: Enter the start times, in the range "00:00" to "23:59", for the periods at which disconnection warnings will be disabled.
③: Enter the number of hours, in the range "1" to "48", to disable warnings starting from the time set in ②.

Example:
Configure the settings as shown in the screen above to disable disconnection warnings every week for 24 hours from 10:30 AM Tuesday to 10:30 AM Wednesday and for 24 hours from 8:30 AM Saturday to 8:30 AM Sunday.

4 Click [Update].

A message indicating that the update was successful appears. Click [OK] to update the settings.
### Updating Notification Data

Use the following steps to set the number of days remaining until a consumable parts replacement, regular periodic cleaning and non-consumable parts replacement are announced and to make settings to send notifications via mail or SNMP transmission. This also allows you to set notifications for devices that operate for a long time or that are otherwise left turned on.

1. **Open the [Others] tab (page 226), and click [Notification].**

2. **Set how many days in advance to issue each notification.**
   
   Enter the number of days in the range “0” to “999”.
   
   - A setting of 0 days mean that no notification will be made. However, if 0 days is set for [Consumable Parts Replacement] and [Non-Consumable Parts Replacement], those replacement warnings will still be sent by mail and SNMP trap transmission.
3 In [Notify by SNMP Trap] (①), select the notifications to be performed by SNMP, and in [Notify by E-Mail] (②), select the notifications to be performed by mail.

![Notify by SNMP Trap](image1)
![Notify by E-Mail](image2)

4 To provide notification of continuous running, select the [Notify if Devices is running continuously] check box, and select [8 hours], [16 hours], or [24 hours] as the continuous operation time that requires notification.

A notification is sent if the powered-on state exceeds the specified number of hours.

- If the power is cycled off/on while the software is updating information, the power state may be recognized as being continuously powered-on, even though the device was actually not running continuously. For example, if the interval to automatically acquire device information ([Interval Time of Device Information]) is set to 90 minutes, and the device is turned off and on between one automatic update and the next, this software cannot recognize the change in power status of the device.

![Notify if Devices is running continuously](image3)

5 Click [Update].

A message indicating that the update was successful appears. Click [OK] to update the settings.

**Notes**

- The [Notify by SNMP Trap] setting causes notification to be sent via an SNMP notification when SNMP is enabled in the SNMP configuration screen.
- The [Notify by E-Mail] setting causes notification to be sent via an E-mail message when the mail setting is enabled in the mail configuration screen.
Registering, Deleting and Changing User Account Control

Use the steps below to perform the user management for logging in to the early warning function from a web browser.

1. Open the [Others] tab (page 226), and click [User account].

2. Click [Add new Account].
3 Enter the user information.

[User Name]: Enter the login user ID. (Up to 64 single-byte alphanumeric characters)
[Account Type]: Select [Administrative User] for users who are to be assigned administrator privileges, or [Standard User] for users who will not be registering devices.

[Password]: Enter the login password.
[Confirm Password]: Re-enter what you typed in [Password].
  - If you click [Cancel] (①), the entered content will be canceled.

4 Click [Register] (②).

You will return to the screen in step 2, and the registered user will appear in the [User accounts].
  - If continuing to register a user, repeat steps 2 to 4. (Maximum of 100 people).
  - An error message appears if an attempt is made to register an already registered user name. Register the user under another name.
Changing the Registered Information

1. Click [Update] in the [User accounts].

2. Change user account control.
   - The [User Name] cannot be changed.
   - [Password] and [Confirm Password] are not echoed to the screen.

3. Click [Update].
   The entered data is used for changing user account control and the user accounts screen appears again.
   - Click [Cancel] if you decide not to update.
Registering, Deleting and Changing User Account Control

Deleting a User

1 Click [Delete] in the [User accounts].

2 When the confirmation message is displayed, click [OK].
   The user is now deleted from user accounts.
   • Click [Cancel] if you decide not to delete.
Making Video Stop Determination Settings for a Network Camera

You can set video stop determination exception conditions for a network camera.

1. Open the [Others] tab (page 226), and click [Video stop determination].

2. Check the determination conditions you want to add.

   ①: Check to include cases where the device is in the standby state (not projecting) or communication is not possible in the determination conditions.
   ②: Check to include no-signal zones in the determination conditions for devices supporting no-signal detection.

3. Click [Update].
   A message indicating that the update was successful appears. Click [OK] to update the settings.
Error Messages

Errors relating to the multi monitoring and control functions

**Cannot register a device**

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please register as a device administrator authority user.</td>
<td>Specify a user name and password for the administer privileges of the device then register.</td>
</tr>
<tr>
<td>2048 devices have already been registered.</td>
<td>The maximum number of registered devices is 2,048. Be sure to stay within that range.</td>
</tr>
<tr>
<td>Create Device Failed. Confirm IP Address, User Name and Password.</td>
<td>Confirm the IP address, user name and password of the device you want to register.</td>
</tr>
<tr>
<td>Create Device Failed. Cannot connect with the projector.</td>
<td>Check LAN cable connection, and confirm the IP address, user name and password of the device you want to register.</td>
</tr>
<tr>
<td>Device with Same IP Address has already been registered.</td>
<td>Confirm the IP address of the device whose information is to be updated.</td>
</tr>
<tr>
<td>Device Update Failed. Confirm IP Address, User Name and Password.</td>
<td>Confirm the IP address, user name, and password that were set for the device whose information is to be updated.</td>
</tr>
<tr>
<td>Invalid IP Address. Input correct IP Address.</td>
<td>Confirm the IP address of the device whose information is to be updated.</td>
</tr>
</tbody>
</table>

**Cannot create a group, keyword, or brightness control**

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 groups have already been created.</td>
<td>The maximum number of groups to which devices can be registered is 100. Be sure to stay within that range.</td>
</tr>
<tr>
<td>100 keywords have already been created.</td>
<td>The maximum number of keywords to which devices can be registered is 100. Be sure to stay within that range.</td>
</tr>
<tr>
<td>100 Brightness Controls have already been created.</td>
<td>The maximum number of brightness controls to which devices can be registered is 100. Be sure to stay within that range.</td>
</tr>
</tbody>
</table>
# Error Messages

## Interrupting delivery or content list delivery cannot be executed

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interrupt delivery failed.</td>
<td>Confirm the connection with the device and make sure there are no problems communicating with it.</td>
</tr>
<tr>
<td>Content list delivery failed.</td>
<td>Confirm the connection with the device and make sure there are no problems communicating with it. In addition, make sure the device has enough memory.</td>
</tr>
<tr>
<td>Content list copy failed.</td>
<td>Confirm the connection with the device and make sure there are no problems communicating with it. In addition, make sure the device has enough memory.</td>
</tr>
<tr>
<td>The PowerPoint® presentation software has not been installed.</td>
<td>Make sure the PowerPoint® presentation software is installed on your computer.</td>
</tr>
<tr>
<td>The PowerPoint® presentation software is running. Close the PowerPoint® presentation software, and retry.</td>
<td>If the PowerPoint® presentation software is already running, close it and then retry.</td>
</tr>
<tr>
<td>The contents is too large. Make sure that the contents are smaller than 2 GB.</td>
<td>The maximum size of the contents that can be used is 2 GB.</td>
</tr>
<tr>
<td>The file extension and the actual file format are mismatched.</td>
<td>See pages 134 and 150 for details about the still image and movie file formats that can be used.</td>
</tr>
<tr>
<td>It is not possible to save more than 32 GB of contents. Please delete contents.</td>
<td>Make sure the saved contents do not exceed 32 GB.</td>
</tr>
<tr>
<td>No USB memory drive inserted. Cancel processing.</td>
<td>Make sure that the USB memory drive is inserted in the device.</td>
</tr>
</tbody>
</table>


Error Messages

Brightness control, acquisition of Light ID information, or acquisition of signage schedule failed

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm whether the adjustment mode of the brightness control is &quot;PC&quot;.</td>
<td>Set the adjustment mode of the device's brightness control to &quot;PC&quot;.</td>
</tr>
<tr>
<td>Please check that the adjustment mode of the brightness control is &quot;PC&quot;, and that it is a model corresponding to the brightness control.</td>
<td>Set the adjustment mode of the device's brightness control to &quot;PC&quot;. Make sure that models that do not support brightness control are excluded from the brightness control group.</td>
</tr>
<tr>
<td>If a different device model is connected with Brightness Control group, Brightness Control cannot be executed.</td>
<td>A device that differs from the registered device was connected to the brightness control group. Be sure to connect the correct device and exclude incorrect models from the brightness control group.</td>
</tr>
<tr>
<td>Failed to get Light ID Information. Please make sure the format is correct.</td>
<td>Make sure the Light ID Information file is correct.</td>
</tr>
<tr>
<td>Acquisition of signage schedule failed.</td>
<td>Confirm the connection with the device and make sure there are no problems communicating with it.</td>
</tr>
<tr>
<td>It is not possible to save more than 32 GB of signage schedule. Please delete signage schedule.</td>
<td>Check the size of the signage schedule (including contents) on the device side, and delete schedule data on the device.</td>
</tr>
<tr>
<td>Insufficient free space. Please make sure there is at least 1 GB of free space.</td>
<td>Check the free space on your computer's hard disk.</td>
</tr>
</tbody>
</table>

Errors relating to the early warning function

Activation does not work

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>This Key Code is already used.</td>
<td>The Key Code is already used. Prepare a new key code.</td>
</tr>
<tr>
<td>Failed to save LST file.</td>
<td>Enter the key code correctly.</td>
</tr>
<tr>
<td>Confirm the Software License Key Code.</td>
<td></td>
</tr>
<tr>
<td>Already used activation code.</td>
<td>The activation code is already used. Prepare the correct activation code.</td>
</tr>
<tr>
<td>Software License activation was failed.</td>
<td>Check whether the activation file is incorrect, or whether the wrong activation code was entered manually.</td>
</tr>
</tbody>
</table>
## Error Messages

### Issues with licenses or user accounts

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software License has expired. Software License renewal required.</td>
<td>The license for the early warning function has expired. Please purchase a new license code.</td>
</tr>
<tr>
<td>Software License is required for further use. Please contact your dealer.</td>
<td></td>
</tr>
<tr>
<td>License will expire soon.</td>
<td>The early warning function trial period will expire in less than one month. Prepare a new license key code.</td>
</tr>
<tr>
<td>You have reached the maximum number of accounts that can be registered.</td>
<td>You can only register up to 100 accounts. Be sure to stay within that range.</td>
</tr>
<tr>
<td>Duplicated user account name.</td>
<td>Use a user account name that is not already registered in the software.</td>
</tr>
</tbody>
</table>

### Unable to update the Device Profile Library, register a network camera, or register a DIGITAL LINK Switcher

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm the Device Profile Library.</td>
<td>Prepare the correct device profile library.</td>
</tr>
<tr>
<td>The selected library is same or older library than current one.</td>
<td>Prepare a device profile library that is newer than the one that is currently registered in the software.</td>
</tr>
<tr>
<td>Network Camera's IP Address is invalid.</td>
<td>Correctly enter the IP address of the network camera you want to register.</td>
</tr>
<tr>
<td>Network Camera's User Name is required.</td>
<td>No user name has been entered. Enter the user name for the network camera you want to register.</td>
</tr>
<tr>
<td>Confirm that the IP address, user name, and password of the network camera are correct.</td>
<td>Confirm the IP address, user name and password of the network camera you want to register.</td>
</tr>
<tr>
<td>Communication error occurred when trying to connect to Network Camera.</td>
<td>Check the network connection.</td>
</tr>
<tr>
<td>Can't find Network Camera.</td>
<td>Check the network connection.</td>
</tr>
<tr>
<td>Duplicated Network Camera.</td>
<td>This network camera has already been registered.</td>
</tr>
<tr>
<td>DIGITAL LINK Switcher's IP Address is invalid.</td>
<td>Correctly enter the IP address of the DIGITAL LINK Switcher you want to register.</td>
</tr>
<tr>
<td>DIGITAL LINK Switcher's User Name is required.</td>
<td>No user name has been entered. Enter the user name for the DIGITAL LINK Switcher you want to register.</td>
</tr>
<tr>
<td>Communication error occurred when trying to connect to DIGITAL LINK Switcher.</td>
<td>Check the network connection.</td>
</tr>
<tr>
<td>Can't find DIGITAL LINK Switcher.</td>
<td>Check the network connection.</td>
</tr>
<tr>
<td>Confirm IP Address, User Name and Password of DIGITAL LINK Switcher.</td>
<td>Confirm the IP address, user name and password of the DIGITAL LINK Switcher you want to register.</td>
</tr>
<tr>
<td>Duplicated DIGITAL LINK Switcher.</td>
<td>This DIGITAL LINK Switcher has already been registered.</td>
</tr>
</tbody>
</table>
### Error Messages

#### Output stopped video detection by camera

<table>
<thead>
<tr>
<th>Message</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>The No Image Determination time is invalid.</td>
<td>Set the time to a value between 1 minute and 10 minutes.</td>
</tr>
<tr>
<td>The video stop determination setting count is already the maximum value of 32. It is not possible to add any more video stop determination settings.</td>
<td>The maximum number of video stop determination settings is 32. Be sure to stay within that range. The number of video stop determination settings represents the number of network cameras associated with devices.</td>
</tr>
</tbody>
</table>
Frequently Asked Questions

Check the following points once more before requesting repair.

### A “401 Unauthorized ...” error is shown and the <Web Control> window cannot be displayed

Is there a mistake with the username entered when the device was registered?
- The username entered when device was registered to this software must be the same as the username set to display the <Web Control> window of the relevant device.

### Cannot switch input from control screen of this software

Is there a mistake with the username entered when the device was registered?
- The username entered when device was registered to this software must be the same as the username set (with administrator rights) to display the <Web Control> window of the relevant device.

### Simultaneous image distribution fails

Is the input of your device set to Miracast / MIRRORING / Signage / MEMORY VIEWER / WHITEBOARD?
- Simultaneous image distribution will fail if the input of your device is set to any of the above.
  - Press the “Panasonic APP” button or “NETWORK/USB” button on the remote control to change the input to “Panasonic APPLICATION”, and then try the simultaneous image distribution again.

### Light ID signals are not transmitted from the device

Settings must be configured on the device side to transmit Light IDs.
- For details on the settings, refer to the operating manual of the device.

### Acquisition of information is not possible

When “INFORMATION_ERROR” is displayed on the command execution log area of the device monitoring screen, confirm the device connection or authentication information.

### In caption distribution, the caption display is garbled at the delivered device.

It is necessary to redo the setting of the font to be used at caption editing.
- Select an applicable caption list, and after changing the font at the caption editing screen, perform caption distribution once more.

### Cannot convert from PowerPoint to still image or movie during content list delivery

Is PowerPoint running while the <Content list delivery> window is displayed?
- Quit PowerPoint, then open the <Content list delivery> window.
  - If the problem persists after quitting PowerPoint, close the software, restart the computer, and try again.
An error occurred in communication with the monitoring service. An error is displayed, and the software will not launch.

Is Early Warning Software not running?
• In order to launch the software, the state of the “Early Warning Software” service must be “Running”.

1. (Windows 10)
   Right-click [Start] button and select [Computer Management].

   (Windows 8.1)
   Click [Start] button, right-click [Computer] and select [Manage].

2. In [Services and Applications], select [Services], and confirm that the status of [Early Warning Software] is [Running] (Windows 10) or [Started] (Windows 8.1).

   • If the status of [Early Warning Software] is not [Running] (Windows 10) or [Started]
   (Windows 8.1), click [Early Warning Software] and select [Start the service] to start it.
Frequently Asked Questions

Is IIS (Internet Information Services) correctly configured?

1. (Windows 10)
   Type “Control Panel” in the search bar to launch the control panel.

   (Windows 8.1)
   Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].

2. Select [Programs] in the Control Panel.
3. Click [Programs and Features] → [Turn Windows features on or off].

![Screenshot of Control Panel with Programs and Features selected]

4. For the following three functions, confirm that the settings for each item are as shown below, then click [OK].

**[.NET Framework 4.7 Advanced Services]**

- ASP.NET 4.7
- WCF Services
  - HTTP Activation
  - Message Queuing (MSMQ) Activation
  - Named Pipe Activation
  - TCP Activation
  - TCP Port Sharing

**[Windows Process Activation Service]**

- .NET Environment
- Configuration APIs
- Process Model
Frequently Asked Questions

[Internet Information Services]

- Internet Information Services
  - FTP Server
    - FTP Extensibility
    - FTP Service
  - Web Management Tools
    - IIS 6 Management Compatibility
      - IIS 6 Management Console
      - IIS 6 Scripting Tools
      - IIS 6 WMI Compatibility
      - IIS Metabase and IIS 5 configuration compatibility
    - IIS Management Console
    - IIS Management Scripts and Tools
    - IIS Management Service
  - World Wide Web Services
    - Application Development Features
      - .NET Extensibility 3.5
      - .NET Extensibility 4.7
      - Application Initialization
      - ASP
      - ASP.NET 3.5
      - ASP.NET 4.7
      - CGI
      - ISAPI Extensions
      - ISAPI Filters
      - Server-Side Includes
      - WebSocket Protocol
    - Common HTTP Features
      - Default Document
      - Directory Browsing
      - HTTP Errors
      - HTTP Redirection
      - Static Content
      - WebDAV Publishing
  - Health and Diagnostics
    - Custom Logging
    - HTTP Logging
    - Logging Tools
    - Request Monitor
    - Tracing
  - Performance Features
    - Dynamic Content Compression
    - Static Content Compression
  - Security
    - Basic Authentication
    - IP Security
    - Request Filtering
    - URL Authorization
Cannot install the software

Is Microsoft .NET Framework 4.7 installed on your computer?

• To install the software, you first have to install Microsoft .NET Framework 4.7 on your computer.

1. (Windows 10)
   Type “Control Panel” in the search bar to launch the control panel.

   (Windows 8.1)
   Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].

2. Select [Programs] in the Control Panel.
3. Click [Programs and Features] → [Turn Windows features on or off].

4. Select the “.NET Framework 4.7 Advanced Services” check box and click [OK].

5. The required files are located and Microsoft .NET Framework 4.7 is installed.
Frequently Asked Questions

6. If the files required for installing Microsoft .NET Framework 4.7 are not on your computer, a screen like the one shown below appears. Select [Let Windows Update download the files for you] in that screen. (This process requires an Internet connection.)

![Windows Update Message]

7. Restart the computer when installation completes.

**Messages that appear when an attempt to uninstall or update the software is made**

Is the “Warning 1910. Could not remove ...” message displayed?

- If an NVIDIA driver is installed on your computer, the following message may appear.

```
Verify that the shortcut file exists and that you can access it.
```

Click [OK] to continue an uninstall or update procedure.

Although uninstalling the software will also remove the desktop shortcut icons, please manually delete the shortcut icons when you start up the computer next time as they will be regenerated.
Frequently Asked Questions

No connection can be made between my device and my computer

When Windows Firewall has been detected
Is the firewall exception setting turned on?

1. (Windows 10)
   Type “Control Panel” in the search bar to launch the control panel.

   (Windows 8.1)
   Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].


3. Click [System and Security] → [Windows Defender Firewall] → [Allow an app through Windows Firewall].
4. Click [Change Settings] (1) → [Allow another app] (2).

5. Click [Browse] (3).
   If you do not specify a different destination, the software is installed in the following location:
   C:\Program Files (x86)\Panasonic\Early Warning Software

7. Select [Multi Monitoring & Control Software Ver.XX] and click [Add] (5).
8. Select the [Private] or [Public] network you want to allow connection to and click to select the check box.

9. Click [OK] (6).
This software will now be added to the Windows Defender firewall’s exception list.

When another firewall has been detected
Are any firewall-containing applications installed?
• If any applications which contain firewalls are installed, the installation may not complete.
  (The firewall function may activate without launch of the application if the application has already been installed.)
  If this occurs, firewall settings must be changed in order to allow connection to the network.
• See the User’s Manuals for all applications containing firewalls to perform these settings.

When the software is launched, an error occurs in communication with the monitoring service.
The following message is displayed if the required data cannot be read when the software is launched:

An error occurred in communication with the monitoring service.
Since there is a possibility that the monitoring service may be stopped, restart the PC.

• Restart the computer, then launch the software again.
  If the same error occurs after restarting the computer, it is possible that the required data has become corrupt.
  Reinstall the software.
Frequently Asked Questions

The screen is not displayed even when calling up the device's WEB control function.

If the device or network camera being used is set to connect using HTTPS communication or if it is required to install a plug-in software, the WEB control screen may not be displayed even if you call up the device’s WEB control function from this software.

- When the WEB control screen is not being displayed, enter the IP address of the device or network camera into the WEB browser URL input field and directly open the WEB control screen.
Trademarks

- Microsoft, Windows, Excel, PowerPoint, Internet Explorer and Microsoft Edge are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- PJLink™ is a registered trademark or pending trademark in Japan, the United States, and other countries and regions.
- Intel is a registered trademark or trademark of Intel Corporation or its subsidiaries in the United States and/or other countries.
- The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trademarks of HDMI Licensing Administrator, Inc. in the United States and other countries.
- DisplayPort is a trademark of the Video Electronics Standards Association.
- Android and Google Chrome are trademarks of Google LLC.
- iPad, iPhone and Safari are trademarks of Apple Inc., registered in the U.S. and other countries.
- IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.
- Other company names, product names or other names noted in these operating instructions are trademarks or registered trademarks of the respective companies. Note that ® and TM marks are not indicated in these operating instructions.

Notes:
- Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
- Panasonic cannot be held liable for any effects resulting from the use of this software and manuals.
- Panasonic reserves the right to revise this software specifications and manual contents without notice.